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Online Help

Find the answers to your questions! From the Main Menu, click the On-Line Help button.
Please do not bookmark this URL as it is a dynamic URL. Type keywords in the Search box
and click the magnifying glass. The search returns the online help topics that match the
keywords you entered.

~ Search returns any topics that include all of your keywords. For example, searching
for re-enroliment email will return results with re-enrollment and email. Items that
include more of your keywords are listed higher in results.

~ Search is not case-sensitive. Re-enrollment Email is the same as re-enroliment
email.

~ Search finds variants of your keywords, for example, searching for creating finds
items containing, create, creation, or creating.

Help Demonstration Videos
RenWeb provides free demonstrations on how to perform various tasks within RenWeb.
1. From the Main Menu, click Customer Support or Report Manager.

2. If using Report Manager, click the Help Demonstrations button at the bottom of the
screen.

3. Choose the Category and then the Class Title in the Demonstrations list.

4. Click Show Demonstration.

OR

5. From the Main Menu, click Online Help.
Online Help displays in an Internet Explorer web browser.

6. Scroll to the bottom of the Contents list and click the Help Demonstration topic.

7. Select from the various Help Demonstrations to learn how to do various tasks in
RenWeb.



Support Request - Live Chat

It is possible to dialogue, via your PC with a support representative about issues you are
experiencing with RenWeb. Live Chat is available between the hours of 8:00 a.m. and 5:00
p.m. Central Time.

1. From the Main Menu, click Live Chat button.
The RenWeb Support Chat window opens.

€ hitp://livechat.boldchat.com/7cwdid=284403339524062721 &url= http%3A//www.renweb.com/renwebAdmini - Windows Internet Explorer [ .= |[ & |
e h h, h b.com/ d lorer | J
Renewing School Managementw School Management Software RenWeb
via the web.. Totally Integrated — In One Database — On the Web Support
Chat
Thanks for contacting us! To better serve you, please fill out the short form
below and click the Start Chat button in the lower right.
Name: Becky 2>
Email: rtur@renweb.com =
Phone: 817-buy-renweb
How do I add a student? -+
Initial Question: *
District Code: Sample| *
( * - indicates required field)
BALD Start Chat | _

2. Type your Name, Email address, Phone number, Initial Question, and District
Code.



3. Click Start Chat (lower right).
The Live Chat screen opens.

(€ http://livechat.boldchat.com/ - RenWeb Support - Windows Internet Explorer =@ =
renawebh _4
. o ? RenWeb
Renewing School Management School Management Software
g via ?he web.. Totally Integrated — In One Database — On the Web Support
Chat
Your Name: Becky
History:
Thanks for contacting us. An agent will be with you shortly...
[Becky] How do I add a student?
[Emily] Hi Becky. My name is Emily and | will be assisting you.
[Emily] May | have your district code please.
[Becky] Sample
Send Message:
| a
Send
BALD End] _

4. Once the support representative types a message to you, you may type your
response in the Send Message field.

5. You may either click the Send button or press the Enter key on your computer
keyboard to submit the response.

®Note: You will be able to see when the agent is typing (lower right). The message in
the pictured example reads, "Emily is typing."



Support Request - Ask A Question

Ask a Question is a tool that allows you to ask simple questions, for which you do not need
an immediate response; this option is available between the hours of 5:00 pm and 8:00 am
central time.

1. From the Main Menu, click the Customer Support button.

2. Click Ask A Question. (This button will read Support Chat during the hours of 8:00
am and 5:00 pm central time)

3. Type in a question or suggestion.
4. Fillin a contact email address and phone number.

5. A RenWeb technician will respond as soon as possible.

Support Request - Phone Support
1. From the Main Menu, click Customer Support.
2. Select the Phone Support button.
3. Select a Support Area.

4. Type in the phone number at which you may be reached—include your extension to
ensure we are able to contact you.

5. Type in any Special Instructions for reaching you.

Support Request - Direct Call
Direct Call is for users who need immediate assistance.
~ Call toll free 866-800-6593 and press 1 for technical support.

~ Call the local number 817-426-6008 and press 1 for technical support.



Registering Online For a Training

1. Go to www.renweb.com.

2. Select the Support tab.
3. Select Training Schedule.

4. Find the class in which to enroll and select the “Click HERE to enroll in this class”
link.

5. Provide the information requested.

6. Register for the Webinar.



Getting Started

Logging In
Main Menu

Personal Security
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Logging in for the First Time

1. Double-click on the RenWeb.com shortcut icon.

2. Enter the school’s District Code on

the RenWeb Login screen.
3. Click Submit.

4. Select the School Name from the
Select School list.

5. Select your name from the Select
Staff list.

6. Type your password in the Enter

Password field. (Your password will

be provided in class.)

7. Click the Login button.

FERY oo
RenWeb Login (=%
District Code ’TH -MASTER Subrmit I
Select School
[Northwood Academy |
Select Staff
|Kate, Emily |

Enter Password

L

Select staff member...

Login I

Cancel I

11




Main Menu of RenWeb

The Main Menu for Administrators has 5 distinct areas:

A The windows at the top for Year, Term, and School allow the user to select which
school year and term in which to work. If the school has chosen to partition
information into separate schools, it is possible to select Elementary, Middle or High

School information.

~ The left section entitled Data contains buttons to areas in which data is displayed.

~ The right section entitled Functions contains buttons to areas in which an individual

will regularly perform school management functions.

~ The section at the bottom contains the link to Live Chat and is used to communicate

upcoming events or announcements.

~ The Side Panel contains information on training, ways you can enhance the RenWeb

product or may contain announcements.

A RenWeb.Com

Year Term School

|201 0-2011 LJ |T2 LI |Notthwood Academy _v_| ﬂ'
~Data——————  Functions kol ]
Admissions I Report Manager ] Create-a-Report |
Classes I Accounting | Grade Book I Report Card I

Courses I Attendance | Library | Renweb Setup I

Family I Class Rank - Honors | Lunch | Security |
Scheduler | Communication | Medical I Survey I .

Staff l Donate Online | Change Password I Parents\wWeb I :

Students I Customer Support I Staff Chat I

I

l Exit Rentweb.Com

renaweb

Powering School Systems Online

2010 Winter Upgrade Now Available

Support
Chat
Online Help

olE =

July 18-21, 2011
rlando, FL

— ] () T S—
Information

Integrated
Web Partners

FINDOUT
MORE’

©




Personal Security

In order to expedite training so that users may quickly log in, all users are initially given a
generic password to gain access to the system. In order to maintain a secure database, it is
imperative for ALL users to change their passwords ASAP. The password should be unique
and once changed, should not be written down.

Changing Your Password

1. From the Main Menu, click the Change Password button.

2. Enter an alphanumeric 6 character password in the Password field and then enter it
again in the Confirm field.

3. Click the OK button.

Change Password @

Password l|
Confirm |

Cancel |
Help |

M Password Exercise

Objective: To create a secure password.

Changing Your Password
1. After Logging in to RenWeb, click Change Password.

2. Change the generic password to an alphanumeric, six character password.

3. Click OK to apply the changes.

13



People Management

Student Screen: General Tab
RenWeb Setup: Defined Lists
User Defined Fields
Grid Edit
Alerts
Portfolio
Family Button
Linking
Family Screen
Student Screen: All Tabs

Staff
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Student Screen

The Student screen enables the user to enter, change, or retrieve student information. On
the Main Menu, click Students. The Edit Student, General tab opens. The general tab
houses demographic information for the students. In addition, it provides links to the
student’s family, medical and attendance information, report card records, user-defined
fields, and interests.

The different tabs across the top of the window allow access to various types of student
information, such as schedules, financial responsibility division, discipline, etc.

' Edit Student =
General IScheduleI EC: ] anancel Advising ] Academics] Misc I F\'eligionl P/T Confefence] Behaviorl Transcn’pt] Community Service] Pidure] Transpl
~Address
Last Name [Brock [ | sweet [R5 ENS ‘ Student 1D |292
:::: Ezg = First Name |/ames ]P— | School UD ID
Adams, Edward Henry Middle Name City |Grand Prairie ‘
Ainge. Braiden Ray State ZIP [TX 75052 ‘ Attendance User Defined
Anderson, Anna Nickname —
Anderson, Jake Country ‘ Report Card Grid Edit
x:;‘::g: é?lzze? . Beteds s B2 | s | Medical Admissions
Ashton, Rick Paul =l SSN/SIN Gender |Male -
Bakies, Aaron Joseph e lﬁ _"J Alerts Re-Enroliment
Banks, Cody Ray Home Ph |817-564-2354 Ethnicity ~Next Year- 1 Porfoli Tracki
Bargas. Braden [ Sous[Ewid ] [Erroled =l e e
Barkley. Aaron Dennis Cell Ph fatus [ ‘ i
ity i el Geade Leve |10 = o —
Boyd. Zacha i I Substatus - ;I‘ [~ Re-envolled ! My Favorites
Brock. James =
Brodburg, Daffy Z weo [ xls] ™ Lang | =] -]l i =~
Buck, Charles Citizen. [—E];J i
Burke, David Michael ~ Fiter ——————————— Medical | Alerts I Email History I
gﬁ"l(fj: dLeVeValker Status = Pacement| _____ lit] ] _Picture Family Notes | Interests |
Divis Caleb [~ Historical Class Of R
Davis, David I~ Next Year Family (E}l:rot:k )Mike
Davis, Hlisha istrict- sther)
Doe, Jeffery L e e Brock, Angela j h: 817-564-2254
Doe, Susan Marie Brock, Mike Brock, Angela
Duck, Alex ||Graduate = {Mother)
Duguay. Jay || Pre-Enrolled ‘E ‘ h: 817-564-2254
Duncan, Av || Withdrawn LS
it birbe _ | Curent School [Sample Upper School ~|
Eccleston, Charles Dallas atd Next School ISample Upper School _vJ
Fortinbemy, Tami <Advanced Fiter>
e et Srade: 08 | Evoled Dae 127277200 Enroliment History
Haney, Emily Kate Grade: 07 L=
Harper, Johnaton Christopher Grade: 09 Withdraw Date I I LI
Harison, Jasmine Grade: 10 Grad. D. ﬁ
Hedruum, Maxwell ~ |Grade: 11 o rad. Date
Count = 98 3
Help Refresh New | Delte |
OK I Cancel Apply
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Student Filter

On the left side of the General tab, is a list of students who have been entered into the
system. To the lower right of the student list is a filter screen which the user may use to filter
by a student status, class, homeroom or activity. It also enables users at schools in a district
to see the entire district if the individual user has district wide rights to view all students.

Adding a Student
1. Click the New button at the bottom of the Student window.
2. Enter data into the appropriate fields.
3. Click Apply to record the student information.
4. Click New to enter another student’s information or OK to save the information and

exit.

®Note: Required fields include student first and last name. RenWeb defaults all newly
added students through the Student screen to a status of Pre-enrolled.

Deleting a Student
1. Select the student to be deleted.
2. Click the Delete button at the bottom of the screen.
The Confirm Student Removal screen opens.
3. Click Yes to delete the student.
4. Click OK to save and exit to the Main Menu or click Apply to save and stay in the

Student screen.

@Note: The system will not allow a user to delete a student if historic information is
associated with a student: grade book, report card, attendance, etc.

16



Current Status and Next status

One of the most important items to enter when adding a student is the Status. While it is not
required, not establishing a status will cause the student to appear as if he or she has not
been entered into the system. In order to locate a student who may have an incorrect status
or no status, select a Filter of District Wide, All and the student will appear in the student list.

Admissions | the student has made application to the school (available
only via the Admissions Student screen)

Enrolled the student is attending the school

Graduate the student has completed all grade levels offered by the
school

Inactive the student once expressed interest in attending the
school but never progressed to admissions

Inquiry the student has expressed interest in attending the
school (available only via the Admissions Student
screen)

Pre-Enrolled | the student will be attending the school at a later date

Withdrawn the student has chosen to go to another school

1. When adding a student for the first time, go to the Status drop-down menu:

2. When selecting and assigning a Status for the current year, a status that mirrors the

student’s current status will automatically populate in the Next Status field for the
student for the next school year. This information will be used when the school

progresses students from one year to the next.

17



Current Grade Level and Next Grade Level

When adding a student into RenWeb and assigning the student a status of enrolled it is
necessary to assign a grade level to the student.

1. Select a Status of enrolled

2. Select the grade in which the student is enrolled in the Grade Level drop-down

menu.
The next year’s grade level will automatically populate in the Next Grade Level field.

@Note: When adding a student for the first time if the user has selected a status of pre-
enrolled it is not recommend to enter a current grade level, but rather to add the grade
level in which the student will be enrolled the following year.

Current School and Next School

In order for a student to be visible in a specific school he or she must have the current
school defined. In addition, if a school is part of a larger district the next school determines
into which school a graduating student will attend.

1. From the Student screen select a student.

2. Inthe Current School and Next School fields, select the appropriate school from
the drop-down.

18



RenWeb Setup: Defined Lists

RenWeb Setup houses many of the behind the scenes set up areas, which serve to enable
the program to run smoothly at your school.

Drop-down list boxes are throughout the system. Selecting an option from these lists makes
data more consistent for reporting. The Defined List function allows the user to enter all the
options for each defined drop-down list. It is possible to add entries to the defined list by
clicking any of the plus boxes located in the system.

Creating a Defined List

1.

4.

5.

From the Student screen, click a plus button that is beside a drop-down list box.
The Defined Lists Editor opens.

Select the item from the drop-down list for which to add a selection option.
Type the option for that list in the edit box to the left of the Add button.
Click Add.

Repeat the process until all list items have been added.

@Note: Some drop-down lists do not have a plus button beside them and must be
accessed through RenWeb Setup.

19



Deleting a Defined List
1. Inthe Defined List Editor, select the defined list name from which to delete an item.
2. Highlight the list item to delete by clicking on it.

3. Click Delete.
The Defined List item is immediately deleted.

Creating a Default Selection

1. Inthe Defined List Editor, select the defined list name in which to create a default
setting.

2. Highlight the list item to make the default by clicking on it.

3. Click Set as Default.
The item will show that it is the default option by placing angled brackets around the

item.

20



M Student, Parent and Family Exercise

Objective: Create a student

Create a student named Paddy P. *Patterson#.
1. Enter the following demographic information:
a. Birth date: 1/1/1999
b. Phone number: 555-555-5555

c. Email address: ppatterson@schoolname.com

d. Enter address: 1234 Pattenheimer St. Pattenville, PA 99999
e. Status: Enrolled
f. Grade Level: Any

2. Save student record.

21
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User-defined Fields

You can gather information with user defined data fields that may not be present in the
RenWeb database. User defined fields may be added to the general Staff, Student, and
Family screens as well as the Admissions (Web Student Inquiry), Courses, Classes, and
Medical screens.

Various types of data may be stored in user defined fields:

Text Text may be typed

Yes/No An option of Yes or No is available.

Date A numeric date may be selected from a drop-down
calendar.

Integer Number An integer (whole numbers 1, 2, 3, or negatives -1, -2,

-3, or 0-zero) may be entered.

Real Number Numbers with decimal points or fractions, as well as
integer numbers may be entered.

Defined List Select | Allows you to add options from which other users will
choose.

Suggested Security Rights

In order for a user to have access to User Defined areas of the program, he or she must
have the following rights in the Security screen.

~ UD Configuration: Allows user to create UD fields and assign security to them.
~ Print Create a Report: Allows the user to create reports based on the data entered.

Add rights to access the various screens in which you may add User Defined fields:

~ Admissions ~ Medical
~ Classes A Student
~ Courses ~ Staff
~ Family

22



Adding User-defined Data Fields

1. From the Main Menu, navigate to the area for which you want to add user defined

fields.

2. Click the User Defined button.
The User Defined dialog box displays.

1. Test [District Wide)

Field

Data

Text

Yes/No

Date

Interger

Real Number

Defined List Select

SAVE Configuration |

Exit | Heb
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10.

11.

12.

Click Configuration.
The User Defined Configuration screen
opens.

Enter the title for the data (i.e. Staff Info, Spouse
Info, etc.)

Select the Group Order, which determines
where on the list the user defined list name
should appear.

Select the option of District Wide if the defined
list is applicable to all of the students, staff or
families in your district.

Click Save.

Re-select the newly created User Defined
group name.

User Defined Configuration @
STUDENT
1. Test [District Wide] Test 44
2. Sample |
7. Passport Data
8. Photo Waiver 1 :" Group Order
10. Application References
11. Tutor IV Distiict Wide
Security
Add Security Group

# |Name [Dala Type

1 Text STRING

2 Yes/No YESNO

3 Date DATE

4 Interger INT

5 Real Number STRING

6 Defined List Select SELECT

»
Save | Delete [ New
Exit Hep |

Click Add Security Group to add restrictions to the security groups who can view or

modify the User Defined group.

Double-click on the blank row of the grid to add a user defined list item.

The User Defined Field Edit dialog box opens.

EX3)

User Defined Field Edit
| R
Defined List Select Options
v | Field Order
* Text " Integer
" Yes/No " Real Number
" Date " Defined List Select

Data Elements
Save I Delete | Help I I
Cancel l

&l

Type a label for the data field. For example, to collect information for school parking,
the title could be Parking and the data fields might be License State, License

Number, Parking Sticker Number, Insurance, etc.

Select the Field Order, which determines where in the grid the user defined

configuration item should appear.
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13. Determine the format in which you want to collect the information:

Text Text may be typed

Yes/No An option of Yes or No is available.

Date A numeric date may be selected from a drop-down
calendar.

Integer Number An integer (whole numbers 1, 2, 3, or negatives -1, -2,

-3, or 0-zero) may be entered.

Real Number Numbers with decimal points or fractions, as well as
integer numbers may be entered.

Defined List Select | Allows you to add options from which other users will
choose.

14. Data Elements displays the number of staff, student, or family information entries
that have been saved into the UD field.

15. After adding a data field, click Save to keep the data, click Cancel to exit without
saving.

16. Repeat as needed to create as many fields as needed to store student, family, and
staff information.



Adding an Information Collection Type of Defined List Select

1.

From the User Defined Configuration screen, double-click on a blank row to add an
information collection type.
The User Defined Field Edit screen opens.

Type a label.
Select the Field Order.
Select an information collection type of Defined List Select.

Type the name of the item to add as a selection type in the field to the left of the +
(plus) button.

Click the + (plus) button to add the item to the Defined List Select Options list.

Repeat until all Defined List Select Options have been added.
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Adding UD Data for an Individual

You may add user defined tracking to any area/screen that has the User Defined button on
it: Student, Staff, Family, Web Student Inquiry, Classes, Courses, etc. Once you have
configured the defined list in the area for which you want to track data, you may add data for
the specific student, staff or family member. The following instructions will step you through
the process on the Student screen; they may be applied to any area in which there is a User
Defined button.

1. From the Main Menu, click Students.
2. Select the Student for whom to add the collected information.
3. Click the User Defined button.

4. Select the User Defined list for which to enter information.
The Fields/Data grid displays the names of each item you added to the user defined

list.
mUser Defined (e
1. Car Information [District Wide) LJ
Field Data
Car Model Type your text here.
Has permit? YES
Reaistration Date 01/22/2010
Year 1987
Mileage 20005
Color Silver
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5. To add data, click or double-click on a row under the column labeled data; depending
on the type of information collection type you have selected, you will have various
options to enter the information.

a. Text: when you double-click on a row that is

configured to allow for text, the Edit screen ERE

will open. Type or paste into the text field the | [Type your test here]
information you have collected,; click OK to oK | Cancel |
save or click Cancel to exit without saving.

b. Yes/No: when you click on a row that is configured tobe a "o 2t ves/No
Yes/No selection, the Select Yes/No screen willopen. [ i
Select Yes or No, by clicking on the word. " No @ ies

c. Date: when you click on a row that is configured to be a

. Select Date
date, the Select Date screen will open. From the

calendar drop-down, select the date or click Clear to 142242010

remove a previously selected date.
Clear

d. Integer and Real Number: when you click on a row that

is configured to be either an Integer or Real Number, you may begin typing the
information directly into the grid.

e. Defined List Select: when you click on a row that is

configured to be a Defined List Select, the UD Selection | UPselction

screen will open. Select from the pre-determined Blue
selections that you added in the configuration process g:iﬁn

. Orange

and click OK. Purple
Red

Silver

6. Once you have entered the information, click Save or click b

EXit to return to the previous screen without saving.
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Grid Edit

At times it is easier to view and edit data in a grid style screen, than to click from individual
to individual and edit the information in the screen.

Configuring Grid Edit

In order to utilize the Grid Edit feature, you need to configure user-defined fields to include in
the grid area for editing.

1. From the Student or Staff General tab, click the Grid Edit button. The Grid Edit

SCreen opens.

2. Click the Set Up button. The Grid Edit Setup screen opens.

Grid Edit

[ | | | [ [ |

| Gender | Last Name | First Name | Middle Nami| Nickname | Suffix | Street | City | State |Zip | Country
Aaron, Tyler Malel Aaron SR = T T ST “2222e.1234 USAl
‘Abell, Adam Male Abell | NSRBI United State
Abell, &ngel Female Abell United State
Adams, Edward Male Adams = -ﬂ 6432
Adams, Johnathon Male Adams Available Fields Selected Fields 6432
‘Adams, Julie Adams |f |Last Name A Gender 6432
Binge,Braiden ____ Male Ainge First Marie Do el 6111

inge, g Middle Name Last Name
Anderson, Anna Female Andersos Nickname L] First Name 6028
Anderson, Jake Male Anders Suffix = Middle Name 5028
Anderson, Joeseph Female School UD ID l.l Nickname 6106
e e e Suffix
Andrews, Gabrielle Female 6028
Street L Street
Armstong, Evan Male City LJ City 6028
Ammstrong, Evan Male S.lale Sgale 6000 USA
Ashton, Rick Male Zip il Zip 6111
‘Ashworth, Michasl worth| | Counity Counlry
Auvenshine, Darren Male uvenshil | Grade Level 6028
Bakies, Aaron Male akies 6180
Banks, Cody Male Banks Birthdate 6108
Bargas, Braden Male Bargas Home Phone 6123
T | Cell Phone
Bargas, Ray Male Bargas Ernad 5133
Barkley, Aaron Male Barkley Ethnicity 6028 UK
Basden, Alex Male Basden Citizenship 6029
Boswarth, Pam Femal Boswarth| | Denomination 6819 USA
Bowman, Samuel Male Bowman Baplism Date 6133
- Baptism Church
Boyd, Zachary Boyd Baptism City
Bradley, Zoe Bradley Baptism State = 8221
Brock, James Brock 5052
Brodburg, Daffy Brodburg 6123 US
Buck, Charles Buck S | Exit I Hel I 6018
Burke, David ale Burke i b 4 6123
Burke, Noah Burke 6123
Save Print | Exit | |General ~|

g

-

Help

3. Select the fields to display in the grid from the left side of the screen and using the >
and >> (arrow) buttons, move the desired fields to the right side of the screen.

4. To name the grid configuration, type the name in the drop-down menu, located at the

upper right side of the screen.

5. Click the Save button.
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Using Grid Edit

1. From the Student or Staff General tab, filter the person list to display the individuals
for whom you want to edit information using the Grid Edit feature.

2. Click the Grid Edit button.
The Grid Edit screen opens.

3. Select the configuration from the drop-down menu that contains the fields to edit.

4. Click in the cell to edit.
A dotted border appears around the cell.

5. Press the Backspace button on the computer keyboard until all incorrect data is

deleted.
| Tutor | Tutar | Tutar | Tutor | Tutor
| Math and &lgebre| English | Days Available | Number at one| Date passec
Aaron, Tyler NO
Abell, Adam
Abell, Angel

Adams, Edward

Adams, Johnathon

Adams, Julie

Ainge, Braiden

Anderson, &nna

Anderson, Jake | |

Anderson, Joeseph |YES | | 07/21/2003
Andrews, Gabrielle

Armstong, Evan

Ammstrong, Evan

Ashton, Rick | | |

Ashworth, Michael NO (YES  wednesday: friday | 3 07/10/2009
Auvenshine, Darren | | | |
Bakies, Aaron | | tuesday: thursday | 1|
Banks, Cody

Bargas, Braden

Bargas, Ray

Barkley, Aaron

Basden, Alex

Bosworth, Pam

Bowman, Samuel

Boyd, Zachary

Bradley, Zoe

Brock, James

Brodburg, Daffy

Buck, Charles

Burke, David

Burke, Noah

Save SetUp Print Exit ]User Defined Ll Help
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6. Enter the appropriate information:

a.

7. You may adjust the column size on the grid by hovering

Text: when you double-click on a
row that is configured to allow for
text, the Edit screen will open.
Type or paste into the text field the
information you have collected;
click OK to save or click Cancel to
exit without saving.

EDIT

[Type your text here |

o]

Cancel |

Yes/No: when you click on a row that is configured | Select Yes/No
to be a Yes/No selection, the Select Yes/No screen

will open. Select Yes or No, by clicking on the word.

" No

Date: when you click on a row that is configured
to be a date, the Select Date screen will open.

From the calendar drop-down, select the date or
click Clear to remove a previously selected date.

Select Date

1/22/2010

Clear J

Integer and Real Number: when you click on a
row that is configured to be either an Integer or
Real Number, you may begin typing the information
directly into the grid.

UD Selection

Black
Blue
Green
Grey
Orange
Purple
Red
Silver
White
Yellow

Defined List Select: when you click on a row that
is configured to be a Defined List Select, the UD
Selection screen will open. Select from the pre-
determined selections that you added in the
configuration process and click OK.

over the grid line that separates the two columns. The
cursor changes to a double sided arrow (<—> ). Click the left mouse button and
hold it down as you drag the grid to be the size you prefer it to be.

8. Click the Save button.

@ Notes:

When information is added, the cell turns yellow; once you click save the cell
turns white.

When you access Grid Edit, it will default to the last configuration selected.
Status and Grade Level are not editable through Grid Edit; they are included as
fields in grid edit for your convenience as reference fields.
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Alerts

Alerts may be set up in either the Student or Medical screen to communicate medical,
monetary, or other urgent information to a variety of RenWeb users.

Alerts may be made visible in a variety of RenWeb Screens or Applications:
~ Student General
~ Cash Reqister
A Lunch Verification
~ Student Clock
~ Medical
~ Teacher
Alerts may be communicated in a variety of methods:
A Visual
A~ Beep
~ Pop Up Until Read

~ Pop Up Always



Configuring an Alert

1. From the Student or Medical screen, click the Alerts button.
The Student Alerts screen opens.

2. Type an Alert Name.

Alerts (=3
inti
3. Type a Description. '°m° AlettName [10
IForgot Medication at Home
4. Click Save. Description
Th f h | h Do not allow Tyler to eat anything that he did =~ »
e name of the alert saves to the not bring from home. He does not have his
Ieft Side Of the screen epipen and is highly allergic to peanuts.
The Alert List will be in Aeckcations
alphabetical order. Student GeneralV'B
Cash Register
To control the order of Alerts, you Lunch Veriication
Student Clack
can type a number at the i
beginning of the Alert Name.
The Applications list for which

you may configure an alert to be [': ::::'
visible display below the I~ Pop Up Until Read
Description. [~ Pop Up Always
. . . Save Delete New
5. Click the name of the Application : o |
in which to make the alert display. | | B | _ Hee |

a. Student General
b. Cash Register
c. Lunch Verification
d. Student Clock

e. Medical

f. Teacher
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6. Select the Communication Method by which to communicate the alert to the
RenWeb user.

a. Visual
b. Beep
c. Pop Up Until Read

d. Pop Up Always

@Note: You do not need to save the Alert after selecting the Applications and the
communication method; it saves automatically.

7. Click New to add another alert or click Exit to return to the previous screen.
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Communication Method

There are four communication methods available for an alert that indicate the importance or
urgency of the alert for a RenWeb user. It is possible to combine the communication
methods as desired to further emphasize the information:

~ Visual ~ Pop Up Until Read
~ Beep ~ Pop Up Always
Visual

When assigning a communication method of Visual to an alert, the Alert tab of the selected
applications will be in the forefront when the RenWeb user enters the screen. The Alert tab
will be part of a tab group on the screen and the location of the tab group varies with each
screen/application.

Beep

When selecting to assign a communication method of Beep to an alert, a beep will sound
when the student is selected. The alert will also be listed on the Alerts tab, but the tab will
not come to the forefront of the group tab unless a communication type of Visual is also
selected.

Pop Up Until Read

When selecting to assign a communication method of Pop Up Until Read to an alert, the
alert will display as a pop up until you click the, | have read these alerts, button. Once you
click that you have read the alerts, the alerts will not display in a pop up. Even if you click
that you have read the alerts, the alerts will still be listed in the Alerts tab.

Pop Up Always

When selecting to assign a communication method of Pop Up to an alert, the alert will
display until it is deactivated from the Alert configuration screen. The Pop Up Always alert
type will also be listed in the Alerts tab.
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Portfolio

The student Portfolio represents a student's most exemplary work. It allows you to store
electronic copies of General documents, Grade Book progress reports, Report Cards,
Transcripts and Class Work. Progress Reports, Report Cards and Transcripts are
automatically saved to the Portfolio when they are archived.

Suggested Security Rights

In order for a user to utilize the Portfolio areas of the program, he or she must have the
following rights in the Security screen.

~ Portfolio (Advisor): If an individual has this security right and is the advisor, they
can view all portfolio documents for students for whom they are set as the advisor.
They may also upload General and Class Work documents.

~ Portfolio (All): If an individual has this security right they can view all portfolio
documents and upload General and Class Work for all students. They will need the
Archive portfolio right if they want to add Progress Reports, Report Cards and
Transcripts to the portfolio.

~ Portfolio (Instructor): If an individual has this security right they can view only
documents that they uploaded and can upload documents through the Grade Book.
(An instructor will need to be assigned to a class in order to see that class in the
Grade Book and will also need security rights to access the Grade Book.)

~ Archive: If anindividual has the right to archive documents, they will be able to add
Progress Reports, Report Cards and Transcripts to the Portfolio. They will need the
Portfolio security right to access those documents.
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Portfolio Contents

When archiving Progress Reports, Report Cards or Transcripts the portfolio will only
maintain a certain number of copies:

~ General: There is no limit to the number of General file types that can be uploaded
and housed in the portfolio.

~ Grade Book: There is no limit to the number of Grade Book file types that can be
uploaded and housed in the portfolio.

~ Grade Book Progress Report: The summary progress report is archived, as
opposed to individual classes. The portfolio will allow for one Grade Book Progress
Report to be archived per term. If you archive more than one per term, you will
overwrite the Grade Book Progress Report in the portfolio with the newly archived
Grade Book Progress Report.

~ Progress Report (Report Card): The portfolio allows for one Progress Report
(Report Card) to be archived per term. If you archive more than one per term, you
will overwrite the Progress Report in the portfolio with the newly archived Progress
Report.

~ Report Card: The portfolio allows for one Report Card to be archived per term. If
you archive more than one per term, you will overwrite the Report Card in the
portfolio with the newly archived Report Card.

~ Transcript: The portfolio allows for one Transcript per template type to be archived
per year. If you archive more than one per template per year, you will overwrite the
Transcript in the portfolio with the newly archived Transcript.
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Uploading a Document Using the Student Screen

1. From the Main Menu, click Students.
The Student screen opens.

2. Select the student whose portfolio to access.

3. Click the Portfolio button.
The Portfolio screen opens.

From this screen you may add documents with a file type of General or Class Work.

Type File Name |Date Saved | Year | Term | Class | Note
General Mentoring Schedule.docx | 02/26/2010 | 2003-2010  Created School Mentor
Report Card 201 urke_Da enefic_ | 05/05/2009

Report Card__| 2008201 ke_David_ReportCard3P him (031772003

ReportCard | 2008-2003 T0_Burke_David_Re 1. |01/13/2003 | 2008-200

Class Work G : 02/26/2010 | 2009-2010

File Type
Upload New Document | I > General
School Year Class Grade Level " Grade book
Download All Documents | | =l | =l |  Refresh | ;Heport Card
7 Transcript
Exit | Help I " Class Work
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4. Select the File Type for which to upload a document.

a. General: This document can be a copy of an award the student won, a
commendation or an extracurricular project the student completed.

b. Class Work: This document is a copy of exceptional class work completed
by a student. When selecting this file type you must first choose a School
Year and Class.

5. Select the School Year with which to associate the document.

6. Select the Class with which to associate the document, if applicable.
7. Select the Grade Level with which to associate the document.

8. Type a Note in the notes field if desired.

9. Click Upload New Document.

10. Click Refresh.
The document is added to the list of items in the portfolio.
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Downloading a Document Using the Student Screen

1. From the Main Menu, click Student.

Portfolio Options |:]
The Student screen opens. B

Download [View)

2. Select the student whose portfolio to access.

3. Click the Portfolio button.
The Portfolio screen opens.

|
Delete I
I

Cancel

4. Double-click on the row of the file to download.
The Portfolio Options screen opens.

5. Click the Download (View) button. GBK ==
A message box opens, alerting you ,
. File has been downloaded to the Download folder in your RWUserFiles
that the file has been downloaded to A folder,
the Download folder in your
RWUserFiles folder.

6. Click OK.
If your computer recognizes the format in which the file was saved and has the
appropriate program to open the document, the document opens.
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Family Access

The Family name on the student screen acts as a shortcut to the family screen. The plus
sign to the right of it enables the user to connect a student to more than one family. It is
possible to add a student to an existing family or to create a new family for a student. If a
student is connected to more than one family, upon clicking the family button, the screen to
the left will open. The family screen is accessible from the main RenWeb screen or by
clicking on the family button in the student screen.

Creating a New Family for a Student
1. Select the student for whom to add a family.

2. Click the + (plus) button beside the Family

box.

A selection screen opens Add student to existing family I
3. Click Create new family for student. Create new famil for student |

The Edit Family screen opens. [~ Blank Family

Select Family

Aaron, Jimmy and Pamela

@Note: Clicking Create new family for student
will create two generic parents for the family,
using the student's last name. If creating a non-
traditional family for the student, select the
Blank family option before clicking the Create
new family button.

Cancel Help
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Linking

RenWe

b contains a feature that helps save time and effort when changing address

information for students who have family members in the same school or district. This

feature

is called a link, and it connects addresses for different individuals together so that

any changes to one individual's address will automatically update the addresses of all others
with the linked address.

1. Select the student or individual for whom to link an address.
2. Click the Link button in the address box.
The Link Address window opens.
3. Click on the address to which to connect the student.
The individual is now linked by their address to others with the same address (as
listed in the Link Address window). Any changes to one individual's address will
automatically update the addresses of all others with the linked address.
Link Address =34
Address | People at this address...
1474 Orange Ave Fort Worth TX 76103 [Chase] [Paullette] Wallace Abemathy Kristin Abernathy
< | e »
Cancel Help
Unlinking an Address
1. Select the student or individual for whom to unlink an address.
2. Click Clear button in the address box.

The address fields are cleared and the address is unlinked from all other addresses.
Any changes to the selected individual will now only affect that individual's address.
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Linking a New Student to an Existing Family
1. From the Student screen, select the student with an unlinked address.

2. Click the Link button.
If the student is not part of a family, the Select Family window opens.

a. Use the Filter to adjust the family list that appears.

b. Click on the family with whom to link the student.
The Link Address window opens.
If the student is part of a family, the Link Address window opens.

3. Inthe Link Address window, click the address to which to link the student.

4. Select OK to link and exit or click Cancel to exit without linking.
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Family Screen Functionality and Layout

' Edit Family =
i Relationships ]
|  FamiyD Famity UD ID iy Notes
- Fiter [e58094 [ -
| ~| | Famiy Name
|Abemathy. Wallace and Kristin
Chase Abemathy (Enrolled - 01) [¥ Web Enabled _Ao_|
Paullette Abemathy (Enrolled - 08) I~ Unlisted (Directory)
¥ Accounting
Family UD
Add Student | Remove Student | Delete Famiy ==
i~ Parents / Grandparents
1. Wallace Abemathy oderf0 0 [~ Financial Responsbiity ~ Employment | Commitees | Service Hours |
2. Kiistin Abemathy B T IR e ——— Preferences | Mail Label | Education Email History |
lostNeme[ | Street | Date | From | subject
First Name ]— City I—
Middle Name 17 State ZIP l_ li
Add | _ Remove | Nickname 17 Country ,7
Bithdate | __Clear | _ Lk |
~Parent Fiter ————————
& SSN Gender[ |
" Custody Home Ph Marital Status v ll
(" Grandparent Cell Phone Religion v[ :I
€ Financial Responsbilty D cuch[ o]+
Emal [
Email #2 ]— User Defined l Medical I Interests |
Webl—' x| +| _New Person I Delete Person from RenWebl
|

Students associated with the family will be listed in the text box on the left of the screen.

~ Add or remove students from the family using the Add and Remove buttons beneath
the list of student names.

~ Enter notes regarding the family into the Family Notes memo field.

A Using the check boxes under the Family Name, determine the following:

Web Enabled checking this box indicates that the family is
enabled to view information on ParentsWeb
Unlisted checking this box keeps the family information

(Directory) out of the school or district directory

Accounting checking this box indicates that this family

should be included in all accounting features

In the bottom half of the screen, RenWeb creates two parents, using the student's
last name. To edit the parent information, select the parent from the list.
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1. Add personal information:

a. The Order field will determine the order in which additional family members

are displayed.

b. Checking the Financial Responsibility box indicates that the person listed is

financially responsible for the family.

c. The parent address may be linked to the student using the Link or Unlink
button under the parent address column.

2. Click Apply before selecting the second parent for whom to add information.

®Note: Once addresses are linked, changing the address for one linked family member will

change the address for all linked family members.

School/District Filter

It is possible to filter the family list by school:
enrolled, pre-enrolled, graduate, withdrawn, all,
family with no children and family with no people
or by district: enrolled, pre-enrolled, graduate,
withdrawn, all. A drop-down menu filter allows the
user to update information on any family in the
database without having to leave the family
screen. Select the filtering option from the menu
and then select a family from the drop-down menu
directly above the filter.

Edit Family

Family General | Refationships |

I ]

Filter

[SCHOOL ENROLL |
d SCHOOL ENROLL

SCHOOL PRE-ENROLLED -
SCHOOL GRADUATE
SCHOOL WITHDRAWN
SCHOOL ALL
FAMILY W/ NO CHILDREN
FAMILY W/ NO PEOPLE

—

—|DISTRICT ENROLL L
|DISTRICT PRE-ENROLLED
DISTRICT GRADUATE
DISTRICT WITHDRAWN e
DISTRICT ALL h 4

fion
ADMISSIONS
INQUIRY pme

|STAFF i
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Defining Parent Relationships

After creating parents or family members for the student, it is important to establish what
their relationship is to the student.

1. Click the Relationships tab at the top of the Family screen.

2. Double-click on the cell in the Relationship column.

The Relationship window opens.
3. Select the relationship the adult has to the child from the drop-down menu.
4. Click OK.

5. Click in the Custody, Correspondence, Grandparent, Report Card, and
ParentsWeb (this enables an individual to view the ParentsWeb) cells to indicate
Yes or No that the individual has access to that area of student information.

Family Generaf(_ Relationships )

Adults | Children | Relationship| Custody | Correspond | Grandpareni| Report Card | Parentsiwet

Wallace Aberathy | Chase Aberathy  Father YES 'YES NO 'YES NO
Wallace Abernathy | Paullette Abemathy | Father (YES (YES NO \YES NO
Kristin Abemathy ~ Chase Abemathy  Mother YES YES NO 'YES NO
| YES (YES NO

Kristin Abemathy  Paullette Abemathy  Mother YES NO

Help

0K I Cancel Apply
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Adding a Student to an Existing Family

In the event that the student is new to the school, but he or she has siblings who already
attend the school, you will not need to create a new family for the student you can add the

student to the existing family.

1. From the Student screen, click on the
student name to add to an existing family.

2. Click the + (plus) button beside the family
name.
A selection screen opens.

3. Click the Add student to existing family
button.
The Select Family screen opens

4. Use the Filter to control the list of family
names displayed.

5. Click the name of the family to which to
add the student.
The student is added to the family and the
Family screen opens.

Removing a Student from an Existing
Family

It is possible to remove a student from a family
without deleting him or her from RenWeb.

1. From the Student screen, select the
student to remove from a family.

2. Click the + (plus) button beside the family
name.

3. Click on the student's name to remove
from the family.

4. Click the Remove button.

Add student to existing family I

Create new family for student I

[ Blank Family

Select Family

Aaron, Jimmy and Pamela

Cancel Help
Select Family ==
Filter
|SCHOOL ENROLL |
Abernathy, Wallace and Kristin -

Accounting Trainee
Adams, George

Adams, Melinda

Adkins, Michael and Roylynn
Armstrong, Keith and Angela ‘
Barron, Mike and Becky

Barrs, Clifford and Sara

Bates, Roberts and Anna

Biggs, Sonia

Biggs, William and Sarah

Blue, Robert and Jessica

Boston, Charles and Marsha

Boyd, Sandra and Ray

Briscoe, Harry and Sue

Brown, Gary and Lacy

Buchannan, Hary and Felicia

Carter, Paula

Carter, Randal

Cathey, Judy

Cathey, Ray

Cherry, David and Michelle

Christians, Steven and Mattie

Clark, Bradley

Clark, Tiffany

Clifton, Jonathan and Karen

Cocrhan, Wiliam and Staci

Cole, Robert and Marinela i

Cancel

The student is immediately removed from the family.
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Adding Parent or Contact Employment Information

It is possible maintain detailed records regarding the parent's work contact information.

1.

2.

From the Edit Family screen, select the desired parent or contact.
Select the Employment tab in the lower right corner of the Edit Family screen.

Double-click the first empty field.
The Edit Employment dialog box opens.

Enter the employment data and click OK to save changes or click Cancel to leave
without saving changes.

Edit Employment 22|

Job Category | | ;I

Occupation l

Company l

Work Phone l |
Street l
City l
State I
Zip |

[ Matching Gift Employer

l Matching Gift Employer ID

oK I Cancel I Help
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Adding Parent or Contact to a Committee
RenWeb allows users to indicate parent involvement in school committees.
1. Select the desired parent or contact.

2. Select the Committee tab in the lower
right corner of the Edit Family screen.

Edit Committee (=3
3. Type in or select a Committee from the Cait i
[ =
drop-down menu. = Cancel
] Delete
4. If the individual holds an office on that . —tJ
committee (i.e. President, Secretary, |
Treasurer) type the information in the
Office field.
5. Type any notes necessary in the Notes
field.
6. Click OK to save changes or click _ Heb |

Cancel to leave without saving changes.

Viewing Email History

The Email History tab provides you with an at-a-glance view of every email that has been
sent to a parent's email address from the school.

~ If you do not see the Email History tab, you need to be sure you have the Email
History security right.

~ |If you have view rights, you will be able to see every email that has been sent to the
parent's email address from anyone at the school, but you will only be able to read
the emails you have sent.

~ |If you have modify rights, you will be able to see every email that has been sent to
the parent's email address and read every email that has been sent.
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Adding Family Service Hours

RenWeb offers schools a simple, updatable way to track family service hours. You can
track information for any individual associated with a student. Only custodial parent service
hours will display in the Family Service Hours report in Report Manager (Student).

1. Select the desired parent or contact.

2. Select the Service Hours tab in the lower right corner of the Edit Family screen.

3. Double-click on a blank row to add a Service Hours record.
The Edit Service Hours screen opens.

4. Select the School Year with which
to associate the hours.

5. Select the Date on which the
service hours were completed.

6. Type in or select a Description
from the drop-down menu.

7. Type the numbers of Hours
served.

8. Include any necessary notes in the
Notes field.

9. Enter the name of the verifying
party in the Verified by field.

10. Click OK to save changes or click

Family Service Hours

School Year

|2009-2010

Date

Cancel

| 341072010

Description

Ll Delete

Help

Hours
|D

Mote

e |
=]

Verified by

Cancel to exit the Family Service Hours screen without saving changes.




Setting Parent or Contact Preferences

RenWeb gives schools the flexibility to set preferences for individual parents and contacts.

1.

2.

Select the parent or contact to edit.

Select the Preferences tab in the lower right corner of the Edit Family screen.

Double-click on the first row of the grid.

Select parental preferences:

a.

Auto Email Grade book
Progress Report: parents
may choose to receive an
automatic progress report for
their students via email. They
may choose Daily, Weekly, or
Never.

Directory Block: parents may
choose what information
should be blocked from the
school directory. They may
choose to block Name,
Address, Home Phone, Cell
Phone and Email.

Block from Donor
Synchronization: blocks the
parent's information from

Parent Preference @]

Auta Email Gradebook Progress Report IE) v

Directory Block: Name |
Directory Block: Address |
Directory Block: Home Phone |
Directory Block: Cell Phone |
Directory Block: Email [
Block from Donor Synchronization [
Parent Alert Country Code ﬁ
Parent Alert: Home Phone |
Parent Alert: Cell Phone v
Parent Alert: Work Phone [V
Parent Alert: No Text [

|

being brought into Donor Connect via a sync.

Parent Alert Country Code: for parents who live out of the country, schools

may type in the country code.

Parent Alert Preference: parents may choose how they want to be contacted if
a Parent Alert is sent out, Home Phone, Cell Phone or Work Phone.

Parent Alert: No Text: Allows parents to opt out of receiving text messages
that are sent out through Parent alert.

5. Click OK to save changes or click Cancel to exit the without saving changes.

51



Adding a Medical Event

In the event that a parent is injured on campus, it is possible to add an incident report to a
parent record.

1. From the Main Menu, click Family.
The Family screen displays.

2. Select the Family from the drop-down menu.
3. Click on the name of the individual for whom to add a medical event.

4. Click the Medical button.
The Medical screen displays.

5. Click the Event Log tab.
A list of all medical events displays.

6. Double-click on a blank row to add details about the medical event.
The Medical Event screen displays.

7. Add the relevant details.

8. Click Save.

Ma Student, Parent and Family Exercise

Objectives: Create a Two parent family with one student

Utilize Parent Preferences

Create a family for Paddy P. Patterson
1. Create a new family for Paddy with parents—Patrick and Patricia *Patterson
2. Define their relationship with the student

3. Arrange to have Patrick receive a weekly progress report email at
PatPatterson@yahoo.com.
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Use the Schedule tab to view or change a student’s schedule. This is the easiest way to

Student Screen: Schedule Tab

change schedules for individual students. Viewing a Student's Schedule

1. From the Student screen select a student.

2. Click the Schedule tab.
The Student's schedule displays, automatically assigned to the appropriate template.

3. The template displays the day and time each enrolled/scheduled class meets.

4. If the student is enrolled in classes, the Enrolled Classes grid displays the classes
and the terms for which a student is enrolled.

r~ Fitter

& Al Courses
" Class Group |03 HR
" Requests

™ Activity

Student Course Requests

Transfer

Other School

Print Schedule

Print Grid

Help

Show Unenrolled l

Available Class List Enrolled Classes (All Terms)
s [Name | Teacher I
12 Bible3 Butier, Stephen 7 | %[ % | w| e
2' ART4-3 | Charles, Joan BEEEREE
BRIT HISTS Locks, Jane B EIEIE:
CALC2 Clementine, John 2 [ x| x[ x|
ENG 41 | Kennys, John s |y |y|vy]|x
PHYSICS-1 Glad, John a | %[ x| x|
SPAN4-1 Jacobs, John 4 [y|x|vy|x

Edit Student
'General Schedule I EC. | Finance | Advising | Academics | Misc | Religion | P/T Corference | Behavior | Transcript | Community Service | Picture | Transp |
_<|_> | Edward Adams
[Tem 1 ~| Template [High School ~|
Monday | Tuesday | | Thursday | Friday
Period 1 BRIT HISTS BRIT HISTS BRIT HISTS
Period 2 CALC2 |caLc2 |catc2 CALC2 |caLc2
Period 3 PHYSICS-1 | PHYSICS-t | PHYSICS-1 PHYSICS-1 | PHYSICS-1
Period 4 SPANS-1 SPAN4-1 | sPAN-1 SPAN4-1 | SPANS-1
Period 5 ENG 41 |ENG 41 |ENG 41 ENG 4-1 |ENG 41
Period 6 ART4-2 | ART43 | ART42 ART4-2 |ART43
Period 7 12 Bible-3 12 Bible3 |12 Bible-3 12 Bible-3 |12 Bible-3
101-A 101-4 101-A 101-A 101-A

£pply
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Student Screen: E.C. Tab

The Emergency Contact tab will hold up to 20 Emergency Contacts for a student. You can
manually add or lookup RenWeb contacts to add to this list. The Emergency Contact data
will be displayed on the main Student screen under the Family tab (bottom right). In addition,
the Student Information report will display the first three emergency contacts in the list.

Manually Adding a Contact to the E.C. Tab

If the Emergency Contact does not already exist in RenWeb, you can manually add him or
her to the E.C. tab.

1.

2.

5.

6.

From the Student screen, click on the E.C. tab.

Double-click on a blank row.
The Order # will appear in the Edit Emergency Contact section (lower).

Type the First and Last Name.

Select the relationship the emergency contact has to the student from the drop-down
menu.

Add the Home, Cell, and Work Phone, and an Email address.

Click Save (lower left).

@Note: Parents may not be considered Emergency Contacts in all schools; they are not
automatically added into the E.C. tab. If you want to add a parent to the E.C. tab, you may
add the contact using the Lookup method.
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Adding a Contact to the E.C. Tab Who is Already in RenWeb

If the Emergency Contact already exists in RenWeb, you can pull his or her information into

the E.C. record.

screen, it will automatically update in the E.C. tab.

1.

From the E.C. tab, double-click on a blank row.
The Order # will appear in the Edit Emergency Contact section (lower).

Click the Lookup button.
The Select Person dialog box opens.

Select a Filter by which to sort the Person list.
Click on the contact's name to add to the E.C. tab and click OK.

The contact's information populates the Edit Emergency Contact section; the
person’s ID number displays in the Reference ID field.

Click Save (lower left).

If the person’s information is changed on the Family, Student, or Staff

Edit Student =)

General | Schedule EC. | Finance l Advising ] Academics ] Misc l Religion | P/T Conference l Behavinrl Transcript l Community Service I Picture I Transp I
_<j _>_| Chase Abemathy

Order | First Name [ Last Name | Relationship | Country Code [Home Phone | Cell Phone | work Phone  [Email [ Note

=1

~

@

=

o

@

3

@

©

20,

— Edit Emergency Contact

Order |0 Country Code
First Name Home Phone
Last Name Cell Phone
Relationship v] +|  Work Phone
Refi D |0 Email
oie0c x| & ™ Uniink from siblings (EC/PU)
Save I Delete | Lookup | Move Up Move Down I Help

0K I Cancel 1
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Student Screen: Finance Tab

The Finance tab allows the user to view a student’s financial responsibility and Free Lunch

or reduced lunch eligibility. If a student is attached to two families, you can designate the

percentage that each family is responsible to pay for the student.

Setting up Financial Responsibility Percentages

When setting up financial responsibility percentages, you need to be sure that the total of

entered percentages is equal to 100%.

1. From the Main Menu, click Students.
The Student screen displays.

2. Select a student.

3. Click the Finance tab.

4. Click the cell in the Fin. Resp. column.

5. Use the keyboard Backspace key to clear the cell.

6. Type the new percent amount in the blank cell.

7. Click Apply to save and stay in the Finance tab or click OK to exit.

=
Edit Student

_<| _> | Chase Abemathy

Reduced Lunch Py =

re e Accounting System ] Family Name I Family ID | Fin. Resp.
% Not eligible E bermathy, Wallace and Kr 858094 100.00
S Patic redsced kanch bemathy, Wallace and Kr 858094 100.00]

" Full reduced lunch

Financial Responsibility

Child Care Payment Plan

]Mer Care v I
Help I

"General | Schedule | EC.  Finance | Advising | Academics | Misc | Religion | P/T Conference | Behavior | Transcript | Community Service | Picture | Transp |
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Assigning Free or Reduced Lunch Status

RenWeb allows for Free and Reduced lunch status assignment and reporting. If you want
to indicate that a student is eligible for free or reduced lunch you can indicate the eligibility
on the Finance tab.

1. From the Reduced Lunch Program area select Not eligible, Partial reduced
lunch, or Full reduced lunch.

2. Click Apply to save and stay in the Finance tab or click OK to exit.

Assigning Childcare Payment Plan

If your school utilizes the Live Time Clock Billing for child care management, it is possible to
assign a Daycare Payment Plan to the student. It is only necessary to assign a Daycare
Payment Plan if the student is not utilizing the default plan as specified in Accounting.

1. From the Child Care Payment Plan drop-down menu, select the plan that the parent
has selected.

2. Click Apply to save and stay in the Finance tab or click OK to exit.
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Student Screen: Advising Tab

The Advising tab assigns students to an advisor or counselor (student mentors can also be

assigned here) and maintains records on advisory meetings. Advisors may also enter

course requests for their students, add transcript notes, or monitor a student's curriculum

plan.

Using the Advising Tab

The advising fields are populated utilizing drop-down menus, defined lists and text fields.

1.

From the Main Menu, click Students.
The Student screen displays.

From the student list, select a student.
Click the Advising tab.
The Advising screen displays.
s

"General | Schedule | EC. | Finance  Advising | Academics | Misc | Religion | P/T Conference | Behavior | Transcrpt | Communty Service | Picture | Transp |
;l_)lﬂ\ase.‘bemathy ra

[~ Advisors veng Holes

Facutty Advisor

I |

Clear l
Student Mentor/Advisor
[ =

Clear I

Student Course Requests |

r~Curmiculum Plans

I El=

-

Save Transcript Notes

Save Delete Help |

o]

Cancel

Apply

4. From the Faculty Advisor drop-down list, select an advisor.

5.

If the student has a Student Mentor, select the student's name from the Student

Mentor drop-down list.
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6. Inthe Advising Notes (right), the advisor enters notes about the student and any
interventions or interactions.

a. To enter notes, click in the blank white screen below the gray section and type
the note.

b. When finished with the note, click Save.
The note is recorded, dated and displays in the top of the window.

c. Modify a Note - Double click the row where the note is located. Revise the note.
Click Save.
d. Delete a Note - Double click the line where the note is located. Click Delete.

7. When finished entering information in the window, click OK to save and exit.

@Note: It is not possible to edit the note date as the date is determined by the date on
the user's computer.

Adding a Transcript Note
1. From the Advising tab click in the Transcript Notes field.
2. Type the note to display on a student's printed transcript.

3. Click the Save Transcript Notes button.
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Student Screen: Academics Tab

Use the Academics tab to view and edit (but not add) honor roll and class ranking
information. In addition, it is possible to store standardized test scores for students and
track student recognitions.

Manually Alter Honor Roll or Ranking Information

The initial Honor Roll or Ranking information is created when an honor roll report is
configured and run. That data automatically displays in this window.

1. From the Main Menu, click Students.
The Student screen displays.

2. Select a student.

3. Click the Academics tab.
The Academics screen displays.

BT =
"General | Schedule | EC. | Finance | Advising Academics | Misc | Relgion | P/T Conference | Behavior | Transcipt | Community Service | Picture | Transp |
_<| _> | Chase Abemathy

HONOR ROLL STUDENT RECOGNITION
l L’ | Year | Category | Recognition [Note | Grade Level

Temm [Avg |GPA [Rank [Honor Credit| Date.

™" Exclude Tem Honor Roll

™ Exclude Tem Ranking

™ Exclude Cumulative Honor Roll
I™ Exclude Cumulative Ranking

; STANDARDIZED TESTS
Test | Date [ | | | I [ I

4. To manually alter honor roll or ranking information already present, click the row to
edit.

5. Enter the changes.

6. Click Apply.
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@Note: To exclude a student from honor roll or ranking for the term, or cumulatively, select
the option by clicking in the box beside the appropriate choice listed to the right of the data
window.

Configure Standardized Test Parameters

1. From the Academics screen, click Configure Tests.
The Test Configuration list screen displays.

2. Double-click an empty line.
The Test Configuration screen displays.

3. Input the test information

T ]

Test Configuration
configuration. —
To enter an SAT test, type I Showontanscipt [~ Distict Wide
SAT in the Test Name box. scoel [ scoes | Score 11 | Score 16
The boxes labeled Score 1, sewez [ Sowe | Score 12 | Seore 17
Score 2, etc. correspond to sewe3 [ Somes | Seore 13 | Score 18
sections of the test: scoed [ Sooed | Score 14 | Score 19
Next to Score 1, enter Verbal; sewes[  seoetn [ Seoe’s| s
next to Score 2, enter Math, e | sl [ ovesn] i e
etc.

4. Select Show on Transcript if you want the standardized test record to display on
the printed transcript.

5. Select District Wide to make the test configuration available in all schools in the
district.

6. Click Save to save the test configuration.

@Note: When a test is configured for any student, the configuration is available for all
students.
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Storing Standardized Test Data

1. From the Academics tab, double-click on a blank row in the test storage grid.
The Test Edit dialog box opens.

2. Type the test results for the student into the applicable test fields.
3. From the Grade Level drop-down list, select the student's grade level.
4. Select to Exclude from Transcript if desired.

5. Type a note in the Notes field if desired.

6. Click Save.
Test Edit ==
e =

Test Date 4/ 9/2009 ~ Grade Level ¥
Math|0 o
Englishru—- rﬂ—
Writingl_u— [_U—
Readingl0 o
o o
o o
o b
o o
b b
o o

[ Exclude from transcript
Note |
Save I Cancel Delete } Help




Student Screen: Miscellaneous Tab

The Miscellaneous tab is a data entry screen for a variety of records. It houses previous
school information birth place, locker number(s) and combination(s), as well as automobile
information for school with driving students.

_<| _> | Chase Abemathy

"General | Schedule | EC. | Finance | Advising | Academics Misc | Religion | P/T Conference | Behavior | Transcript | Community Service | Picture | Transp |

Race

r~ Public School District AL
Local School | Make |
Dt | Model :
Auto Lic.
County State
I |_ Drivers Lic. I
Public school information if student was NOT going to this school. Pemit # I
r Locker r Birth Place
Location #1 | ~| City
Combination #1 | State
Location #2 | = Country |
Combination #2 |
Locker Management |
Previous Schools

| Name

| Grade Completed | From |To

| Address

| Phone

| Note

Double cick to ed
Help
oK | Camcel | sppl |
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Public School District

It is possible to maintain a record of the public school (if the student was not attending your
school) information for a student.

1.

Race

From the Main Menu, click Students.
The Student screen displays.

From the students list, select a student.
Select the Miscellaneous tab.

Click in the Local School field and type the name of the school the student would
attend.

Add the District, County and State if desired.

Click OK to save and exit to the Main Menu or click Apply to save and continue
working in the Student screen.

Race is an area that allows schools to specify for state reporting purposes student race.
Race describes biological descent. Ethnicity describes cultural heritage.

-~ Add a Race to the list through the Defined List area of RenWeb Setup.

~ Once the race has been added, click in the field to the right of the race to add a Y for

yes or a blank for no.
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Configure Lockers

1. From the Miscellaneous tab, click Locker Management.

2. Inthe Locker field, type the locker number or name.

a. You can enter up to 5 different combinations and then specify which combination

is currently in use.

b. If a locker becomes out of service, you can label it as such, so it is not mistakenly

assigned to a student.

|#2 [#3 [ #4 [#5 | Curren

101 10530 72413 6129 22716 1867 Locker [101
102 23410 433 71426 81323 3105 e —
103 2163 51520 20155 13246 131630 Combination #1

104 93027 26411 12624 25142 16428 Combination #2 [7-24-13
105 8513 71630 8325 11221 3064
106 10414 6178 9122 32517 25143 Combination #3 |6-12-9
:gg 21162 22212 18526 4217 17267 Conbinaton - 22718
109 41619 13730 10514 6142 28610 Combination #5 [186.7
110 26512 17613 15314 13214 16514
2 4 5 Current Combination |2

Note I~ Dutof Service

Save | Delete |

New

Clear Lockers

Import Configuration File

Set Current Combination l 0

Exit Help I

3. Click Save.

4. To enter a new locker click New repeat steps 2 and 3.
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Assign a Locker

1. On the Miscellaneous tab, in the Locker section, select the locker number to assign
to the student from the Location #1 drop-down menu.
The combination selected in the Locker Management screen displays in the
Combination #1 field.

2. If the student has two lockers, select a second locker from the Location #2 drop-
down menu.
The combination selected in the Locker Management screen displays in the
Combination #2 field.

3. Click OK to save and exit to the Main Menu or click Apply to save and continue
working in the Student screen.

Automobile Information

1. From the Miscellaneous screen, click in the Make field and type the make of the
vehicle.

2. Add the Model, Auto Lic., Driver's Lic., and Permit #.

3. Click OK to save and exit to the Main Menu or click Apply to save and continue
working in the Student screen.
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Previous School Contact Information

The Miscellaneous tab can hold the name, address, and phone of prior schools that a

student has attended.

1. From the Miscellaneous screen, double-click in a blank row in the Previous School

section.
The Edit Previous School dialog box
opens.

2. Type a Name, Address, Phone,
Note, and a From Date and To Date
into the appropriate fields.

3. Click OK.
The information will now be displayed
in the Previous Schools section.

Birthplace

Edit Previous School @
1
Name Address
|
Phone Note
From Date ToDate

Grade Completed

D
o]

Cancel I Delete

1. From the Miscellaneous screen, click in the City field and type the city in which the

student was born.

2. Add the State and Country.

3. Click OK to save and exit to the Main Menu or click Apply to save and continue

working in the Student screen.
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Student Screen: Religion Tab

The Religion tab contains fields for various church related occurrences.

Accessing the Religion Tab

1. From the Main Menu, click Students.
The Student screen displays.

2. From the students list, select a student.

3. Click the Religion tab.
The Religion screen displays for that student.

| Edit Student ==

>General| Schedule| EC: ] Financel Advisingl Academics] Misc  Religion | P/T Corference Behavior' Transcript ] Community Service ] Pictunel Transp |
_<| _> | Chase Abemathy

Denomination v ;J
~Church
Church/ Congregation | ~| ;]

Senior Pastor/ Clergy |

Youth |

Phone l

Street I
Ciy/State/ZIP | [
I” Local church member

[~ Baptism 1 Bar/Bat Mitzvah ‘—Communion ~ Confirmation Reconciliation
e | | I I l
oue | | | | |
ay || ] I l l
sae [ [ i [ | [
Help
0K | Cancel
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Adding a Denomination

1. Click the + (Plus) next to the Denomination

field.

2. The Defined Lists Editor/Religion displays
the list of pre-defined denominations.

3. Type a name in the text box (bottom). Click

Add.

Adding a Home Church

Defined Lists Editor

7th Day Adventist
Assembly of God
Baptist

Catholic

Christian

Church of Christ
Episcopal

Greek Orthodox
Islam

Jewish

Lutheran
Methodist
Nazarene

New
Non-denominational
Prashiterian

m

X
Help

Delete
Seths Defaulll

Exit

Add

1. From the Religion tab, click the + (Plus) next to Church/Congregation to add a
church or edit church information.

The Edit Church/Congregation screen displays.

Edit Church/Congregation

Christ Church &/G
Dallas First Baptist
Fellowship Church
First Nazarene

St. John the Evangelist
United Methodist

Merge Churches

ChurchID |53

Church/ |Chyist Church
Congregation

Phone ]81 7-655-9292

Street |1234 Alta Mesa

City/State/ZIP - [FortWorth [TX [76123

Senior Pastor’fuyiliam Morton
Clergy

Youth IJoseph Miller

New I Save I

Delete |

Esit | Help |

2. Click New.

3. Type information to complete the details of the Church/Congregation details.

4. Click Save.

5. To Edit - Select the church name from the list (left). Correct the information. Click

Save.
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Merging Churches

It is possible that the same church can be entered twice into your database. You can clean
up duplicated Church or Congregation names by using the Merge Churches function.

1. From the Edit Church/Congregation screen, click Merge Churches.
The Merge Churches screen displays.

2. Select the Primary Church and Secondary Church.

a. All people who are assigned to the Secondary Church will be assigned to the
Primary Church.

b. The Secondary Church will be deleted from the database.

3. Click OK to complete the merge or click Cancel to exit without saving.

Other Religious Events

Baptism, Reconciliation, Communion, Bar/Bat Mitzvah, and Confirmation dates may be
housed in the Religion tab. Keep record of the church, date, city and state in which the event
occurred.

1. Click in the desired field and type the desired data.

2. Click Apply to save and stay and OK to save and exit.

@Note: Student church/religion information and Parent church/religion information are not
linked together. This information is specific to the individual.
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Student Screen: Parent/Teacher Conference Tab

Use the P/T (Parent/Teacher) Conference tab to document parent contacts and
conferences. These can include formal conferences, as well as phone conversations and
emails. The left side displays a list of the previous conferences any teacher has had with the
student’s parents or guardians. Changes entered into the right side of the screen are added
on the left side as a record.

1. From the Main Menu, click Students.
The Student screen displays.

2. From the students list, select a student.

3. Select the P/T Conference tab.
The P/T Conference screen displays for that student.

Edit Student (=34
General | Schedule | EC. | Finance | Advising | Academics | Misc | Religion P/T Conference | Behavior | Transcript | Community Service | Picture | Transp |
_<| _> | Chase Abemathy
[ 321720m | [Kate. Emiy ~] New
: Print
Subject I Delete
Location Reason
& Phone Conversation [~ Academic
" In-Person Conference ™ Conduct
" Email/Mail [~ Other (Explain)
Observation ﬂ
[~ Academically Bright [~ Low grades
[ Disruptive in class I~ Poor effort
[ Health issues I Poor study habits
[~ Imegular attendance I~ Progressing very well
[~ Late homework ™ Social adjustment dficu
Recommendation
Parent’s reaction/comments
Help
0K | Cancel I |

4. Click New.
5. From the date drop-down list (top), select the date of the conference.
6. Select the Teacher who created the event.

7. Type in a Subject to describe the event.

71



8. Under Location, select the type of conference: Phone, In-Person, or Email/Mail.

9. Under Reason, check the reason for the conference: Academic, Conduct or Other.
If you select Other, a short explanation can be entered in the text box (right).

10. Select the Observation(s) made which prompted the conference and in the text box,
type the specific details of the problem.

11. In the Recommendation and Parent's reaction/comments text boxes, enter the
school's recommendation(s) for the student and the parents’ response or comments.

12. Click OK to save and exit to the Main Menu or click Apply to save and continue
working in the Student screen.

Edita P/T Conference

1. From the list of conferences documented in the left window, click on the listed
conference to edit.
The recorded information displays.

2. Type any updates.

3. Click OK to save and exit to the Main Menu or click Apply to save and continue
working in the Student screen.
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o Parent/Teacher Conference Exercise
Objective: To enter a conference event
To see multiple entries by various staff members

To delete a conference event

Add a Parent Teacher Conference Event
1. Student: Paddy *Patterson
2. Date: Today’s Date
3. Staff Member: You
4. Location: Phone Conversation
5. Reason: Conduct
6. Observation: Behavior Concern

7. Recommendation: Parent has a conversation with student to discourage
inappropriate behavior as any more demerits will result in a $25 fine and an in
person conference.

8. Parent’s Reaction/Comments: Parent agrees to discuss inappropriate behavior
with student and seemed very annoyed with student.

9. After Trainer views Conference record, delete the conference.



Student Screen: Behavior Tab

RenWeb provides a discipline recording and reporting system that eliminates the need for a
middle person (the offending student) and limits the necessity of time-consuming, repetitious
phone calls from the teacher to the parent. RenWeb also allows schools to easily track
discipline offenses, even when reported by different teachers. Teachers may then view
notes made by other teachers.

The Behavior tab:
~ Displays all merits in black and all demerits in red.

~ Summarizes the merits and demerits earned for each term, and provides a
cumulative (yearly) amount for each.

~ Allows you to print all of a student's behavior events.

~ Lists the last two sanctions a student has received.
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Entering Behavior Information

1. From the Main Menu, click Students.
The Student screen displays.

2. From the students list, select a student.

3. Select the Behavior tab.
The Behavior screen displays for that student.

4. Double-click an empty row to enter a new record.
The Edit Behavior screen opens.

_<|_> | Chase Abemathy

Date Event | Desciiption

| Sanction [ Status | Demerits [ Meiits

03/25/2011) Cleaning the Classroom Chase wiped off all of the classroom desks and Merits
03/21/2011| Chewing Gum

Chase was chewing gum 3 times in the same cl. 30 minute Open |

20/

20

Behavior Summary
Demerits Merits

Term 1 0.0 0.0
Tem 2 0.0 0.0
Term 3 0.0 0.0
Term 4 00 00
Term 5 20 20
Term 6 0.0 0.0
Year 20 20

"General | Schedule | EC. | Finance | Advising | Academics | Misc | Religion | P/T Corference  Behavior | Transcript | Community Service | Picture | Transp |

™ Show All Years

Lpply
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5. Add the following information into the Edit Behavior screen:

a.

g.

Date: Use a calendar
to set an incident date.

Reported By: a drop-
down list includes
school faculty and
administration.

Event: a drop-down
list of school specific
infractions or ability to

enter unigue situations.

Description: type a
detailed description.

Notes: type private
notes that parents are
unable to view

Edit Behavior ==
Date Reported By
p temorize
v Kate, Emil v
[ar212011 ~] [Kate, Emily | e
Event
IChewingGum L]_ﬂ

Description of Event

Chase was chewing gum 3 times in the same class period.

Notes [Confidential - Parents do not see these notes)

Have sent the parents an email requesting tha tthey check Chase's backpack for gum every moming]

Email Send Options

_1] ;I [~ Parents

Sanctions
[ 3212011 > ] [30 minute detention

[‘32120m ~]| Elfi
<Not Assigned> -
Accounting, Trainee
Level |0 S Bars, Sara =
Demeiit & Status Briscoe, Susan
emerit * i
! 2 Open = Class, Trainer
Merit € | [ R —J—] Fry, Angie
Print Kate, Emily ;
Email
| Save and Exill Cancel | Delete l Help

Sanctions: select the sanction/s imposed

Demerits/Merits: log the number of demerits or merits

6. When finished, click Save and Exit to return to the Behavior tab.

@Note: An email report may be sent to the parents, principal or other involved parties.

~ Select Parents or Advisor.

~ Click on a Faculty member's name.

~ Click Email.
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M Behavior Exercise
Objective: To enter a behavior incident
To see multiple entries by various staff members

To delete a behavior event

Add a Behavior Event
1. Student: Paddy *Patterson
2. Date: Today’s Date
3. Staff Member: You
4. Event: Pushing other students in the hall

5. Notes: Paddy seems very angry. He often has outbursts in class and often
assaults other students.

6. Sanction: Detention
7. Demerits: 5
8. Email Options: Send one to Advisor (you) and Parents

9. After Trainer views behavior event, delete the behavior event.
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Student Screen: Transcript Tab

Most of the information on this screen is entered automatically when Grade book grades
are loaded to the Report Card. The only time it is necessary to actively work in this screen
is when adding a new student who has transferred from another school. The initial screen is

the historical transcript information.

Accessing the Transcript

1. From the Main Menu, click Students.
The Student screen displays.

2. Select the student whose transcript you want to view.

3. Click the Transcript tab.
The Transcript screen displays

Edit Student =]
"General | Schedule | EC. | Finance | Advising | Academics | Misc | Religion | P/T Conference | Behavior Transcipt | Communty Service | Picture | Transp |
_<| _> | Chase Abemathy @ Grades (A) " Grades (HS) " Absent/Tardy ¢ Rank/Honor

L|Year | Course | Leve| Crec| Grac| ava | GPA | UGP| Pass| Calc| GL | &bbrev. | Department | School | Trar|Sch. Code [ Instructor

¢ 2008-2009 Sem 1 Geomety | B 87E 30003000 Y | Y | GEOMTY Mathematics | Northwood Academ N Rw-TRAIN |

2003-2010 Sem 1| Algebrs ors | AP 1.25( 85 850 40003000 Y | Y | ALGTH  Mathema

Y| 20092010 Sem 1 -TRAIN |
RW-TRAIN |

Y 20032010 Sem1 |

Credits (Attempted) = 65000 Cum.Avg.= 899615 S : . Sot
Credits (Eamed) = 65000 Cum GPA= 35154 PintGid | Prnt Transcrpt | © Yox |C Dot Help
Ccum UGPA= 34385
0K | Cancel | Bpply
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Transcript Selections
At the top of the transcript screen are several options for viewing the data:
~ Grades (All) — View all of the grades the student has had at this school (campus).
~ Grades (HS) — View all high school classes the student has taken at this school.

~ Absent/Tardy — View the cumulative Day (not Period) attendance the student has
had at this school.

~ Rank/Honor — View historical rank and honor roll for this student at this school.

Statistics
At the bottom of the screen is a set of statistics for the grades shown in the grid:
~ Credits Attempted and Earned
~ Cum. Average
~ Cum. GPA

~ Cum. UGPA.

Print Buttons
At the bottom of the screen are two print features:
~ Print Grid — Prints the displayed grid without any changes.

~ Print Transcript — Prints the current student’s transcript. (The default transcript must
be set in the Grade Level Configuration.)
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Automatically Entering Transcript Grades

RenWeb automatically saves the grades in the transcript when loaded to the report card. In
order for this to occur, the courses a student is taking must be set up correctly in the Edit
Course screen.

First, the HS Credits is used to determine how many credits are assigned to a class when it
is loaded into the Transcript. Secondly, the Transcript Loading section determines which
report card grade should be loaded.

N

Do Not Load on Transcript.

Term Grade — Each term (quarter) is loaded individually. This is not normally done
for high schools.

Semester Grade — The grade is loaded into the transcript at the end of each
semester.

Final Grade — The grade is loaded into the transcript only at the end of the academic
year when Final Grades are calculated on the report card.

@Note: The credits identified are the credits earned when the grade is loaded. If a
course earns a total of 1 credit for the year but the grade is entered into the transcript
in two semester pieces, then the HS Credits should be .5. When both semester grades
are earned, the student will have received a total of two .5 credits for a total of 1 credit.
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Manually Entering Transcript Grades

There are times when grades must be modified or new grades must be entered for a
student. This typically occurs with transfer credits:

1. Double-click on the blank line at the top of the screen or the entry line to make
changes to currently entered transcript information.

The Edit Transcript window appears.

2. Enter the information requested in the window:

a.

Year: Select the academic
year for the credit.

School Granting Credit:
Select the school where
credit was earned. If no
schools are listed, the user
may either manually type in
the school name or use the
“+” button to add the school
name to the Defined List of
schools.

Semester: Choose the
semester for the grade

Edit Transcript

IV Manual Entry

Year

School Granting Credit

Semester

Course Title

ﬂ ISchedule Training High School

Base Course

31

Grade Level

& None
" Semester 1
" Semester 2

Credits

Instructor

Department

=

I Summer School
Tem v

[0 |

Level

Grade Avg GPA

|

UGPA

[

Ed | [0 [0

[~ Pass ™ Cale.

I Transfer Credit

I High School Credit

State ID

[o

Note

Absent IU |

Save I

Tardy |0
Source Report Card Grades
Class

T T4

13
Gade [ [ [ [ [

Grade changes here do not affect the
report card.

T5 TE E1 E2 51 52

| |

veege oo oo oo o oo o

Apply |

Delete | it | Help

(

(choose None for a singleffinal grade per year) and indicate if this class was

earned in summer school.

Course Title: Title of course.

Base Course: Select the course (from the school's list of courses) that is
equivalent to the transferred course. If the transferred course is not
equivalent to any course the school offers, leave blank. Selecting a Base
Course will fill in most of the field options for the rest of the screen. Make any
necessary changes to field entries.

Grade Level:

Select the grade level of the student when he or she earned

the credit. The grade level should match currently entered grade levels (i.e.,

Ol.or 1, 02 or 2, etc.)

Credits: Enter the credit worth of the course. (Do not enter a O if the student
failed the course. This field is attempted credit, not earned credit.)

Instructor:

If known, type the name of the instructor.
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q.

r.

Department: Select the department category of the course. (This is an
important field by which courses are sorted on several transcript templates)

Level: Select the level for the course (STD, AP, HONORS, etc.).

Grade: Enter the grade for the course. This is typically the displayed grade
on the transcript and may be either a letter grade or a number grade.

AVG: Enter the numeric average that was earned for the course.
GPA: Enter the associated GPA for the course.
UGPA: Enter the associated Un-weighted GPA for the course.

Pass: Select if the earned grade is a passing grade, and earned credit will
be assigned.

Calc: Select if the grade should be calculated into any type of honor roll or
ranking.

Transfer Credit: if the course is a transfer credit.

High School Credit: Select if the course is for HS credit.

3. Click Save, then repeat the process for any additional courses that need to be
entered.

@Note: To edit a record already entered, double-click the record.
Make changes in the Edit Transcript window.
Click Save.
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M Transcript Exercise
Omit if Elementary or Middle school doesn’t use transcript for permanent record
Objectives: Add a manual entry to a transcript

Delete a manual entry from a transcript

Add a manual entry to the transcript for Paddy Patterson
1. Year: 2005-2006
2. School: Peterson Academy
3. Course Title: Algebra 1
4. Base Course: Algebra |
5. Grade Level: 09
6. Credits: 0.05
7. Grade: 90
8. Average: 90
9. GPA: 3.6
10. UGPA: 3.6
11. Transfer Credit: Yes
12. High School Credit: Yes

13. Show the trainer the manual entry

Delete the manual entry from the transcript for Paddy *Patterson

1. Delete the Algebra 1 manually added transcript record
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Student Screen: Community Service Tab

Many schools have a community service component as part of their curriculum or graduation
requirements. You can enter, update and track the community service projects, and number
of service hours performed by their students, under the Community Service tab of the
Student screen.

1. From the Main Menu, click Students.
The Student screen displays.

2. From the students list, select a student.

3. Click the Community Service tab.
The Community Service screen displays.

Edit Student [=

Genevall Schedulel EC. I ﬁnance] Advising | Academial Misc I Religion] P/T Conferencel Behavior] Transcript  Community Service IPidure] Transpl
_<| _> | Chase Abemathy

Date Service | Hours

01/17/2011| Volunteered at the local nursing home 2.00
03/19/2011] Trash Cleanup

Edit Community Service

Date Description
w1 v| [Trash Clearup

Save |

Total hours worked: 6.00 kep

oK Cancel bppy |

4. Double-click an empty line.
The Edit Community Service screen displays.

5. Select the Date on which the service time was earned.
6. Click in the Description field to type a description of the work performed.

7. Inthe Hours field, type in the number of hours worked for that service credit.
The program calculates a running total of time earned per year.

8. Click Save.

84



Student Screen: Picture Tab

The Picture tab allows you to upload photos of each student. School photographers often

provide the pictures in the recommended format, saved by student id, 172 X 228 pixels - as

a JPEG or GIF.

Accessing the Picture Tab
1. From the Main Menu, click Students.

The Student screen displays.

2. From the students list (left), select a student.

3. Click the Picture tab.

The Picture screen displays for that student.

Edit Student

_<|_> | Chase Abemathy

General | Schedule | EC. | Finance | Advising | Academics | Misc | Religion | P/T Conference | Behavior | Transcript | Communty Service  Picture | Transp |

Single Picture

File Name
Iyearbook photo jpg

Save
Upload File

|C:\Users\.Rebecca Tumer\Desktop\Stuff\RHGr

Browse I

e

| Finished.

~ Muttiple Pictures -

Directory Where Pictures are Stored

Browse
@ Student ID
" SchoollD
Mask
JPG
Upload

Help

Cancel
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Adding a Picture for One student at a time:

1.

From the Picture tab, click the Browse button.
The Open file window opens.

Navigate to picture of the selected student and click Open.

Click Upload.
The file uploads and displays the word Finished below the Upload button when it
has uploaded.

@Note: The benefit of loading pictures this way is that the name of the file is not that

important because it may be named in any manner desired in order to identify it.

Adding an Entire Folder of Pictures at One Time:

It is important that the photographer has the student ID numbers in order to identify the staff
picture by the id. Using the Multiple Pictures section you may import multiple pictures at

once.

1.

Save the pictures to the C drive (specific instructions for exporting from Life Touch
CD to your computer are found under help demonstrations>Importing Student
Photos).

In the Multiple Pictures section, click the Browse button to locate where on your
computer the pictures are saved.
The Open file window opens.

Open the folder and click on one of the photos.

Choose the Mask (or file extension) for most it will be JPG (please note that this area
is case sensitive).

Click Upload and it will upload one picture at a time.
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Student Screen: Transportation Tab

The Transp.(Transportation) tab is comprised of two tabs, the Pick Up tab and the
Carpool/Bus Tab.

The Pick Up tab holds up to 20 records of individuals with permission to pick up a student
from school. You can manually add or lookup RenWeb contacts to add to this list. The Pick
Up data will be displayed on the Student screen under the Family tab (bottom right). In
addition, the Student Pick Up report will display all individuals on the Pick Up tab for a
student.

The Carpool/Bus tab allows you to create bus routes and carpools for assigning, tracking
and reporting. After they are created you can assign the routes to students and generate
reports over it.

' Edit Student =
General I Schedulel EC: l Finance ] Advising | Academics I Misc ] Religion l P/T Conference I Behaviorl Transcript I Community Service} Picture  Transp |
_<| _> | Tyler Aaron

Pick Up [XCarpool/ Bus | :
Order| First Name [ Last Name | Relationship | Country Code [Home Phone [ Cell Phone  [Work Phone | Email [ Note
1| Becky Turner Aunt 556-556-555
2| Stephanie  King Friend 555-555-7777 stephking@hotmail.com
3| Shirley Long Grandparent 555-222-5555
4
5
6
7
8
9
10
11
12
13
14
15
16
17
18
19
20
1~ Edit Pick Up -
Order |0 Country Code Subdivision
First Name Home Phone
Last Name Cell Phone
Relstonshp [ =] _+| Work Phone
Reference ID [0 ] Email
I Add To RenWeb Person Table
Save Delete Lookup ' Move Up l Move Down I Help
0K | Cancel | ippy
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Manually Adding a Pick Up to the Transp. Tab

1.

2.

7.

From the Student screen, click the Transp. tab.

Double-click on a blank row.
The Order # will appear in the Edit Pick Up section (lower).

Type the First and Last Name.
Select the Relationship the pick up has to the student from the drop-down menu.
Add the Home, Cell, and Work Phone, and an Email address.

Select the Add to RenWeb Person Table option if you plan to utilize the Pick Up
Check In/Out feature.

Click Save (lower left).

®Note: Parents may not be considered Transportation Pick Ups in all schools; so they
are not automatically added into the Transp. tab. If you want to add a parent to the
Transp. tab, you may add the contact using the Lookup method.
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Adding a Pick Up to the Transp. Tab Who is Already in RenWeb

1. From the Transp. Tab, double-click on a blank row.
The Order # will appear in the Edit Pick Up section (lower).

2. Click the Lookup button.
The Select Person dialog box opens.

Select Person (23]
- Filter
Person Type
Abbasi, Susan M. -~ I—'ﬁ
Abbe, Virginia o [ Student =
Abbott, Angela - By
Abbott, Cynthia Status =
Abel, Teresa
Abelson, Wanda
Abraham, Barbara I~ Next'Year
Abraham, Virginia ™ District'wide

Abrahamson, Ruth

Adams, Cynthia Enrolled
Adams, Helen Graduate

Addison, Teresa Pre-Enrolled
Addison, Virginia ‘Withdravwn

Aijun, Nancy Inactive

Airy, Robert ALL

Akotia, Elizabeth

Alame, Mary

i::‘r‘gihNg’l‘fijs <&dvanced Filter>
Alassi, Frances

Alassi, Karen

Alassi, Wanda

Aldridge, Frances
Alexander, Teresa
Ali, Barbara >

Cancel

3. Select a Filter by which to sort the Person list.

4. Click on the contact's name to add to the Transp. tab and click OK.
The contact's information populates the Edit Pick Up section; the person’s ID
number displays in the Reference ID field.

5. Click Save (lower left).

@Note: If the person’s information is changed on the Family, Student, or Staff screen, it
will automatically update in the Transp. tab.

The X button will remove the connection between an emergency contact and his or her
RenWeb ID number. This allows you to update the contact's information in the Transp.
tab and it is no longer updated when changed elsewhere in the program.
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Create a Carpool/Bus Route

1. From the Transp. tab, click the Carpool/Bus tab.

2. Inthe Edit Transportation Record section (lower), click the + (plus) button next to

the Bus/Carpool field.

The Edit Transportation window opens.

Edit Transportation

Skyline Ranch

Bus/ Carpool Name

]Keene Bus Stop

I District Wide

|D|'3—

Driver 1 ]Danny Roberts

Phone 1 [817-939-9339

Driver 2 ]

Phone 2 |

Driver 3 ]

Phone 3 ]

Note

Save

Delete

Route Roster

| Exit

Help

3. Select the District Wide option if this route will need to be accessible from other

schools within your district.

4. Type the Bus/Carpool Name.

5. Enter the Driver 1 name and Phone 1.
Add Driver 2 and Driver 3 information as needed.

6. Type a Note if needed.

7. Click Save.

The Name of the route will now show up in the list box on the left, and the drop-down

menu on the Transp. tab.
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Assigning a Route to a Student

1. From the Transp. tab, click the Carpool/Bus tab.
The Bus Route/Carpool Route assignment grid displays.

"General | Schedule | EC. | Finance | Advising | Academics | Misc | Religion | P/T Corference | Behavior | Transcript | Community Service | Picture  Transp
_<| _> | Chase Abemathy

"Pick Up Camool/ Bus |

Route [Type |Days | Street | CityStateZip [Note

r~ Edit Tr ion Record

Bus/Carpool ~] +] € BothAMandPM [ Sunday Subdivision
S l— =l " AMonly I” Monday
" PMonly I” Tuesday
Gty State Zp I” Wednesday
I~ Thursday
™ Friday
I~ Saturday
Save Delete I Route ID 0 Help

[ ok | Cocd || fppb |

2. Inthe Edit Transportation Record area, select the Bus/Carpool from the drop-
down menu.

3. Type the Street, City, State, and Zip of where the student is to be picked up.

4. Select the pickup time from the available options: Both AM and PM, AM Only, PM
Only.

5. Type the Subdivision name in which the student lives, if applicable.

6. Select the route days: Sunday, Monday, Tuesday, Wednesday, Thursday, Friday
or Saturday.

7. Type a Note.

8. Click Save. The record is added to the Bus Route/Carpool Route assignment grid.
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Staff Information

The Staff screen allows the school to store many types of data about the school’s staff:
demographic information, schedule, educational background, substitutes who have covered
classes for the teacher, security rights and groups that the teacher belongs to for
collaborative sharing of lesson plans and assignments.

Edit Staff
General ]Schedule] Education | Substitutes | Securty | Groups | Picture | EC |
Staff ID |508
IArmstrong,Angee Salutation |Mrs. v] I Super User RhEas | l < ; I
<Not Assigned> - ﬁ 5 il mmittees ervice Hours
e Do *  LastName |Amstrong Street |21e Mistletoe Powe | Notes | Prfemnces |
Allen, Pam
Amstong, Mavis 23 e IAngee City IBudeson
.
Bames, May iddle Name | State Zp [TX [76000
Bamett, Valerie R
Bosworth, Jamal Home Phone I817"447'9632 County IUSA
Boyd, Ray .
Burke. David Michael | CelPhone [g17487-1794 I™ Staff Directory Block ‘
Burke, Dawn 2 ‘ Clear | Link
Burrell, Donald Work Phone I - ~— —=
Dani, Faiz Gender ||
Davis, Noma Email #1 Iaarmstrong@renweb.com
Doe, J;ckie Ethnicity
Bg:osrt,h?.lgs.erljsa Email #2 lrtumer@nenweb.com Birth Date |01/01/1950
Duck, Daisey T —
Duck. Gillan D | Depatment |Administration =l SSN|_-~

Duguay. Faculty Tile [Vice Principal | +| Denomination |

Duguay, Kenny Staff

Erickson, Laranne Room {Homeroom v ﬂ Church I LI ;]

Jones, Wendell

Jose, Roger N Refresh bt I Oeiels

Evans, Keith - Fitter - Favorite Reports
rIzat:ug. \,J‘uaa; [~ District Wide Start Date End Date l L.l
aculty, :
Emnldintra?;ym; [ ikactive M Active l I Financial Responsibility
aney, il IRy rsne .Y - ! - 3
::tdlog.ﬁhaw [~ Staff [ V' Preschool ‘ Penstiany. Kelty sl Joi ﬂJ :‘l
estad, Jean
Henderson, Bl I™ Facuty o (i B V' Elementary Medical I Parents Web I
e b I Substitute M Facdy  CPatTme 5 e school
:-Iu?e)'. 'Stjacée " ™ Preschool : [~ Substitute FTE |0 ¥ High School User Defined l Grid Edit |
Inglewood, L
James, Tanya [~ Bementary Hi R
Jazz, John R Sample Elementary School b o |
Jefferson, Thomas I” Middle School Sample Upper School
Johnson, Phillip New ‘ Add I
Jones, Deborsh R L |_ ngh Sphpql |
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Adding a Staff to the School

1. From the Main Menu click Staff.
The Edit Staff screen opens.

2. Click New.

3. Type in the demographic information about the staff member.

4. Input additional information to store in the database about the individual:
a. Select Active if a Staff member is currently active.
b. Enter the Department and Title of the staff member.
c. Select Role:

i. Staff (Admin): This user will use the administrators (full view) RenWeb
screen.

ii. Faculty: This user teaches a class and will use the Faculty screen.

ii. Full Time: Select this option if the staff member works at the school full
time.

iv. Part Time: Select this option if the staff member only works at the
school part time.

v. School Division: Select the division(s) in which the staff member
works: Preschool, Elementary, Middle School or High School

d. Fin. Responsibility: This allows a staff/faculty member to be linked to a
family, thereby creating only one person record in RenWeb. It is also possible
to set up staff with no children in accounting for lunch ordering and charges.

5. Click OK to save and exit to the Main Menu or click Apply to save and stay in the
Staff screen.

93



1. From the Main Menu, click Staff.

The Edit Staff screen opens.

Click Add.
The Select Person window
opens.

Use the Filter to sort the person
list to find the individual who has
already been entered into
RenWeb.

Click on the person's name and
click OK.

The demographic information will
automatically populate the staff
screen.

Input all the information to store
in the database about the
individual:

a. Select Active if a Staff

member is currently active.

b. Enter the Department and Title of the staff member.

c. Select Role:

Adding a Staff to the School who is Already a Parent or Family Member

Select Person

-Filter

Person Type

Abbasi, Susan M.
Abbe, Virginia
Abbott, Angela
Abbaott, Cynthia
Abel, Teresa
Abelson, Wanda
Abraham, Barbara
Abraham, Virginia
Abrahamson, Ruth
Adams, Cynthia
Adams, Helen
Addison, Teresa
Addison, Virginia
Ajjun, Nancy

Airy, Robert
Akotia, Elizabeth
Alame, Mary
Alame, Nancy
Alarcon, Gladys
Alassi, Frances
Alassi, Karen
Alassi, Wanda
Aldridge, Frances
Alexander, Teresa
Ali, Barbara

B IStudent
L4 | By

IStatus L’

™ NestYear
™ Districtwide

Kl

Enrolled
Graduate
Pre-Enrolled
Withdrawn
Inactive
ALL

<Advanced Filter>

Cancel I

i. Staff (Admin): This user will use the administrators (full view) RenWeb

screen.

ii. Faculty: This user teaches a class and will use the Faculty screen.

ii. Full Time: Select this option if the staff member works at the school full

time.

iv. Part Time: Select this option if the staff member only works at the

school part time.

v. School Division: Select the division(s) in which the staff member
works: Preschool, Elementary, Middle School or High School
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d. Fin. Responsibility — This allows a staff/faculty member to be linked to a
family, thereby creating only one person record in RenWeb. It is also possible
to set up staff with no children in accounting for lunch ordering and charges.

6. Click OK to save and exit to the Main Menu or click Apply to save and stay in the
Staff screen.

@Note: If the staff member that you add is also a parent, the information from the tab group

on the Family screen is also connected. If you add, edit or delete the Preferences, Mail
Label, Committees and Services Hours on the Staff screen they will be updated on the

Family screen and vice versa. The Picture and Notes tab contain information unique to
the Staff screen.

Deleting Staff from the List

1. Select the staff member by clicking his/her name in the list. The data will appear on
the right.

2. Click Delete.
The Delete Confirmation window opens.

3. Click Yes to continue with the deletion.
The Staff member is deleted.

®Warning: Do not delete a Staff member who has courses and grades associated with him

or her in the Grade book or Report Cards. In such a case, inactivating the faculty member
is the suggested procedure.

To do so, select the Active box in the General screen to inactivate. It is recommended to
remove passwords and group rights through the Security tab.
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Adding Medical Information

Your school may use the Staff Medical area to track if a staff member is injured on campus
or to track more detailed medical information: Doctor, insurance, hospital preference,
allergies, etc.

1.

From the Main Menu, click Staff.
The Staff screen displays.

Select the Staff member for whom to add medical information.

Click the Medical button.
The Medical screen displays.

Add the desired information.

Click Save.

Adding Human Resource Information

Human Resources area allows you to document staff absences and tardies, behavior,
observations, salary, and evaluations.

1.

From the Main Menu click Staff.
The Edit Staff screen opens.

Select the Staff member for whom to add Human Resource information.

Click the Human Resources button.
The Human Resources screen displays with the Attendance tab selected.

Add the desired information.

Click OK to save and return to the staff screen or click Apply to save and stay in the
Human Resources screen.

®Note: Specific details on adding, editing and deleting information in each area of the
Human Resource section is found in Online Help.
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Staff Screen: Schedule Tab

Viewing a Staff Member’s Class Schedule
1. Select the staff member by clicking his or her name in the list.

2. Click the Schedule tab.
If an instructor has been assigned to classes, the schedule will be populated with the
classes.

'General Schedule |Educah‘on| Substm.tal Securityl Groupsl Pldurel EC |

Template |US ~|

Mon Tues. Wed Thur Fii
Peiodq  PRECALC3 | PRECALC3 PRECALC-3 | PRECALC-3 PRECALC-3

usa37 |Us037 |US037 |us037 |Us037
Period2 | | | |
Peiod3  PRECALCH | PRECALC-4 PRECALC-4 | PRECALC-4 PRECALC-4

Us037 Us037 |Us037 Us037 |us037
Peiod4 | | | |
Peiod5  ALG2H2 |ALG2H-2 ALGZH-2 |ALG2H-2 ALGZH-2

Us037 |Us037 |US037 |Us037 |Us037
Peiods  PRECALCS | PRECALC6 PRECALCE | PRECALCE PRECALCS

Us037 us037 |Us037 us037 Us037.
Peiiod7  PRECALCHONS  PRECALCHONS  PRECALCHONS | PRECALCHONS

us037 Us037 |us037 Us037 5037
Period 8

oK Cancel Apply
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Staff Screen: Education Tab

Maintaining a Staff Member’s Educational Information
1. Select the staff member by clicking his or her name in the list.

2. Click the Education tab.

it Stoff =
"General | Schedule Education | Substiutes | Securty | Groups | Picture | EC |

Degree Information

Type School | Name | Year

Bachelors Southwestern Assemblies ¢ Early Childhood Education
Bachelars University of Texas Ma,

Years Experience at School IE]_ Job Category
Total Years Experience [23_ IEducation ZI ﬂ

Continuing Education/Training

Date | Description |Hows [CEU

10/12/2003| CRISS Reading Strategies | 30,00 3.00
02/23/2010] True Colors 10.00 1.00

Staff Certification
Eamned | Expires | Certification [Note

08/01/1988 0870172011 English 6-12 Cetification wil be automatically be rer

[TI Cancel Apply

3. Enter any Degree Information you want to track for the teacher.
a. Double-click a blank line.
b. Select a Degree Type.
c. Type the name of the School from which a degree was earned.
d. Type the Degree name.
e. Type the Year in which the degree was earned.
f. Click Save.

4. Type the total Years Experience at School.

98



Type the Total Years Experience of teaching.

Type the teacher’'s Job Category from the defined list drop-down list.

Click Apply to save the changes you have made to the Education tab or click
Cancel to exit without saving.

Enter any CEU’s (Continuing Education Units) or Trainings a teacher has
completed.

a.

b.

Double-click the blank line.

Type the Date of the CEU or training.
Type a Description.

Type the total number of Hours attended.
Type the total number of CEU'’s earned.

Click Save to add the CEU or Training to the list or click Cancel to exit
without saving.

Staff Continuing Education Edit

|1U/1 2/2003 l

Description
|CRISS Reading Strategies

Hoursl3l]
CEUI3

Save | Delete Cancel Help
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9. Enter any Staff Certifications an employee may have.

a.

b.

Type the Earned and Expires date

Type the name of the Certification.

Type a Note if desired.

Type the Certification type.

Type the certification level.

Click Save to add the Staff Certification to the list or click Cancel to exit

without saving.

Edit Certification

Earned

Expires

| 8/ 171988 L]

Certification

| 8/ 1/2011 LI

=

IEninsh 612
Note

|Celtification will be automatically be renewed based on inservice participation

Certification Type

| TEA Certification |+

Certification Level

IProfessionaI _v_l +]
Save Delete Cancel I

Help
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Staff Screen: Substitutes Tab

The substitute tab allows you to track the classes for which you will need to assign a
substitute in the event that a teacher is absent. Any substitute assigned to a class in the
Substitutes tab will be able to take attendance in that class for the date on which he or she

is assigned to the class.

Assigning a Substitute to a Teacher's Class

1. Select the name of the teacher for which a substitute is needed.

2. Click the Substitutes tab.

Edit Staff
General | Schedue | Education  Substiutes | Securty | Groups | Picture | EC |

History
Date for Substitution [Date

[Class [ Substitute [Reason

[4r1272010 ~
Highlight Classes To be Subbed

04/12/2010 ENG |1 Burke, Dawn
04/12/2010 ENG 1-2 Burke, Dawn
04/12/2010 ENG -4 Burke, Dawn
04/12/2010 ENG | HA urke, Dawn
04/12/2010 ENG II-4

04/12/2010 ENG Il H-a

04/12/2010 NWSP-1

04/12/2010 YBK-A Burke, Dawn

School Related
School Related
School Related
School Related
School Related
School Related
School Related
School Related

Reason for Absence _I
= ||
Substitute

Save
Help

o]

Cancel

3. Highlight the class for which the teacher needs a substitute.

4, Select a Reason for Absence.

5. Select the Substitute who will be covering the class.

6. Click Save. The History grid is populated with Date, Class, Substitute and Reason.

@Note: The Reason for Absence list is a Defined List. You may add to the defined list
values available in the drop-down by clicking the + button or by going to Defined Lists
area of RenWeb Setup. The Defined List for which you need to define values is Staff

Absent Reason.
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Staff Screen: Groups Tab

Groups allow the user to assign staff members the permission to view or modify the grade
book and lesson plans for classes in which they are not the assigned teacher. Additionally,
by placing a staff member in a group, the user creates an email group to facilitate the
creation and sending of information pertinent to the group.

Adding a Staff Group
1. From the Staff screen, click the Groups tab.

2. Inthe Name field, type a name by which to identify the group.

3. Click Save.
The name is added to the Faculty Group list.

Edit Staff ==
Genemll Schedule] Education | Substitutes | Security Groups ]Picture| =e |
Faculty Group Name
et [ Classes | st |
L English Save | {
High School —
ALG1-1 -
New Group I Delete Group ‘ ALG1-10 S
g ALG |-2
Class List ALGI-3 ||
ALG |-4 |
ALGI-5 \
< ALG -6
ALG -7
» ALG -8
ALG -9
ALGIIH-A
AMH -1
AMHI-10
AMH | -2
1 AMH -3
elfist AMH 1 -4
AMH | -5
AMH -6
<View | |AMH -7
AMH -8
<Modty | |AMH -9
ANAT | -A
=z AP LANG - A -
ACT A

Help

[TI Cancel
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Adding Classes to a Staff Group

1.

2.

In the Faculty Group list click on the name of the group to which to add classes.

Click the Classes tab and add the classes for which teachers in the group will have
either modify or view rights. Click on a class and use the > (arrow) buttons to add
the class to the Class List.

Click Apply to save the changes you have made to the Groups tab or click Cancel
to exit without saving.

Edit Staff

'General | Schedule | Education | Substitutes | Securty Groups IPicture] E |

Faculty Group

High School

Math £ |

New Group I Delete Group | th : 1
Class List ALG | -

ALG |-
ALG -9 ALG |-

ALG Il H-A ALG |-
<| |aGi-

% ALG |-

> ALG |-

ALGI-

ALG II
AMH | -
AMH | -
AMH | -
Staff List AMH

AMH | -
Bamett, Valerie R (Modify) AMH |

Burrell, Donald (View) MH |
Doerstling, Lesa (View) <View /’?\M: 1-
Evans, Keith (View) AMH | -
<-Modify |{AMH |-
ANAT |- A
AP LANG - A

ACT A

>

Iwm\:mw&wws
T —
[ m |

° »

000~ O LN B N = —

Help

oK I Cancel

103




Adding Members to a Staff Group

1.

In the Faculty Group list click on the name of the group to which to add staff

members.

Click the Staff tab and add the staff members who will have view rights by clicking

on the staff name and clicking the View button.

To add staff members who will have modify rights click on the staff name and click

the Modify button.

Click Apply to save the changes you have made to the Groups tab or click Cancel

to exit without saving.

Edit Staff

"General | Schedule | Education | Substiutes | Securty Groups | Picture | EC

Faculty Group

High School

Name
Math Save
New Group | Delete Group |
Class List
ALG Il H-A
Staff List

Bamett, Valerie R (Modify)
Burrell, Donald (View)
Doerstling, Lesa (View)
Evans, Keith (View)

Burrell, Donald
Dani, Faiz
Davis, Norma
Doe, Jackie
Doerstling, Lesa
Donor, User
Duck, Daisey

| | Duck, Gillian D

Duguay, Faculty
Duguay. Kenny Staff
Erickson, Laranne
Evans, Keith

| i N T

OK

Cancel
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Staff Screen: Picture Tab

The Picture tab enables the school to upload staff pictures to be displayed on the Staff
screen and on ParentsWeb 2.0. School photographers often provide the pictures in the
recommended format—saved by staff id, 172 X 228 pixels and as a JPEG or GIF.

Edit Staff @
iGenerall Schedule | Education Subst'rtu‘lesl Security] Groups  Picture IEC l
Single Picture
- File Name
[123ipg
Save
Upload File
|
Upload Browse

1~ Muttiple Pictures -

m

Directory Where Pictures are Stored

Browse
Mask

l_—_ Upload

oK I Cancel
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Upload a Picture for One Staff Member at a Time:

The benefit of loading pictures this way is that the name of the file is not that important
because it may be named in any manner desired in order to identify it.

1.

2.

On the Staff screen, select the teacher for whom to upload the picture.
Click the Picture tab.

In the Single Picture area, click Browse to locate where on your computer the
picture is saved.
The Open file window opens.

Navigate to the picture location and click on the picture.
Click Open.

Click Upload.
The file uploads and displays the word Finished below the Upload button when it
has uploaded.

Upload the Entire Folder of Staff Pictures at One Time:

It is important that the photographer has the staff ID numbers in order to identify the staff
picture by the id. Using the Multiple Pictures section you may import multiple pictures at

once.

1.

Save the pictures to the C drive (specific instructions for exporting from Life Touch
CD to your computer are found under help demonstrations>Importing Student
Photos).

In the Multiple Pictures section, click the Browse button to locate where on your
computer the pictures are saved.
The Open file window opens.

Open the folder and click on one of the photos.

Type the Mask (or file extension) for most it will be JPG (please note that this area is
case sensitive).

Click Upload and it will upload one picture at a time.

106



Staff Screen: EC Tab

The EC (Emergency Contact) tab allows for you to maintain contact information for the
individuals to contact if a Staff Member has an emergency situation.

Manually Adding a Contact to the EC Tab

1. From the Staff screen, select the staff member for whom to add EC information.

2. Click the EC tab.

Edit Staff ==
General | Schedule I Education | Substitutes | Seourity] Groups | Picture EC |
Order | First Name ]Last Name |Helationship |Home Phone |Eel| Phone |Work Phane |Email INote AI
1 |
2
3
4
9|
8|
7
8
3
10|
11
12|
13] ﬂ
<[ 2
- Edit Emergency Contact
Order |1
First Name Home Phone
Last Name Cell Phone
Relationship < LI Work Phone l
Reference ID [0 | Email |
Save | Delete | Lookup Move Up | Move Down Help
oK I Cancel

3. Double-click on a blank row.
4. The Order # will appear in the Edit Emergency Contact section (lower).
5. Type the First and Last Name.

6. Select the relationship the emergency contact has to the student from the drop-down
menu.

7. Add the Home, Cell, and Work Phone, and an Email address.

8. Click Save (lower left).
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Adding a Contact who is Already in RenWeb
1. From the Staff screen, select the staff member for whom to add EC information.
2. Click the EC tab.
3. Double-click on a blank row,
4. The Order # will appear in the Edit Emergency Contact section (lower).

5. Click the Lookup button.
The Select Person dialog box opens.

6. Select a Filter by which to sort the Person list.
7. Click on the contact's name to add to the E.C. tab and click OK.

8. The contact's information populates the Edit Emergency Contact section; the
person’s ID number displays in the Reference ID field.

9. Click Save (lower left).

@Note: If the person’s information is changed on the Family, Student, or Staff screen, it
will automatically update in the EC tab.
The X button will remove the connection between an emergency contact and his or her
RenWeb ID number. This allows you to update the contact's information in the EC tab
and it is no longer updated when changed elsewhere in the program.
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My Staff Exercise

Objective: Create a Staff Member

Create a New Staff Member
1. Name: Michelle *Michelson#.

2. Email: mmichelson@staff.com

3. Do not add her to a family yet.

My Student, Parent and Family Exercise
Objectives: Divorce the family
Remarry one of the parents to a staff member

Discuss Financial Set Up

Divorce the Pattersons
1. Unlink their addresses, keeping in mind that the kids live with mom.

2. Dad’s new address: 5678 Pattington Ave. Pattenville, PA 99999

Split the Family into Two Families
1. From the student screen create a new (blank) family for Patrick Patterson.

2. Without adding Pat into the system again, add him into this new family.
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Communication

Staff Chat
Automated Communication
ParentsWeb

Email
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Staff Chat

Staff Chat allows the staff and faculty of your school to communicate with each other using a

messaging style format. You can establish preferences so that Staff Chat launches

immediately upon logging into RenWeb. You also have the ability to create groups by which

to easily identify and message other users.

Creating a Staff Chat User Name

1. From the Main Menu, click Staff Chat.
The RenWeb Staff Chat screen opens.

RenWeb Staff Chat

Iour User iName cannot conta

User Name EmilyK

RenWeb Password eeeeses|

Register

2. Type a User Name.

a. This is the name by which all faculty and staff members at the school will identify

you.
i. Good Example: EmilyK

i. Bad Example: Edogg

b. Your User Name cannot contain any spaces.

3. Type your RenWeb Password.

4. Click Register.
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Understanding the Staff Chat Main Menu

1. From the Main Menu, click Staff Chat.
The RenWeb Staff Chat screen opens.
Since you have already created a User Name, you only have to log into RenWeb in
order to gain access to Staff Chat.

2. Your User Name displays at the top of the Main Menu.

3. Your current Status displays below your User Name.

4. The add user icon allows you to add to your Staff Chat, other users at the school.

5. The
contacts.

manage groups icon allows you to create groups by which to organize

e broadcast message icon allows you to send a message to a group of users.

v Eed
7. The ﬂ preferences icon allows you to configure preferred settings of your staff chat.
Th

S

e help icon takes you to Online Help where you can find information regarding
how to use and configure Staff Chat.
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Starting a Chat

1.

From the Main Screen, double-
click on the name of the contact
with whom you would like to chat.
The Chat window displays.

Type your message in the
message area and press the Enter
key on your computer keyboard.

Your message displays with your
name in green preceding the
message.

The person's name with whom you
are chatting displays at the top of
the chat window.

Once the contact responds, his or
her message will display. The
contact's user name will display in
red.

To end the conversation, click the
(red x) at the upper-right
corner of the chat window.

e )
/€ Chat with ereed - Windows Internet E... El@

"

[10:58:27] rebecca.turner: Hello

[10:58:38] ereed: Hello

[10:59:46] rebecca.turner: Did you send Ginger to
my class with a tardy pass?

[10:59:52] rebecca.turner: | wantto be sure itis
not forged.

[11:00:10] ereed: yes

[11:00:18] ereed: she was doing make up work

P Type your message here &

’@ https://chat.renweb.com:8445/RenwebChat/ch v % ‘

€ Internet | Protected Mode: On #100% «
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Automated Communication

Maintenance Manager enables the user to set up a variety of jobs to send parents behavior
and attendance notifications, send progress reports and notify parents regarding accounting
information.

Accessing Maintenance Manager

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup screen opens.

2. Click the Maintenance button.
The Maintenance Scheduler screen displays and identifies all the current
maintenance jobs that have been defined along with other information regarding
when the job should process. From this grid you can identify which jobs have been
setup and status information for each on.

Type | Description | Date |Last RunDay | Time
Accounting Notification i ~ DISABLED |
Attendance Notification 3 unexused tardy DISABLED
Behavior Notification | 3 demerits DISABLED |
Behavior Notification 6 demerits DISABLED |

Create Day Attendance | Sth Grade Day Attendance DAILY 03/16/2010 16:03:36
Demographics Clean Up  Demographic Cleanup ~ WEEKLY
FACTS/NES Payment Noti Pay Now Payment Notifica DAILY
Grade Book | Grade Book Notifications | DISABLED |
Library Late Fee | create late fees in library  DISABLED |
Library Late Notification | overdue Book notification ' DISABLED
‘webform Notification ‘Web form notification DISABLED

Help | AddJob |
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Attendance Notifications

You may schedule an Attendance Natification to automatically send emails based on a
defined number of absences a student has accrued based on daily attendance, individual
classes or all classes combined. If your school uses Parent Alert, you can configure parents
to be notified via text messages or phone calls for a defined number of absences.

Behavior Notifications

Typically, a student is assigned merit or demerit marks whenever a behavior record is
entered into the system. The notification system will add up all those marks over a specified
time frame and if they are equal to or have exceed the threshold, a notification is set.

Grade Book Notifications

Your school may set up a notification job to automatically send an email to the parents
based on a variety of grade parameters. The combined Grade Book job controls the
sending of two different types of grade book information:

~ The grade book progress report
~ A variety of grade book assignment notifications

If both types of jobs are configured the parent, student or school representative will receive
multiple types of grade book notifications.
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ParentsWeb

ParentsWeb allows schools to create a customized, informative and interactive site.

ParentsWeb consists of the following functions:

~ Configuration ~ Newsletter

~ Announcements ~ Course Requests

~ Calendar ~ Web Forms

~ Pictures ~ Reenrollment

' Web Configuration
Configuration ]Announcemems | Calendar | Pictures | Newsletter | Course Requests | Web Foms | Reenrolment |
Legacy ParentsWeb ParentsWeb 2.0 | Enable Al Famiies in School | [ Erable All Families in Distnct 3|
School ParentsWeb Access Disable All Families in School | Disable All Families in District I
1 | Accoining  School ParentsWeb Default Year and Tem
Y  Announcements ParentsWeb Year Schedule
Y | Attendance 20092010 7 2005-2010 v
Y | Behavi
Enavier Gradebook Defaut Tem  Report Card Defautt Temn |1 S
| el [T EliQ <] [StudentScheduleGrid.cfm ~]
Y  Class Websites
Y Community Service —~ Default ParentsWeb Login - — Banner
Y | Course Requests " Legacy ParentsWeb Primary Color
Y | Directory - Family & ParentsWeb 2.0 INavyBIue vI
Y | Directory - School Information — ParentsWeb Preview — Sec?ndaw Color
Y | Directory - Staff White v
Y | Directory - Staff (District-wide) Staff Login | Text Color
Y | Emergency Contacts/Pick-Ups _l IB&ack v I
Y  Gradebook Grades M
E ascot
Y | Homework Parent Login | IRams
Y  Lesson Plans
Y | Library
Y Lunch Menu Help
Y | 1imeh Nrdarinn =
0K Cancel Apply
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Configuration

RenWeb offers complete customization of ParentsWeb. The Configuration options allow the
user to determine exactly what will be viewed on your parent site and who will view it.

Configuration Fields:

~ Enable All Families in School - clicking this button enables family access to
ParentsWeb for all families in the school.

~ Disable All Families in School - clicking this button disables family access to
ParentsWeb for all families in the school.

~ Enable All Families in District — clicking this button enables family access to
ParentsWeb for all families in the district.

~ Disable All Families in District — clicking this button disables family access to
ParentsWeb for all families in the district.

@Warning: Enabling or disabling all families in the district will alter the status of ALL
FAMILIES IN THE DISTRICT. Be very careful when exercising this option in order to
protect student privacy and follow district policy.

~ Grade book Default Term — select the default term for which to display the grade
book.

~ Report Card Default Term — select the default term for report card display.
~ Schedule — allows schools to set the Schedule Year and Term for parent’s view.

~ ParentsWeb Preview — clicking this button opens the ParentsWeb site in a browser
for preview if Public Login is marked Y in the Web Access List.
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Configuring ParentsWeb Content

1.

From the ParentsWeb, Configuration tab, select whether to offer parents
ParentsWeb 2.0, the graphic-rich Broadband version of ParentsWeb, or whether to
offer parents Legacy ParentsWeb, a more simplified version of ParentsWeb, which
is compatible with parents who have a dial-up internet connection.

a. If schools choose to make both available to parents, the school will need to
select which items to display in each of the School ParentsWeb Access
lists.

b. The school may choose to select ParentsWeb 2.0 as the default but still
have Legacy ParentsWeb for parents on dial-up service.

In the School ParentsWeb Access list, select the content to make available on
Parents Web by clicking on the items listed.
A ‘Y’ (Yes) indicates content that will be made available on the ParentsWeb site.

Select the default ParentsWeb Year from the drop-down list.

Select the Grade book Default Term that will be displayed for staff and parents from
the drop-down list.

Select the Report Card Default Term that will be displayed in ParentsWeb from the
drop-down list.

Preview the final appearance and content of the ParentsWeb site by clicking the
Staff Login button.

To preview what a parent sees, select a parent name from the drop-down list and
press the Parent Login button.

Click Apply to save the configuration.
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Email

Communication with parents and students is an integral part of education, and RenWeb
makes the process easier with a variety of email options: Messages, lesson plans and
progress reports. In order to use the Email capabilities of RenWeb, the instructor’s email

address must be saved in the Staff dialog box.

Emailing a Message to Parents or Students

1. From the Main Menu, click Communication.
The Communication Menu displays.

2. Click Create Email Message.

The Email Editor opens with the Setup tab selected.

Email Editor (=3
Setup lCompose!Send]
-Send To
=Filter— Abernathy, Chase A 5
F'Ierz::;n Tone Abemathy, Paullette ‘ —J I Student
B Adams, Christopher —! —ﬁ I Custody
Student 'I g'a%ua"’il ¥ Adams, Edward I~ Corespondence
(EcEnrolcs &dams, Jane
By Withdrawn Adkins, Joseph Robert M o
lStatus vl Inactive Adkins, Scott ;] I Emergency Contact
ALL ; I” Financial Responsibility
Akotia, Karen
™ Mest Year ' Al Dorathy ﬁJ I” Pick Up
™ District Wid <&dvanced Filter> - Alarcon, Frances ™ Staff
ISHCEWICE | Grade: PK = Alassi, Mary [ Carbon Self
Grade: K =] Alexander, Virginia ‘ Soona8
Grade: 01 Ali, Nancy <Not Asgxgned>' -
Grade: 02 Ali, Wanda Accounting, Trainee '
Grade: 03 Alison, Cynthia Barrs, Sara —
Grade: 04 * Allam, Dorothy - rBﬂlnsc:on?r, SAusan =i
From staff@school.com _'_I Recipient Report
To A
Attachment Attachment i]
Exit Help

3. Select the Filter by which to populate the person list and use the > or >> arrow
buttons to add recipients to the email list. It is possible to select multiple filters and

arrow over multiple groups of individuals.
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4. Select options in the Send To list to determine who will receive the emails. Emails
are always sent in a Blind Carbon Copy style. People will receive emails, but will not
see the list of others who are also selected as Send To.

a.

b.

g.
h.

Students: will send to the email address on the student screen.

Custody: will send to the email addresses of any individual marked as
custody in the family screen.

Correspondence: will send to the email addresses of any individual marked
as correspondence in the family screen.

Grandparent: will send to the email addresses of any individual marked as a
grandparent in the family screen.

Emergency Contact: will send to the email addresses of any individual
listed in the Emergency Contact tab.

Pick Up: will send to the email addresses of any individual listed in the Pick
Up tab.

Staff: will send to the email addresses on the staff screen.

Carbon Self: will send a copy of the email to the address in the From field.

5. To see a listing of each email address to which an email has been sent, click the
Recipient Report button.
A list of each person selected and the email address or addresses for each Send To
option selected will display.
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6. Click the Compose/Send tab.
The email editor screen opens.

Email Editor @
Setup Compose/Sendl
Subiject: |
23| 2l BE=E=EBIUS | EEH{Y v FicicOE
k|
I Upload Images l
Send Email Save Template to DB | Get Template from DB ] Image Directory l

Save Template to Disk | Get Template from Disk I

|1 Hep |

7. Type a Subject by which to identify the email message.

8. Type an email message in the large text field area.
Find detailed toolbar instructions in Online Help.

If you have the RenWeb Customization Kit or Parent Alert, you can create and save

email templates.

9. Click Send Email to send the email.
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Emailing a Grade Book Progress Report

1.

The Communication Menu displays.

Click Email Gradebook Progress Report.

From the Main Menu, click Communication.

The Email Gradebook Progress Report (All Classes) screen displays.

Email Gradebook Progress Report (All Classes)

~ Filter- —||*Cain. Kevin Lee {*Cain, Kevin Lee}
" Status : “ || Abell, Adam Abell, Adam
ﬁtg : ; 12 ||| sbell, sngel ;] {Abell, Angel }
o H ALG|-A Adams, Edward Henry Adams, Edward Henry
omercor ALG1-B Ainge, Braiden Ray i‘ Ainge, Braiden Ray
@ Class ANATI-A ~ Anderson, &nna Anderson, Anhna
O Activity e | Anderson, Jake Anderson, Jake
Armstong, EvanJ {Armstong, Evan J}
Ashton, Rick Paul < | |Ashton, Rick Paul
Banks, Cody Ray Banks, Cody Ray
Barkley, Aaron Dennis i] Barkley, Aaron Dennis
Bamett, Heather Bamett, Heather
Bosworth, Pam {Bosworth, Pam }
Bowman, Samuel {Bowman, Samuel }
Note:  <No Parent Email Address> {No Student Email Address}
Status
Exit Send

~Email To

vV Student
vV Parent
[~ Family

Carbon Copy
[~ Self

[ Student's Advisor
Other Staff

-Term
11

T2
T3

T4

~ GBK Style

* Details
" Summary

7 Include Student Comments

Help

Select the Filter by which to control the student list population.

Highlight the students to receive the message in the left name list box and click the

single arrow pointing to the right-hand list box >. To add all students, click the double
arrows pointing to the right list box >>.

Select to whom to send the grade book progress report:

a. Student
b. Parent
c. Family
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@Note: Teachers should have added comments through the grade book. If a teacher

needs to add or edit student comments they will need to do so through the Grade Book.

6. Select the Carbon Copy options of Self, Student's Advisor or the name of any
Other Staff who should receive a copy.

7. From the Term options, select the term to include on the Progress Report.
8. From GBK style options, select the style of the Progress Report:

a. Details shows all details for each class grade on the progress report.

b. Summary shows the class average grade for each class in which the student

is enrolled.

9. Toinclude private comments with the Progress Report for selected students, sele
the Include Student Comments option.

10. If desired, type a Note to be included with the Progress Report for all students.

11. Click Send to email the Progress Reports.

ct
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Reporting

Report Manager
Year and Term Report
Mail Label
Birthday Report
Directory
Transcript
Email Log Reports
Activity Log
Course Listing
Class List
Class Roster

Create-a-Report
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Report Manager

RenWeb offers a variety of reporting tools to facilitate the needs of a school. The Report
Manager houses numerous canned reports—reports that already have a format,
predetermined fields and established parameters.

Basic Report Manager Use

1.

2.

3.

Select a Category.

Choose a report; specify date, grade level, student or staff parameters.
Click Print.

In the filter screen define additional parameters for the report.

Click Print.

The report will open in an internet explorer browser and may then be printed by
going to file and selecting print or by clicking the printer icon.

Adding Reports to My Favorites

My Favorites displays selected and frequently used reports in an easy to use list in Report
Manager, Staff screen and Student screen. If you add a report to the My Favorites section
in Report Manager from the Student or Staff Categories it will display in the Student or Staff
screen, respectively.

1.

From the Main Menu, click Report Manager.
The Report Manager screen displays.

Click on the Category from which to add a report to My Favorites.
The Reports in the category are listed in the Report Title area.

Click on the Report Title to add to My Favorites.

Click the Add Favorite button.
The report is added to the My Favorites area.
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Year and Term Report

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Administration.
The Report Title list populates with reports administration regularly runs.

3. Click the Report Title of Year and Term Report.

4. Click Print.
The Year and Term Report displays in an Internet Explorer window, providing an at
a glance view of day setup, term dates, days on which attendance was taken, etc.
Select the Internet Explorer File>Print menu option to print.
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Printing a Mail Label

1. From the Main Menu, click Report Manager.

The Report Manager screen opens.

2. Click the Category of Administration.
The Report Title list populates with reports administration regularly runs.

3. Click the Report Title of Mail Labels.

4. Click Print.

The Mail Label screen opens.

Mail Labels

1~ One mail label per... -

% Student ¢ Family ¢ Staff

Student List
Abernathy, Chase A
Abernathy, Paullette B
Adams, Christopher e
Adams, Edward
Adams, Jane > |
Adkins, Joseph Robert
Adkins, Scott
Akotia, Karen o I
Al, Dorothy
Alarcon, Frances
Alassi, Mary
Alexander, Yirginia < |
Ali, Nancy
Ali, Wanda
Alison, Cynthia <« I
Allam, Dorothy
Alles, Frances
Alles, Teresa I3
i~ Filter 5
Peson Tye [T
]Student v I Graduate
Pre-Enrolled
By Withdrawn
lStatus - ] Inactive
ALL
[” District Wide
[ NestYear
<Advanced Filter> -
Grade: PK .
Grade: K ‘E
Grade: 01 —
Grade: 02
Grade: 03
Grade: 04
Grade: 05 i

Help

Mail Labels

[ Bulk Mail [Sort by Zip Code)

7 Use Nicknames

Line 1 |John Doe

4

Line 2 |Street

v

Line 3 |City State ZIP

v

Line 4

Avery Label|&VERYS160.RPT

2l

Skip Labels IU

Print Mailing Labels

Exit

5. Choose to print one mail label per Student, Family or Staff.
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6. Select the Filter option that will list the student(s) for whom to print mail labels.
7. Use the > or >> (arrow) buttons to move students to the Mail Labels field.

8. Use Line 1, Line 2, Line 3, and Line 4 drop-down menus to configure the mail label
content.

9. Select the Avery Label format in which to print the mail labels.

10. Click Print Mailing Labels.
The report opens in the Crystal Report Viewer.

11. Click the printer icon to print the mail labels.

Printing a Birthday Report

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Grade Book.
The Report Title list populates with reports related to the grade book.

3. Click the Report Title of Birthday Report.

4. Click Print.
The Student Selection screen opens.

5. Select the Filter option that will list the student(s) for whom to print mail labels.
6. Use the > or >> (arrow) buttons to move students to the Print List field.

7. Click Print.
The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Printing a Directory

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Directory.
The Report Title list populates with directory reports.

3. Click the Report Title of Family Directory.

4. Click Print.
The report opens in the Crystal Report Viewer.

5. Click the printer icon to print the family directory.
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Printing a Transcript

1.

From the Main Menu, click Report Manager.
The Report Manager screen opens.

Click the Category of Academics.
The Report Title list populates with reports relating to academics.

Click the Report Title of Transcripts.

Click Print.
The Transcript screen opens.

Transcripts
Student List

Abell, Adam

Abell, Angel

Adams, Edward Henry
Ainge, Braiden Ray
Anderson, &nna
Anderson, Jake
Anderson, Joeseph
Armstong, EvanJ
Ashton, Rick Paul

fom | »

Bakies, Aaron Joseph

Banks, Cody Ray

Bargas, Braden

Barkley, Aaron Dennis

Bosworth, Pam

Bowman, Samuel

Boyd, Zachary -

—Filter-
& Status )
" Grade Level |Withdiawn

" Homeroom E'{Z'gl:'a'?elled
" Class

" District Wide

i~ Transcript Notes

>

<

>

BB

<

B

Transcripts

Template Grade Levels ta Include
IHSTranscriptcfm Ll gg

V' Show GPA 09

V' Show Rank 10

V' Show Attendance 112

V' Show Community Service

V' Show Standardized Tests

Print

Save Notes

Transcript notes must
be saved before they
appear on transcript.

[” <Details>

Archive

Exit

Help

130



10.

Select the Filter option that will list the student(s) for whom to print transcript(s).
Use the > or >> (arrow) buttons to move students to the Transcripts field.

Select the template from the Template drop-down list box. RenWeb provides
standard templates free of charge that may be used. RenWeb may also create a
custom template for schools for an additional charge.

Select the Grade Levels to include.
If desired type a Transcript Note to include on the printed transcript.

Click Print.
The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Printing Email Message Reports

Email message reports show the administrator emails that have been sent by staff at the
school or have been automatically sent by the 'system’, the email address to which the email
was sent, the date and time of the email and whether or not parents signified that they
received the email.

Email - Staff Messages

1.

From the Main Menu, click Report Manager.
The Report Manager screen opens.

Click the Category of Administration.
The Report Title list populates with reports administration regularly runs.

Click the Report Title of Email - Staff Messages.

Click Print.
The Staff Selection screen displays.

Use the Filter to populate the Staff List.

Select a Date 1 and a Date 2, indicating the date range for which to see emails that
have been sent by staff.

Use the > or >> (arrow) buttons to move staff members to the Print List.

Click Print.
The Staff Email Report displays in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.

Email - System Messages

1.

From the Main Menu, click Report Manager.
The Report Manager screen opens.

Click the Category of Administration.
The Report Title list populates with reports administration regularly runs.

Click the Report Title of Email - System Messages.

Select a Date 1 and a Date 2, indicating the date range for which to see emails that
have been sent by the system.

Click Print.
The System Email Report displays in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.

132



Printing Activity Logs

Activity logs show the administrator changes that have been made, the time and date of the

change, and the user’s name that made the change.

Grades Activity Log

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Administration.

The Report Title list populates with reports administration regularly runs.

3. Click the Report Title of Activity Logs.

4. Click Print.
The Activity Log configuration screen displays.

Activity Log @
Grades Accounting Demographics
{*
5 g’adeb‘”k © Fanily € Esisting
EpaiCard " Student " Deleted
" Transcript
Class Person
Student Field
l = | =
From| 3/15/2010 ~ From| 3/15/2010 ~ From| 3/15/2010 ~
To| 341572010 « To| 3/15/2010 To| 3/15/2010 ~
Print | Print | Print |
[ Edi |

5. Inthe Grades section, select the Grade book, Report Card, or Transcript option.

6. Select a Class.

7. Select a Student in the class to see changes made to a specific student or leave the
student field blank to see changes made to all students in the class.

8. Select a date range.

9. Click Print.

The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Accounting Log

This log enables the user to view all changes made to the family register, dealing with
payments and charges.

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Administration.
The Report Title list populates with reports administration regularly runs.

3. Click the Report Title of Activity Logs.

4. Click Print.
The Activity Log configuration screen displays.

5. Inthe Accounting section of the screen, select the Family or Student option.
6. Select a family or student name from the drop-down menu.
7. Select a date range.

8. Click Print.
The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Demographics Log

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Administration.
The Report Title list populates with reports administration regularly runs.

3. Click the Report Title of Activity Logs.

4. Click Print.
The Activity Log configuration screen displays.

5. Select Existing or Deleted under the Demographics portion of the screen.
6. Select a Person.

7. All fields which have been edited or deleted will then show up in the drop-down list
under Field.
To view a specific field, select it from the Field drop-down list.
To view all fields changed leave the Field area blank.

8. Select a date range.

9. Click Print.
The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Course Listing

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Course.
The Report Title list populates with reports related to courses.

3. Click the Report Title of Course Listing.

4. Click Print.
The Course Selection screen displays.
Course Selection (=2
Course List Print List

*CERT - RW Certification - *CERT - RW Certification -

ALG | - Algebra | K| ALG | - Algebra | F

ALG | H - Algebra | Honors = ‘ ALG | H - Algebra | Honors

ALG Il - Algebra I ALG Il - Algebra I =

ALG Il H - Algebra Il Honors
AMH | - American History |
AMH Il - American History |l 5 AMH Il - American History |1

ANAT | - Anatomy 7 ANAT | - Anatomy

AP LANG - Advanced Placement L. AP LANG - Advanced Placement L.
AP LIT - Advanced Placement Liter AP LIT - Advanced Placement Liter
AST - Astronomy AST - Astronomy

ALG Il H - Algebra Il Honors
AMH | - American History |

I

AUTO - Automotive < AUTO - Automotive
BAND | - Band | BAND | - Band |
BAND Il - Band I BAND Il - Band Il
BAND Il - Band IIl & BAND Il - Band IIl
BAND IV - Band IV BAND IV - Band IV
BASE | - Junior Varsity Baseball BASE | - Junior Varsity Baseball
BASE Il - Varsity Baseball - BASE Il - Varsity Baseball
—— BIBLE | - Bible |
- Filter BIBLE Il - Bible Il
A Activit BIBLE IIl - Bible Il
S Acive EIBLE IV - Eibile IV
¢ Inactive  Pre-School BIO | - Biology |
Elementary BIO Il - Biology Il
Middle School CALC | H - Calculus | Honors
High School CALC I H - Caleulus Il Honors
CALC I H - Calculus 1l Honors
CH ENS - Ensemble -
Print |
Exit I

5. Select the Filter by which to sort the Course List.
6. Use the > or >> (arrow) buttons to move students to the Print List.

7. Click Print.
The Course Listing report displays in an Internet Explorer window, providing an at a
glance view of the courses parameters as they are established for your school.
Select the Internet Explorer File>Print menu option to print.
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Class List

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Class.
The Report Title list populates with reports related to classes.

3. Click the Report Title of Class List.

4. Click Print.
The Class List report displays in an Internet Explorer window, providing an at a
glance view of the class sections that have been created for your school, the
enrollment numbers, the Instructor, etc.
Select the Internet Explorer File>Print menu option to print.
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Class Roster

1. From the Main Menu, click Report Manager.
The Report Manager screen opens.

2. Click the Category of Class.

The Report Title list populates with reports related to classes.

3. Click the Report Title of Class Roster.

4. Click Print.
The Print Class Roster screen displays.
Print Class Roster
~ Filter Class List Print List
Staff ALG 111 -
ALG 110 =
I LI ALG I-2 ‘
Pattern ALGI-3 =
ALG |-4 |
] ~| | |ALGIS >
. ALG 1B =
ourse ALG |7
] o] | |AGs 2
ALG -9
ALG I H-A <
Sort | |ALG I H-A
{* Class Name AMH |1 <«
AMH 110
" Instructor Name AMH 12
" Patten AMH 13
3  |AMH -4
3 v] [V Page Breaks AMH 15
Term # g AMH 16
AMH -7
Roster Template ﬁmn :g
ICIassRoster _vJ ANAT 14
Status AP LANG-A ¥
Print

5. Select the Filter by which to sort the Class Roster report:

a. Staff
b. Pattern
c. Course

6. Choose the method by which to sort the report:
a. Class Name
b. Instructor Name

c. Pattern
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7. Select the Term for which to print the Class Roster.

8. Select the Page Breaks option if you want to include page breaks between each
Class Roster.

9. Select the Roster Template:

a. 15 Column: Provides a listing of enrolled student names in column one,
followed by 15 blank columns for recording information.

b. Attendance (Day): Provides a listing of enrolled student names in column
one, followed by a column labeled Attend.

c. Attendance (Week): Provides a listing of enrolled student names in column
one, followed by a series of columns, one for Monday, one for Tuesday, one
for Wednesday, one for Thursday and one for Friday.

d. Class Roster: Provides a listing of enrolled student names in column one,
followed by a column that lists the student's grad level, and an additional
blank column. The numbers of Male and Female students enrolled in the
class are listed at the bottom.

e. Demographics: Provides a listing of enrolled student names, grade levels,
home phone number, parent names and the address to which the student is
linked.

f. Picture Roster: Provides a picture of each enrolled student, underneath
which their name is listed.

g. Total Enrollment: Provides a listing of enrolled student names in column
one, followed by grade level, term enroliment (indicated by a Y in the term
column), and a total number of students enrolled by term.

10. Use the > or >> (arrow) buttons to move class sections to the Print List.

11. Click Print.
The Class Roster report displays in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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M Activity Log Exercise
Objectives: To illustrate the ability to track and view demographic changes.
Run a Demographic Activity Log
1. Choose Paddy *Patterson.

2. Select today’s date.

3. Click Print.

140



General use of Create-A-Report

Create-A-Report offers the user the opportunity to pull data regarding student, family, or
staff in a variety of configurations.

1. From the Main Menu, click Create-A-Report.
The Create-A-Report screen opens.

2. Select a Base Report Type of Student, Family, or Staff.

3. Double-click an Available Field to move it to Report Fields.

4. Select the Filter option that will list the student(s) for whom to print the report:
a. Status — lists students by enrolled status.
b. Class - lists students from a specific class.
c. Activity— lists students from a specific activity.

d. Former Student— will display students who have graduated or withdrawn
from the school.

e. Next Year— will display Next Year students in the filtered list.
f. District Wide — lists students in every school in the district.
5. Use the > or >> (arrow) buttons to move students to the Selected List field.

6. Click Print.
The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Mu Create-A-Report Exercise (Work through with instructor)

Objectives: To create a customized report

Create a Basic Report

1. Add the following Available Fields to Report Fields:
a. Name
b. Grade Level
c. SystemID
d. Address
e. City
f. Ethnicity
g. Gender

2. Filter by Enrolled students

3. Print

Create a Filtered Report
1. Print the same report except filter it by 3¢ grade

2. Print the same report except filter it by an ethnicity in the school.

Export a Report to Excel
1. Print the report from exercise A

2. Copy and paste the printed report to Excel
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Attendance

Attendance Approach
Attendance Components
Attendance Setup

Taking Attendance
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Attendance Approach

Each school must develop its own attendance approach.

~ Elementary schools typically take attendance in only one class (usually Homeroom).
That attendance mark is the only mark the student will receive the entire day.

~ Middle schools and high schools often record attendance for every class.

Attendance Components

Whether your school uses homeroom attendance or period attendance, Day Attendance is
determined by the settings configured in your Attendance Setup.

There are two primary components to attendance recording:

~ Period Attendance: the attendance records for a student in a particular class or
subject.

~ Day Attendance: a computed number whereby the system determines whether a
student is absent or tardy for the day by counting how many period absences the
student has that day.
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Attendance Setup

1.

From the Main Menu click Attendance.
The Attendance Menu dialog box displays.

Click Attendance Setup.
The Attendance Setup screen displays.

Attendance Setup
A72: Half Day Absent [wt. = 0.5)
|3_ Number of absences that constitute A: Absent [wt. =1.0)
absent for the day AE: Absent - Excused (Wt =1.0]

AS: Absent-Sent to Dffice [wt. =1.0]
AT: Absent due to Tardy MWt =1.0)
All: Absent - Unexcused (Wt =1.0)

,2— Number of absences that constitute
absent for half the day

NS: No School
P: Present
v Block faculty attendance on TE: Tardy - Excused (Wt =1.0)
different day
THR: Tardy Excused [wt. =1.0]
V¥ Dynamic Day Attendance TU: Tardy - Unexcused [w't. =1.0]

Hide NS attendance code from
v faculty

[V &llow substitute to take attendance

[V Disable Column 2

Save and Exit |

Add Edit

Delete '

Type the Number of absences that constitute absent for the day.
Type the Number of absences that constitute absent for half the day.

Select the Block faculty attendance on different day to ensure that attendance is
only taken by faculty on today's date.

Select the Dynamic Day Attendance to automatically configure Day Attendance as
attendance marks are entered.

As attendance marks are entered by the school, the day attendance is dynamically
configured according to the parameters created in the Attendance Setup. In the
event that you need to edit an attendance mark for a previous day, the day
attendance dynamically adjusts to reflect the new day attendance value.
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7. Select the Hide NS attendance code from faculty if you do not want Faculty to be
able to utilize the system default code of NS and prefer to allow only the main office
staff to be able to enter the code.

The NS code is a code that signifies that a student was not present or absent.
Selecting the code for a student removes the day from the total count of school days
for the student.

For example, you may use this code for students who have been given permission to
go on a college visit; you don't want to mark them absent because it is a school
sanctioned trip, but they weren't actually in attendance at the school.

8. Select Allow Substitute to take attendance if you want substitutes to be able to
take attendance on days they are assigned to a class.

9. Select Disable Column 2 to remove Column #2 from the attendance screens.

10. Click Save and Exit to save changes and return to the Attendance Menu.

146



Creating Attendance Codes

1. From the Main Menu click
Attendance.
The Attendance Menu displays.

2. Click Attendance Setup.
The Attendance Setup screen
displays.

3. Click Add.
The Edit Attendance Code screen
displays.

4. Enter the appropriate data:

Edit Attendance Code

Code Description

5

Weight

]ﬂ Absent - Excused

V' Administrator
IV Faculty

v Absent
™ Tardy

Save |

|1

[V Excused

Cancel l

Delete |

Help l

a. Code: Attendance Code, i.e. A, AU, AE, etc.

b. Description: Description of Attendance Code.

c. Weight: This field is user-defined in that the value or “importance” of a
particular attendance code is determined by the individual creating it. 1 could
represent 1 class missed or 1 day missed.

d. Absent checkbox: ldentifies code as an absent code.

e. Tardy checkbox: Identifies code as a tardy code.

f. Administrator checkbox: Allows staff to use code.

g. Faculty checkbox: Allows faculty to use check box.

h. Excused checkbox: Identifies code as being excused.

5. Click the Save button.
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Taking Attendance

There are two methods by which period attendance is recorded:

~ Class Attendance - the roster for the class is listed along with the attendance marks
by period for the day.

~ Student Attendance - the list shows all enrolled classes for a single student for the
day.

Faculty is given access to the classes that they teach through the Class Attendance dialog
box, while Administrators are given access to both Attendance-Class and Attendance-
Student attendance entry screen.
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Using the Attendance - Student Screen

This screen allows the user to view/take attendance for an individual student. This is the
screen that an administrator would use to record attendance for a student when a parent

calls in an absence.

1. From the Main Menu click Attendance.
The Attendance Menu displays.

2. Click Attendance - Student.

The Student Attendance screen displays.

Student Attendance

Select Student

Select Date

Abell, Adam

Schedule
Period 1
Period 2/3
Period 4/5
Period 6/7

L.l I Monday

#1 Comment

March 15,2010

> [*1=Nolonger enolled in class

=ili=H

(>3

~ Attendance Codes 4 Attendance Note
Fill
P: Present . ;] z
NS: No School View
A Absent (Wt =1.0)
A/72: Half Day Absent [w't. =0.5) o o
AE: Absent - Excused [ =1.0) abay 5 Hodh
AS: Absent-Sent to Office (Wt =1.0) " week € Tem
AT: Absent due to Tardy (Wt =1.0)
Al Absent - Unexcused Wt =1.0) 1 -
TE: Tardy - Excused (wt. = 1.0) __ PintGid |
THR: Tardy Excused [wt. = 1.0 Print Schedule |
TU: Tardy - Unexcused [wt. =1.0) o
SAVE |
Exit | Hep |

Day Attendance

Select the student for whom to add attendance from the Select Student drop-
down list.

Select the date if the attendance is for a date other than the current day.
Click on the code in the Attendance Codes box to which to add to a student.

Click the cell that is in column #1 and in the same row as the student for whom
attendance is being recorded.
Attendance is immediately recorded and saved.
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Entering a Comment for a Student

1. Click in the cell in the column labeled #1 i Comment L-E_&-J“
Comment.
The Comment dialog box opens.

| =]
2. Type a comment or use the drop-down menu to
select from a list of pre-defined comments. I—I':'K Cancel |

3. Click OK to save the comment or click Cancel to L ;
exit the comment screen without saving a comment.

Attendance - Student Screen Navigation

~ View - allows the user to view the class list and the days absent for that class by
Day, Week, Month or Term.

~ Fill - allows the user to fill in each attendance cell with the same code. After entering
one code, it is possible to select the fill button and all the unmarked fields below it will
be filled to match.

~ Select Student — allows the user to select the desired student.

~ Print Grid — allows the user to print the grid view of a specific student’s attendance
records.

~ Print Schedule — allows the user to print the student’s schedule.

~ Attendance Note — allows the user to record special notes about the student
attendance.
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Using the Attendance - Class Screen

This screen allows a teacher or attendance clerk to view/take attendance for an entire class.
It also gives access to the lunch ordering screen and the class seating chart editor. The
screen may be accessed through the grade book by faculty, but most administrative users
will access it through the Main Menu > Attendance Menu.

1. From the Main Menu, click Attendance.
The Attendance Menu displays.

2. Click Attendance — Class.
The Class Attendance screen displays.

Select Class

Student #1 Comment #2 Comment 01 EBIB-A L]
. Corinthos, Christina
~Grace. Lillie . ‘ » Monday , February 16, 2003 L]
. Hembd, Aaliyah | | | [~ Show scheduled classes only.
. Henderson, Marcus AE Drappt | | View
. Henderson, Margot P | | @ Day  Tem
: KOV:aI, Whitney P : | | " Week " Seating Chart
. Krajacha, Kennedy TU 10 min late no pass | ¢ Month
. Martinez, Sara P | | |
_ Pesnell, Erica P [ Attendance | Lunch |

P: Present

AE: Absent - Excused [wt. =1.0)
AU Absent - Unexcused Wt =1.0)
HDE: Half-day Excused [wt. = 0.5)
TE: Tardy - Excused (wt. = 1.0

TU: Tardy - Unezcused Wt =1.0

Edit Seating Chart |

Esit |
Print Grid I Fill Presentl Fill PresentI S Help l

3. Select the class from the Select Class drop-down list.

4. Select the date if the attendance is for a date other than the current day.

5. Deselect the Show scheduled classes only check box if the class you need does
not display in the drop-down list.

6. Select the code from the Attendance tab.
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7. Click the cell that is in column #1 and in the same row as the student for whom
attendance is being recorded.

8. Use column #2 if attendance is taken twice in the same class.

9. Add comments as desired.

Save Time When Recording Attendance
In order to save time when recording attendance, use the following procedure:
1. Mark all students who are absent.
2. Mark all students who are tardy.

3. Mark all students who are present using the Fill Present button.

Using Fill Present

Provided as a time-saving feature, the system will allow the user to record a single
attendance code at the top of a column and then fill in all the remaining blank attendances to

match.
1. Mark the student in the top-most row possible with the code to be filled.

2. Click the Fill button. All students below the first marked student who do not already
have an attendance code marked will be filled in with the same mark as the first
student.
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Attendance - Class Screen Navigation

~ View: allows the user to view the class list and the days absent for that class by day,
week, month or seating chart.

~ Fill Present: allows the user to fill every box Present for the day.
~ Select Class: allows the user to select the desired class.

~ Attendance/Lunch Tab: allows the user to select whether to mark attendance or
record lunch orders.

~ Add: allows the user to add new attendance codes.
~ Edit: allows the user to highlight and edit existing attendance codes.
~ Delete: allows the user to highlight and delete existing attendance codes.

~ Edit Seating Chart: takes the user to the seating chart and allows him or her to
create a seating chart for the selected class.

~ Attendance Report: allows the user to run attendance reports on the class being
viewed.
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Academic Management

RenWeb Setup:

Courses

Classes

Course Level

Enrolling Students into Classes

RenWeb Setup:
RenWeb Setup:
RenWeb Setup:
RenWeb Setup:
RenWeb Setup:

RenWeb Setup:

System Defaults
Grade Book
Comment Codes
Citizenship Codes
RC Formula

Database Tasks

Report Card Automatic Load

Printing Report Cards

154



RenWeb Setup: Course Level

RenWeb Setup houses many of the behind the scenes set up areas, which serve to enable
the program to run smoothly at your school.

Course Level is the used for Report Card recognition and Transcript Loading. It is the
primary tool for determining how internal non-displayed grades are established, because
each course must have a course level associated with it.

Every course receives a grade on the report card: either a letter (i.e., A, B, C) or a number
(i.e., 95, 83, 72, etc.) These grades are referred to as the earned grade.

RenWeb then takes this grade and creates a GPA (weighted) and UGPA (un-weighted
grade point average) associated with the grade (i.e., A = 4.0).

Every course must have a course level identifier code to identify the academic level of the
course. Inthe simplest case, all courses may be given the same level; for example, STD for
standard. In a more complex situation, there may be several levels such as CP (College
Placement), HNR (Honors) and AP (Advanced Placement).

Course Level is where the following aspects of a grade are defined:
~ The earned grades that may be recorded for a particular course.
~ The GPA and UGPA associated with a displayed grade (letter or number)
~ Whether or not a grade is passing

~ Whether or not the grade should be included when calculating overall averages on
report cards and transcripts, as well as determining honor rolls

~ The offset, if any, that should be added to a numeric average if used for weighting
purposes due to an advanced level course setup (This is normally used in lieu of a
weighted GPA.)
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There are two similar, but completely independent aspects of Course Level:

~ Letter Grade: The school should populate this grid if the grades entered into the
report card are letter grades. The Letter Grades area requires an exact match. For
example, if a teacher enters a B-in the grade book, but that letter is not defined in the
Course Level it will not be recognized.

~ Number Grade: The school should populate this grid if the grades entered into the
report card are number grades. The Number Grades area Works based on the
closest number (in the course level grid) below the number grade entered into the
report card. For example, if the grade entered is an 87 the appropriate range on the
grid is the parameter for an 80.

Edit Course level
CourseLevel Level Description
ﬁFD'N ISTD IStandard I Honors Report Card Formula I
SPEC Letter Giades Number Grades
S TR —
- Grade |GPA [UGP Pass [ Cale Grade |GP4 |UGPE Pass |Cale | Dffsel
At 4.000 4.000 Y Y 97.00C 4.000 4.000 Y Y 0
A 4.000 4.000 Y Y 93.00C 4.000 4.000 Y ¥ ]
A- 3.700 3.700 Y Y 90.00C 3.700 3.700 Y ¥ 0
B+ 3.300 3.300 Y Y §8.00 3.300 3.300 Y Y 0
B 3.000 3.000 Y Y 83.00C 3.000 3.000 Y ¥ ]
B- 2700 2700 Y Y 80.00C 2.700 2.700 Y Y 0
C+ 2.300 2.300 Y Y 78.00( 2.300 2.300 Y ¥ 0
C 2.000 2.000 Y Y 73.00( 2.000 2.000 Y ¥ 0
C- 1.700 1.700 Y Y 70.00C 1.700 1.700 Y Y 0
D+ 1.300 1.300 Y Y 67.00C 1.300 1.300 Y ¥ 0
D 1.000 1.000 Y Y £3.00C 1.000 1.000 Y Y ]
D- 0.700 0.700 Y R 60.00C 0.700 0.700 Y Y 0
] 0.000 0.000 50.00C 0.500 0.500 ¥ 0
5 0.000 0.000 Y 0.000 0.000 0.000 Y 0
P 0.000 0.000 Y
0 0.000 0.000 Y
| 0.000 0.000
F 0.000 0.000 Y
E 0.000 0.000 Y
h v

Save | Save and Exitl Exit Delete New Help
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Creating a Course Level

1.

8.

From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu displays.

Click Course Level.
The Course Level screen opens.

Click New (bottom).

Type the Level Name (i.e. STD).

Type the Level Description (i.e. Standard).

If it is an honors course level, select Honors.

In the Letter Grades grid, type:

a.

e.

The letters a student may receive in order for the report card to recognize
entry.

The GPA associated with each letter.
The UGPA (Un-weighted GPA).
Y - if the grade is considered passing.

Y - if the grade should be used in calculations (include failing grades).

In the Number Grades grid, type:

a.

The number (the lowest percentage grade that may be earned to receive a
particular letter grade). For example: If any grade equal to and above a 90 is
a 4.0, only type a 90 beside the 4.0.

The associated GPA and UGPA.
Y - if the grade is considered passing.
Y - if the grade should be used in calculations.

The grade Offset if the grade average should be increased due to the
academic level of the class.

For example: It is possible to boost the average grade 10 points if the course
is an Honors course. This affects subsequent grade calculations in the
grades average. This can be done be in lieu of a weighted GPA of 4.5 or 5.0
for Honors courses.
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9. Click Save when finished.

®Note: This grade translation created is not the same as the grade translation created
for grade books. The two remain separate in case an instructor wants to place his/her
class on a different grading scale.
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Courses

In RenWeb there is a difference between a Course and a Class. A Course is a top-level
designation; A Class is an actual meeting of a Course (often times referred to as a Section).
For example, English Composition is a course. The class is Section ‘A’ of English
Composition, taught by Mrs. Smith, in Room 100, at 8:00 a.m.

Adding a Course

1. From the Main Menu, click Courses.
The Course screen opens.

Edit Course

Course List

01 ART - Art

01 ATTND - Attendance
01 BIE - Bible

01 CL - Computer Lab

01 ENG - English

01 MTH - Math

01 MUS - Music

01 PE - Physical Education
01 5CI - Science

01 SP - Spanish

01 55 - Social Studies
01/02 HR - First and Second Grade Homer
02 ART - Art

02 BIB - Bible

02 CL - Computer Lab

02 ENG - English

02 MTH - Math

02 MUS - Music

02 PE - Physical Education
02 5CI - Science

02 SP - Spanish

02 55 - Social Studies

m

Course Title: Course ID

l I I

L . User Defined

[—_:_I Vv Active

Department State ID Master Lessan Plan

[ Lj _+] | Text Books

Description Objectives

Skill Sets

- Requests

Report Card Transcript

Term  Sem.  Final

‘Weight h_ ]1_ [1_

[V Include on Report Card

Credits ’r

' Do not load on transcript

== s
Prereq ICoreq | Equiv | Grade |
101 2RT - At -
[C101 ATTND - Attendance
[101BIE - Bible

[C101 CL - Computer Lab
[T101 ENG - English

[C101 MTH - Math

[7101 MUS - Music

[101 PE - Physical Education
[C101 SCI - Science

[[101 5P - Spanish

[C101 55 - Social Studies
[T101/02 HR - First and Second Grade Homeroom
[C102 ART - &rt

[C102BIB - Bible

[[102CL - Computer Lab

[C] 02 ENG - English

m

03 AHT_' Al [V Calculate on Report Card L ATem Greds L1 0oMTH: Math

03 BIE - Bible - [[102MUS - Music

03 CL - Computer Lab V¥ Enatle attendance recording Semester Grade [7102 PE - Physical Education

03 ENG - English r " Final Grads 8

03 MTH - Math Home room i mal arade [[]025C1 - Science

03 MUS - Music I~ Activiy [ Elective [ Do not calculate on transcript [[102 SP - Spanish

03 PE - Physical Education RC Placement [Custom) ,D_ [[102 55 - Social Studies

03 5Cl - Science = T [1034RT - At

03 5P - Spanish Scheduling School Division 03 EIE - Bibl

0355 - Social Studies Ma Size (0=Open) [0 O s

03/04 HR - Third and Forth Grade Homero ™ PreSchool [C]03 CL - Computer Lab

D4 ART - Art Default lﬁ [C103ENG - English

04 BIE - Bible _ | Instructor I Elementary [ 02MTH - Math

N4 - Camniter | 2h Required [—L] Ll Middle School [71 03 MUS - Music

Activity Room I™" High School [1 03 PE - Physical Education

élr[e-s chool Ealtem v [1035CI - Science

Elementary =% g gg :: ' :pa‘n IIsgt di

Middle School 7 2900181 I LICKES.

High School _ aotve | New | [_Save | Help | [] 03/04 HR - Third and Forth Grade Homeroom =

Inactive Delete | Save and Exit] Exxit I L™ »

2. Click New.
3. Inthe Course field, type a course abbreviation to be used when creating classes.

Keep it short and simple; a max of 5 characters. (While the field allows up to 10
characters in the field, it is recommended to limit the characters to 5)

a. Use all CAPITAL letters

b. Avoid punctuation marks

C.

Each course name must be completely unique. i.e. ALG1
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4. Inthe Title field, type the official course name. i.e. Algebra 1.
5. From the Level drop-down box, select a Course Level.

6. From the Department drop-down menu, select the department with which the course
is associated.

7. Type the State ID assigned to the course. The State ID will automatically populate
this field in the Transcript for any courses added to the transcript by RenWeb.

8. Type a Description of the course.
9. Inthe Report Card section, establish the report card parameters:
a. Type the Term, Sem., and Final Weights.

b. If the course should not be on the report card, deselect the Include on
Report Card option.

c. If the course should not be calculated on the report card, deselect the
Calculate on Report Card option.

d. If the teacher will not be taking attendance for the course, deselect the
Enable attendance recording option.

e. If a course is the designated Homeroom, select the Homeroom option.
f. If the course is an activity, select the Activity option.
g. If the course is an elective, select the Elective option.

10. In the Transcript section, establish the transcript parameters:

a. Inthe Credits box, enter the course credits. This is typically used for High
School level courses.

b. If the classes generated from this course should not be on the student
transcripts, select Do Not Load on Transcript.

c. Select when to load the grade to the transcript:
i. Term Grade
ii. Semester Grade

iii. Final Grade
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d. If aclassis on the transcript, but should be omitted from the final GPA and
averages calculation, select the Do Not Calculate on Transcript option.

11. In the Scheduling area, select the scheduling parameters:
a. Add a Max Size for the course.
b. If aninstructor is required for a course, select the Default Instructor.
c. If a course must meet in a specific room, select the Required Room.
d. Select the Pattern Group with which to associate the course.
12. Select the School Division with which the course is associated:
a. Pre-school
b. Elementary
c. Middle School
d. High School

13. Click Save to add the course to the list of courses for the school.
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Deleting a Course
1. From the Main Menu, click Courses.

2. From the course list box (left), click on the course hame to select it.

3. Click Delete.

®Warning! It is not possible to delete a course if there are class sections currently

defined or based on that course. If the user inactivates a course without un-enrolling

students and removing the class section, that section will continue to show in the
grade book.
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Course SKkill Sets

Courses with skill sets have a list of subject areas to master for proficiency. Subjects are
divided into specific skills. Skill levels are graded: Course > Subject > Skills.

Creating a Subject

1. From the Main Menu, click Courses.
The Edit Course screen displays.

2. From the Course List, click the course in which the skill set will be measured.

3. Click the Skill Sets button.
The Skill Sets screen displays.

Skl Sets ==
# Subject RNIE Skil
1}Verbs i 1| Progress
2| Listening 2| Participation
3| Speaking 3| Performance
4| 'writing
5| Reading
~| -
Add | Add |
Exit I Help | v | CopyFrom ...

4. Double-click the first blank entry line in the Subject grid. Or click the Add button
under the Subject grid.
The Edit subject dialog box displays.

5. Type a subject in the text field.
The subject ID # defaults to the first available number. This is important in identifying
the order in which the subject is displayed and is used to associate skills with skill set
grades.

6. Click Save.
The subject displays in the Subject grid.
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Creating a SKkill

1. From the Skill Sets screen, select the subject for which to add a skill in the Subject

grid.

2. Click Add under the Skill grid.
The Edit Skill Set screen opens.

Rubric #1

Edit Skill Set

#  Edit/Delete a skill
=
Grade Type

& Letter or Number
" Yes/MNo or Pass/Fail

[ Single grade per year

Add Obijective |

Rubric #2

Rubric #3

Rubric #4

Rubric #5

Cancel Delete Help

3. Fillin the appropriate data:

a.

# (Skill Number): Used for ordering the skills and for identifying the skill in the
report card.

Skill Name: Type the skill name.

Grade Type: May be a letter/number grade or a Yes/No grade.
Use Yes/No grades to identify that a subject was covered for a student.
Letter/Number grades indicate a skill level for the subject.

Single Grade Per Year option indicates that there is only one grade saved
for this item in a year. This is often time associated with Yes/No grades.
One entry only will be accepted for a skill with this setup.

Click Save. The skill displays in the Skill Sets screen when the subject is
selected.
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Course Objectives

Adding an Objective Group

1. From the Main Menu, click Courses.
The Edit Course screen displays.

2. From the Course List, select the course for which the Objective will be added.

3. Click the Objectives button.
The Course Objectives screen displays.

4. Click Add Objective Group.
The Edit Objective dialog box displays.

Edit Objective Group =) B | [3]

#t Group
|3 IWriting Skillg Cancel |
__ Delete |

a. Inthe # field, type a number by which to sort the objective.
b. Inthe Group field, type the group name.

c. Click OK.
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Adding an Objective to a Group

1. From the Course Objectives screen, click Add Objective.
The Edit Objective screen displays.

[ Edit Objective EE =)

#
1.23

Objective

Student uses varied tone when presenting a public speech.

Save I Cancel | Delete | Help |

2. Inthe Edit Objective screen, enter the data:
a. Inthe #field, type a number by which to sort the objectives.
b. Inthe Objective field, type a description of the objective.

c. Click Save.
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Classes

The Edit Class screen is a multiple function screen that allows the user to create and edit
all aspects related to classes in one place, including: student enroliment and transfers;
attendance; grades; instructor; room; term; the class time table.

rEdit Class ==l
Course Class Sections ID = 2495 Show Unenrolled |

PHOTO Il - Photography: Advance: SPAN | -4 :
PHT I - Photography | SPAN|-B Add Section Altendance
PR-ALG - Pre-&lgebra
PR-ALG H - Pre-Algebra Honors femove Enroll
PRE-C - Pre-Calculus Print
PRE-CH - Pre-Calculus Honors Ky
PRIV - Private Voice
SH - Study Hall Report Card
SKY-DIYV - Sky Diving rCTEE—
SOCC| - Soccer| Transfer
SOCCII - Soccer |l e
SOFT | - Junior Varsity Softball User Defined
SOFT Il - Yarsity Softball ——;
SPAN | H - Spanish | Honors C Secti
SPAN |1 - Spanish Il L ection
SPAN |1 H - Spanish || Honors lSPAN | 'l A
SPAN Il - Spanish Il Instugtor————————————— IHS LI
SPAN Il H - Spanish Il Honors 1 |Burke, Damm LI :
ggﬁ” :x Hs-psa::rt}s%v Honors L |Tuesday IW ayl Ih |Fr|day
SPE - Speech #2 |<Not Assigned> ~| 218(: ?,!og ,
THED - Theology Aide|<Nol Assigned> E] ACLEI00
TRIH | - Trigonometry Honors | 3rd Period|
I.I..ls\llé \A;'[ ri%ondoms‘t;y | T Room Pattern 4th Period

- Under Water basket Wea =
VICHEER - Varsty Cheerading | | | |1 =l =) [bch |
-DANCE - Varsity Dance sl M1 Sth Period|
WBBALL | - Women's Junior Yarsity ¥ 12 Bth Period|
WEBBALL |l - Women's Varsity Bask v 13 7th Period
WwHS - World History v T4
YBK - Yearbook %
Q;I:livity Edit Course | ™ Do notinclude on Day Attendance
Pre-School 7 Lock Schedule
Elementary ™ Lock Enroliment
dedle School Gender Restriction
High School l——_-l

Refresh I =
Linked Class
= ]
Exit | Save Help
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Auto-Creating Class Sections

1. From the Main Menu, click the Classes button.

The Edit Class screen displays.

2. Select the Course to which to add class sections from the list on the left.

3. Click the Add Section button.

The Add Section screen displays.

Add Section

ALGH I ||——

Auto Create Section

Status

il
" Numerical
* Alphabetical il i]
3| s

=& =

Cancel

i

4. Inthe Auto Create Section area, select the option of Numerical or Alphabetical.

5. Click on the number that represents the number of sections desired.

If more than 9 sections are needed, repeat the process and the additional sections

will be added beginning with the next appropriate numeral or letter designation.

6. Click OK to exit the Add Section Screen and return to the Edit Class screen.
The class section(s) has been added to the Class Sections list.
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Manually Creating Class Sections

1. From the Main Menu, click the Classes button.
The Edit Class dialog box opens.

2. Select the Course to which to add class sections from the list on the left.

3. Click the Add Section button.
The Add Section screen displays.

4. Type the specific section letter or number for the class you are adding in the text field
above the Auto Create Class Section area.
It is possible to create a class section by teacher’s last name or initial for quick
recognition of multiple sections for the same course.

5. Click OK to exit the Add Section Screen and return to the Edit Class screen.
The class section has been added to the Class Sections list.
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Assigning Other Class Parameters

Once you have created class sections, you may add other parameters to the class section.

~ Instructor: In the #1 drop-down menu, select the main Instructor of the class. Select
a second instructor from the #2 drop-down menu. Select an Aide from the Aide
drop-down menu.

~ Room: Select the room in which the class section meets.
~ Pattern: Select the pattern with which the class is associated.

~ Time Table: If your school does not use patterns, use the time grid to schedule the
class into time periods by clicking the cell in the grid in which the class is to be
scheduled. To remove, click on it again. The class room displays in the grid.

~ Term: Select the terms for which the class will be offered by clicking in the Term
check boxes.

~ Select the Do not include on Day Attendance option if the class section should not
be included in the configuration of day attendance.

~ Select the Lock Schedule option if you do not want the automatic scheduler to alter
the schedule of the class section.

~ Select the Lock Enrollment option if you do not want the automatic scheduler to
alter the enrollment of the class section.

~ Select a gender in the Gender Restriction if you want the class section to be only
male or female.

~ Select a Linked Class if the class must either meet in the same pattern as another
class section or if the class must be scheduled in the same patter (different term) as
another class.
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Enrolling Students into Classes

Students are typically enrolled into classes using one of four methods: Class enroliment,
Student screen enrollment, Group enrollment and Automated Scheduling.

Automated Scheduling and Group scheduling are covered in detail in the Scheduling
training classes, but we will be referring to them briefly in this training.

Class Enrollment

This method is typically used to enroll students into classes before the school year begins,
because you can enroll a large number of students into a specific subject simultaneously.

1.

From the Main Menu, click Classes.
The Edit Classes screen displays.

Select the course in which to enroll students from the Course list.

Click on the Class Section in
which to enroll students.

Click the Enroll button.

The Enroll Class/Activity screen
displays with the class section
selected in the drop-down menu.

Use the Filter to refine the
Student List.

Use the > or >> (arrow) buttons to
move students to the Roster.

The student is enrolled in the
class section.

Use the < or << (arrow) buttons to
remove a student from the Roster
list and un-enroll him or her from a
class.

Enrall Class/Activity

=B &

|1

Title

Student List

[ALGH -1 |

Roster

Adams, Johnathan

Anderson, Anna
Anderzon, Jake
Ashton, Rick Paul
Banks, Cody Ray
Barkley, Aaron
Barnett, Heather
Boswarth, Pam
Bowman, Sarnuel
Bayd, Zachary
Brock, James
Buck, Charles
Cavness, Bethany
D avis, Bradly
Davis, Caleb
Diavig, Elizha
Duncan, Avery

Carimmmn D lbina

(* Status

" Grade Level
" Requests
" Class

“fmztrong, Jon Bob -
Adamsz, Edward Henry

Ainge, Braiden Matthew >

“fmstrong, Jon Bob
Adamsz, Edward Henry
Davig, Caleb
Hedruurn, Maxmel
Hightower, Samuel
Jones, Joseph
Lancaster, James
Moare, Kelly

[+ [

m

<

2 |~

(v Current Year
" Mest Year

Size =8 [Max =0]
Student Barcode

pubnibaese

E xit
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Student Screen Enrollment

This method is typically used to enroll students who come to the school after the school year
has started. This method allows you to see the placement of a student's enrolled classes
into a time schedule.

1. From the Student screen, General tab, click the Schedule tab.

2. Use the Filter to control the course list and class sections for which you can enroll
students.

a. All Courses: displays all courses in the school.
b. Class Groups: displays all groups that have been created.
c. Requests: displays the student's requested courses.

d. Activities: If the school enrolls students into activities (athletics,
cheerleading, drill team, etc.), select view available activities.

3. Click on a course name.
The class section(s) display in the Available Class List.

4. From the Available Class List, click on the class section.
5. Click the > (arrow) button to move the selected class to Enrolled Classes.

The Class will display in the Schedule grid reflecting any conflict now existing with a
student’s schedule.

@Note: You can only enroll one class at a time.

6. Repeat the procedure for each additional course/class.

Unenrolling a Student fom the Student Screen

1. From the Enrolled Classes list, double-click a class name to unenroll a student.
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Group Enrollment

This method is typically used to enroll elementary or self contained groups of students into a
group of classes. The helpful aspect of this feature is that if a specific grade level takes
certain classes, those classes can be made into a group into which students are enrolled.

Create a New Class Group

1. From the Main Menu of RenWeb, click Scheduler.
The Filter screen opens.

2. Select the desired School Division filters.

3. Click Scheduler.

4. The Scheduler screen opens with the Configuration tab selected.
5. Select the template for which you will be adding groups.

6. Click the Groups tab.

7. Click in the Name window and type the name of the group to create.
For example, Miller - 02 for the group of classes Mrs. Miller teaches in second grade.

8. When finished, click Save. The name of the new group displays in the Class Group
list.
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Add Classes to a Class Group

1. From the Main Menu of RenWeb, click Scheduler.

The Filter screen opens.

2. Select the desired School Division filters.

3. Click Scheduler.

The Scheduler screen opens with the Configuration tab selected.

4. Select the template for which you will be adding classes to a group.

5. Click the Groups tab.

6. From the Class Group list, select the Class Group to which to add classes.

7. From the class list (right), select the classes to add to the group.

8. Click the < arrow. The chosen classes display in the selected class list (left).

Scheduler

Configuration | Grade Level Requests | Student Requests | Instmctorl Course ] Student Group I Manual [

Template Name Help
New Template v 1€ .
rint
Class Group New Group | Delete Group l
1C
10 ;
i Classes | Students | Schedule | N
%ﬁ 1ART -C 1PEN-C 2BEHAVIOR -
3G 1BEHAVIORC 1ART -0 1PEN-O 2BEHAVIOR -
2p 1ART-R 1PEN-R 2BEHAVIOR -
W 1MATHC 1BEHAVIOR -C 1READ-C 2CHINESE -C
24D 1MUSICC 1BEHAVIOR -0 1READ-0 2CHINESE - C
AM 1PENC 1BEHAVIOR -R 1READ-R 2CHINESE - F
AW 1READC % 1CHINESE -C 1SCI-C 2COMP -A
K-M 1SCIC 1CHINESE -0 15CI-0 2HR-C
KN 1SPANC 1CHINESE - R 1SCI-R 2HR-G
KR 1SPELLC 1COMP - A 1SPAN-C 2HR-R
185C 1HR-C 1SPAN -0 2LANG-C
1WORKL s 1HR -0 1SPAN-R 2LANG -G
MHR-R 1SPELL-C 2LANG -R
1LANG -C 1SPELL-O 2LSLB-M
22 1LANG -0 1SPELL-R 2MATH-C
1LANG - R 18S-C 2MATH-G
1LSLIB - M 185-0 2MATH-R
1MATH-C 18S-R 2MUSIC-C
1MATH -0 1WORK-C 2MUSIC -G
1MATH -R 1WORK -0 2MUSIC-R
1MUSIC -C 1WORK-R 2PE-1
1MUSIC -0 2ART-C 2PEN-C
1MUSIC-R 2ART-G 2PEN-G
1PE-1 2ART-R 2PEN-R
< | m »
0K | Cancel
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Enroll Students into a Class Goup

1. From the Main Menu of RenWeb, click Scheduler.
The Filter screen opens.

2. Select the desired School Division filters.

3. Click Scheduler.
The Scheduler screen opens with the Configuration tab selected.

4. Select the template for which you will be enrolling students into a group of classes.
5. Click the Groups tab.
6. From the Class Group list, select the Class Group in which to enroll the students.

7. Click the Students tab.
The group student list displays (left), and the complete student list displays (right).

8. From the grade list (lower right), select the grade level. The filtered student list
displays.

9. From the filtered student list (right), select the students for the group.

10. Click the < (left arrow). The selected students are added to the group student list.

Scheduler @
Corfiguration | Grade Level Requests | Student Requests | Instnuctor | Course | Student Group | Manual |
Template Name Help
New Template v 1<
Print
Class Group New Group [ Delete Group |
10
Epi Classes  Students | Schedule | |
%g Alland, Jenna | Admire, Stephanie Michelle -
%G Andrews, Grayce Alland, Audra Grace =
3 Appel. Sophie Alland. Jenna Ann 3
2w Alen, Jack Koch
WD Amos, Kian Falcon
M Amos, Sasha Mei-Ling
W Z | Andrews, Grayce Maurine
K-M | Appel, Sophie Juliann
KN « | |Applewhite, Emiy Anne
K-R Bacon, John Charles
Bahrami, Roddean
3 Baker, Claire Marie ™ Next Year
Baker, Rachel Lauren
Barber, Emilia Berenice 1
22 Barber, Sam David 2
Barlow, Townes Atthur 3
Bamon, Peyton Ryan 4
Bass, Anne Haley K
Bass, Beau Parker
Baweja, Yuvraj
Bazir, Yassmine
Beardsley, Claire Grace
Beardsley, Michael Shawn
Bekish, Paige Danielle
Benson, Taylor Lee -

OK I Cancel
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M Courses/Classes Exercise

Objectives: Add a course
Use UD to name the Section
Change terms
Schedule Manually
Change section name
Enroll a student — 3 different ways

Add multiple class sections

Add a New Course
1. Course: HIST-SCOT
2. Title: Scottish History
3. Level: Standard
4. Credits: .5
5. Weight: 1
6. Department: History
7. Include and Calculate on Report Card: Yes
8. Load to Transcript: Semester
9. Requires Attendance: Yes
10. Active: Yes

11. Filter: High School

Add Multiple Class Sections
1. Add a section named 101

a. Assign a teacher
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b. Assign a room number
c. Assign it to all four terms
2. Auto create a section with a numerical name
a. Assign a teacher
b. Assign a room number
c. Assignittoterms 1 and 2
3. Auto create a section with an alphabetical name
a. Assign ateacher
b. Assign a room number

c. Assignittoterms 3 and 4

Schedule the Class Manually

1. Schedule section 101 to meet on Monday, Wednesday and Friday during Period
1.

2. Schedule the section with a numerical name to meet on Tuesdays and
Thursdays during Period 1.

3. Schedule the section with an alphabetical name to meet on Monday through
Friday during period 5.
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Change Section Names

1. Change the name of the numerical and alphabetical sections to 102 and 102
respectively.

Enroll Paddy *Patterson in a Class
1. Enroll Paddy *Patterson into section 102 using the Enroliment button.
2. Transfer Paddy *Patterson into section 101 for term two using the transfer button.

3. Enroll Paddy into section 103 for terms 3 and 4.
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RenWeb Setup: System Defaults

The system defaults area is where overall system configuration properties are set. Each
area is saved independently and must be updated by the school as needed.

These include;:

~ Report Card Editing ~ Grade book Editing
~ Lesson Plan Labels ~ Family Name Configuration
~ Current Year/Current Term ~ Next Year

Report Card Editing

The Report Card Editing area is used to enable and disable the terms into which the report
card data may be entered. This prevents instructors from inadvertently putting grades into
the wrong term or modifying grades without office notification after they have been officially
entered.

Grade Book Editing

Administration has the option of un-checking a term box so changes may not be made to the
grade book after the term is finished and grades have been loaded to the report card. This
option forces the instructor to let the office know there needs to be a change made so a
student’s report card may be reloaded and reprinted to show the correction.

Current Year - Default Year

Each school has the option to assign the Year and Term in which RenWeb will open when
everyone logs in. Ideally, when you are finished with each grading period (Term) and are
ready to begin working in the next, you (Administration) will go into RenWeb Setup/System
Defaults and change the Default Term from T1 to T2 or Q1 to Q2, depending on your
school’'s setup. Next time any user logs in, the system will default to open with the Term you
have assigned in system default. This also affects the Term or Quarter in which the
Teacher’s Grade book will open when accessing a class.

Next Year

In order for the online reenrolliment process to pull students and the correct grade level for
reenrollment, it is necessary to have the Next Year section set up under School Year.
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RenWeb Setup: Grade Book

The grade book has several setup options. These options may be set up by the appropriate
instructor for each class within his/her Grade book/Class or an administrative staff member
for the whole school through RenWeb Setup/Grade book. Schools using Letter grades
determine the Numeric averages that are associated with a letter grade.

Configuring Grade Book Setup

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu displays.

2. From the RenWeb setup menu, click Grade Book Setup.
The Grade Book screen opens

Gradebook (=3
= = Grade Calculation Method 1 Save Multiple Classes —
Letter [ Ava ¢ Points ALGI-1 i
Status & 90.000 || ; ALG1-10
B 80,000 & ‘Weighted Percentage ALG|-2
O Mi ALGI-3 =
Gradebook Category E ;gggg | M | ALGI-4
Diw/: Daily Work F 0 bDU User Preferences - : ALGI-5
HWK: Homework : v ALGI-B
PIT: Projects v Treat Incomplete as 0 ALGI-7
Quiz: Quiz IV “Web Progress Report Enable ALGI-8
Test: Test : ALGI-3
lFuIl Details _v_] AMH -1
¥ Cap Category grade at 100 ﬁmg : 120
IV Cap Tem grade at 100 AMHI1-3
[ Show Paints Eamed imu : g
Decimal Places IU AMH-B
Time Frame imn : - g
|TERM | AMH -9
Student Sorting f}';‘fT ,I\ A o
_J |Doe, John ._'_I [V Gbk Category
T Assignment Sorting IE Gbk Letter Grades
Add Category Clear | [In order they were added [Ascen ~ | [; EE:: galf- Method
references
Save | Save I
Esit | Hep |

3. Select the Course Level to configure from the Course Level drop-down list box

(upper left corner). If grade data has already been entered, it will be displayed in the
grid.
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4. To add a Grade Book Category, click the Add Category button.
The Grade Book Category window opens.

a. Type the category Title.
b. Type a Description.

c. Add a Weight if you use a Grade Calculation Method of Weighted
Percentage or Mixed.

d. Select the Terms in which the category will display in the grade book.
e. Click Save and Exit.

5. Click in the grid and type in the letters and the lowest numeric average associated
with each letter. (To remove characters use the back space key.)

6. Select a Grade Calculation Method of Points, Weighted Percentage or Mixed.
7. Establish User Preferences:

a. Select Treat Incomplete as 0 if all grades assigned a status of 'l
(incomplete) will be averaged into the grade book average as a zero.

b. Select the level detail to display on ParentsWeb from the Web Progress
Report Enable drop-down menu:

i. Full Details
ii. Category Averages
iii. Term Average

c. Select Cap Category grade at 100 to disallow category grades from
exceeding 100.

d. Select Cap Term grade at 100 to disallow term grades from exceeding 100.
e. Select the Decimal Places to display in the Grade Book.
f. Select the grade book Time Frame:

i. Term

ii. Semester

iii. Year
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g. Select the method of Student Sorting.
h. Select the method of Assignment Sorting.

8. Click Save (on the right).

Saving a Grade Translation to a Class Grade Book

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu displays.

2. From the RenWeb setup menu, click Grade Book Setup.
The Grade Book screen opens.

3. Select the Course Level to configure from the Course Level drop-down list box
(upper left corner). If grade data has already been entered, it will be displayed in the
grid.

4. Select the Class from the Save Multiple Classes list.

5. Select Save (on left).

Saving a Grade Translation to All Class Grade Books

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu displays.

2. From the RenWeb setup menu, click Grade Book Setup.
The Grade Book screen opens.

3. Select the Course Level to configure from the Course Level drop-down list box
(upper left corner). If grade data has already been entered, it will be displayed in the
grid.

4. Select all classes in the Save Multiple Classes list (or highlight only the classes to
which to save the current configuration.)
Highlight and scroll to select all or hold down the Ctrl key and select the individual
classes to which to apply the setup.

5. Select the Save button under the Save Multiple Classes section.
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M Grade Book Exercise

Objective: Set up the grade scale for all classes in the school.

Establish a Grade Scale for Elementary and Secondary Classes

1.

2.

5.

Set up the grade scale for a specific Course Level in your school.
Save it to all other classes using the Save Multiple Classes feature.
Set up the grade scale for a specific Course Level.

Save it to all other applicable secondary classes using the Save Multiple Classes
feature.

Repeat if needed for Honors and AP level class grading scales.

@Notes The grade scale may have already been configured in RenWeb by your Project
Manager. Only complete this exercise for classes that have not previously configured.
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Report Card

RenWeb automates the report card production process by collecting, configuring and
producing report cards that represent the input provided by various staff at the school.

Teacher Role:
~ To set up his/her Grade book to produce grades, using the grading method chosen.
~ To record daily grades and attendance in the Grade book.

~ To post those grades to the report card, along with citizenship grades, skill set
grades, etc.

Administrator/Administration Staff Role:

~ To ensure term grades and final exam grades are weighted properly for the
calculating of semester, exam and final grades.

~ To print and review report cards prior to distribution.

184



RenWeb Setup: Report Card Comments

Comment codes allow the staff or instructor to make predetermined comments on the report
card. These comments are connected to a code using this screen. For example, “1” could
be defined as “Does Excellent Work,” “2” as “Talks Too Much in Class,” etc.

Adding Comment Codes

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu opens.

2. Click the Report Card Comments button.
The Comment Codes screen opens.

Edit Codes
Code Description
1 IWorking at or above grade level. 1E. I
2. IIs a pleasure to have in class. 17. I
3 |Failing due to incomplete assignments. 18.
4. |Great team worker. 19.
5. IKeep up the good work! 20. I
= IJoy to have in class. 21 I
7 22
8 23
3. | 24, |
10. | 25, I
11. 26.
12. 27.
13. | 28 I
14. | 29, I
15. | 0. I
Save I Exit | Help |

3. Type the comment description in the Description field.
It will automatically be associated with the corresponding number code.

4. Click Save.
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RenWeb Setup: Citizenship Codes

Citizenship codes are created and utilized to associate a description of behavior, using a
code. For example, “NI” represents “Needs Improvement.”

Adding Citizenship Codes

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu opens.

2. Click Citizenship Codes
The Edit Citizenship Codes screen opens.

Edit Citizenship Codes =

Code Description Disable Honors

IE— Excellent r I_ |
IU_ Unsatisfactory v ,_ I
IF\I—I— Needs Improvement v I—I I
[ r [ L}
[ r [ [
— = -
[ r [ ] L
[ r [ r
[ r [ [
— ER -

Save Exit I Help I

3. Type the letter or number (may be a range) grade into the Code column of the grid.
4. Type the description of that grade into the Description column.

5. If the Code prohibits a student from being on the honor roll check the Disable
Honors check box.

6. Select Save.
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RenWeb Setup: Report Card Formula

If the school uses a number grading scheme for report card grades, RenWeb may
automatically calculate the class grades based on a formula that the user defines. This
formula may be tied to course levels or may be different for each class.

Creating a Report Card Formula

1. From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu opens.

2. Click Course Level.
The Edit Course Level screen opens.

3. Click the Report Card Formula button.
The Report Card Formula screen opens.

Report Card Formula (3]

Save Multiple Classes
Course Level

ALGHI-1 A
STD! v ALGHI-2
ALGHI-3
Grade Calculations 2tg :—I LL-A
T1 T2 T3 T4 T5 T6 EXM1 EXM2 ALG I :B
N o o el ot ol o e Aate
ALGII-C
Semester 2 IU— ‘0_ l? [? IU— ‘0_ |°— W SEM1 SEM2 ﬁm : j@
FralGrade [0 [0 [0 0 o oo o [ %&”Ef':l%_m
Decimal Places [U_ J:E?T‘Ig. B
Save I Save |
Exit | Help ]

4. Select the Course Level for which to set up the report card formula.
5. Establish the parameters and click the Save button.
6. Enter the number of Decimal Places, if any, to be shown on the report card.

7. Click Save, located below the Course Level drop-down list, to save the formula to
this Course Level.

8. To save this formula to other classes, highlight the courses in the Save Multiple
Classes list by scrolling to select all the classes OR hold the Ctrl key to select
individual classes.

9. Click Save under the Save Multiple Classes list.
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@Notes:

~ |tis acceptable to use the same Report Card Formula for courses even if some have
exams and some do not. If student is missing exam grade the system will
automatically not include it in the calculation.

~ Most people think of averaging in terms of a simple average:
Adding up all the term averages and dividing by the number of terms.
(90 + 80 + 70)/3 =80

The Report Card Formula utilizes a weighted average:

Multiplying each term average by its weight, adding the results together, and then
dividing by the combined weight of all terms.

(90*40 + 80*40 + 70*20) / 100 = 82

~ Weighted averaging is typically used in all academic calculations. If all the weights
are the same then simple average and weighted average will bear the same result.
Weighting provides relative importance of grades.

~ In the Report Card Formula, the weights do not have to add up to 100.
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RenWeb Setup: Database Tasks

Database Tasks is an area in RenWeb where system-wide functions may be performed by
staff members with administrative security group rights. It is an extremely powerful tool and

should be utilized only when mass changes to the databases need to take place.

Report Card Automatic Load

This function allows the user to mass load or set the report card attendance and grades
from all classes without having the teacher load grades from Grade book to report card.

1.

4. Select the Term for which to load grade book grades to the report card.

Click Database Tasks.
The Database Tasks screen opens.

From the Main Menu, click RenWeb Setup.
The RenWeb Setup menu displays.

Select Report Card Automatic Load and click Run.
The Report Card Automatic Load screen opens.

Report Card Automatic Load
Classes

ALGI-C -

AMH | -4
14 | ﬂ

AMH 1 -B
AP LANG - A ﬁl

AMH I -4
ANAT -2

Event Log

* ReportCard " Progress Report

~Temm - Action Grade Type
© Tem1 " Load attendance from daily attendance records & Number
@ Tem2 % Load grades from gradebook " Letter
" Tem3 " Clear report card grades, citizenship and comments | Dagimal Places
T Tem 4 " Calculate Semester 1 Grade [U_
" Tem5 " Calculate Semester 2 Grade
C Temb " Calculate Final Grade

Exit

5. Select the Action to complete.
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Select the Grade Type of Number or Letter.
Type the number of Decimal Places to display on the report card.

Use the > or >> (arrow) buttons to load a single class or multiple classes,
respectively, from the grade book to the report card.
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Printing Report Cards

1. From the Main Menu, click Report Manager.

The Report Manager screen opens.

2. Click the Category of Academics.

The Report Title list populates with reports relating to academics.

3. Click the Report Title of Report Card.

4. Click Print.

The Report Card screen opens.

‘Report Card
Student List

Abell, Adam

Abell, Angel

Adams, Edward Henry
Ainge, Braiden Ray
Anderson, Anna
Anderson, Jake
Anderson, Joeseph
Armstong, Evan J
Ashton, Rick Paul
Bakies, Aaron Joseph
Banks, Cody Ray
Bargas, Braden
Barkley, Aaron Dennis
Bosworth, Pam
Bowman, Samuel
Boyd, Zachary

Brock, James
Brodburg, Daffy Z

m._ | »

—Filter —
& Status
" Grade Level
" Homeroom
" Class
" Former Student

Withdrawn
Pre-Enrolled
Graduate

EHE|

>>

<L

A

Template

Print List

5 IHepoﬂCardtlF'Acfm _:_l

User Defined Message

 Term

13

£ AT T4
12

7 Include Behavior Page

Grade Level Override |

Print

-

-

Archive

Email

Exit

Help
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5. Select the Filter option that will list the student(s) for whom to print report card(s):
a. Status — list students by enrolled status.
b. Grade Level — list all students from a specific grade level.
c. Homeroom - list students from a specific homeroom.
d. Class - list students from a specific class.
e. Former Student — lists students who are former students.
6. Use the > or >> (arrow) buttons to move students to the Print List.

7. Select the template from the Template drop-down list box. RenWeb provides
standard templates free of charge that may be used. RenWeb may also create a
custom template for schools for an additional charge.

8. Select the Term for which print the report card.

9. Click Print.
The report(s) will be displayed in an Internet Explorer window.
Select the Internet Explorer File>Print menu option to print.
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Ma Report Card Configuration Exercise

Objectives: Establish the grade calculation formula for elementary courses.
Establish the grade calculation formula for full year secondary courses.

Establish the grade calculation formula for semester secondary courses.

Create Comment Codes and Citizenship Codes (if applicable).

Create a Report Card Formula for Elementary Classes

1. Select an elementary class.

2. Establish the grade calculation used by the school.

3. Save it to all other elementary classes.

@Notes The report card formula may have already been configured in RenWeb by your
Project Manager. Only complete the report card formula exercises if needed.

Create a Report Card Formula for Fully Year Secondary Courses

1. Select a secondary, full year class.

2. Establish the grade calculation used by the school.

3. Save it to all other secondary, full year classes.

Create a Report Card Formula for Semester Secondary Courses

1. Select a secondary, semester class.
2. Establish the grade calculation used by the school.

3. Save it to all other secondary, semester classes.
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Create Comment Codes
1. Add the following comment codes:
a. Needs improvement on organizational skills.
b. Excellent use of time.
c. Failing grade due to excessive absences.

d. Contributes to classroom community and conversation.

Create Citizenship Codes
1. Add the following citizenship codes:
a. E - Description: Excellent
b. G - Description: Good
c. S - Description: Satisfactory
d. U - Description: Unsatisfactory—Disable Honors

e. N - Description: Needs Improvement—Disable Honors

@Note: The Comment Codes and Citizenship Codes may have already been configured in
RenWeb by your Project Manager. Only complete the above exercises if needed.
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School's RenWeb Administrator

School Security

Staff Screen: Security Tab

RenWeb Setup: Year and Term Setup
RenWeb Setup: School Configuration
RenWeb Setup: Grade Level Setup
RenWeb Setup: Database Tasks

Person Family Cleanup

195



School Security

Security Groups are established to define a common set of rights for a group of people at a
school. Typical security groups include Administrator, Administrator 2, Faculty, Security,
Accounting, Nurse, etc. Only two individuals will be given access to the Security screen as
it is the method by which to control access to the entire program.

Setting up a Security Group

1. From the Main Menu, click the Security button.

Security

Security Groups

New

Delete Exit

Program | Report Caleguvies] Reporlsl

= ¢ Staff List Group Membership Password Control

Scouning “Amstiong, Angee & Burrel, Donald
i Qassed 13, | [DaviNoms Distict Wide
Facult Description Bamett, Valerie R |/ Doerstling, Lesa P d
irersd Burell, Donald Duguay, Kenny s s
o || o, e
Meded Dilinder, Harold Reed, Elzabeth P
Parent Alert Do, Jackie Sample, Staff Expiration [Days) 1<
Security Doerstling, Lesa Tumner, Rebecca D
Vals Daonor, User ‘Wilbers, Dustin R

Duck, Gilian D

Save
Help

Duguay, Kenny
Erickson. Laranne

|

Security Item View [Modity [ Description N
Acadenmics Y Provides access to the student academics screen for all students
Academics [Advisor] Y Provides access to the student Academics screen for all students in which user is the a
Accounting Y Allows user to setup Accounting Systems in the Accounting module
Admissions Y Provides access to the Admissions section of the program
Advising Y Provides access to the student Advising screen for all students in student list
Advising (Advisor) Y Provides access to the student Advising screen for all students in which user is the adv
Archive Y Allows user to create student archives for Report Cards and transcripts
Attendance 3 Provides access to the Attendance screen
Class Groups Y Provides access to the class groups screen
Classes N Provides access to the Course and Class Edit screen
Community Service Y Provides access to the student Community Service screen for all students
Community Service (Advisor] Y Provides access to the student community service screen for all students in which user
Ci Y Provides access to the P/T Conference screen for all students
Conferences [Advisor) Y Provides access to the P/T Conference screen for all students in which user is the adv
Courses g Provides access to the courses screen
iscij N Provides access to discipline screen for all students in student list ﬂ
“ O Er———— P ATV VT T SR

Click New.

3. Inthe Group Name field, type the name of the security group, and add a
Description if desired.

4. Click Save.

5. Go through the list of security rights and choose which rights to assign View or
Modify rights for the group.
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Assigning Reporting Rights

It is possible to give individuals access to view and print all reports in a specific Report
Category through the Report Categories tab or to allow access only to select Reports
through the Reports tab.

1. From the Security screen, select the Security Group to which to add reporting
rights.

2. Click the Report Categories tab and click in the grid beside a Report Manager
Category name to give the group access to print all reports in the category.

3. To give the user access to only specific reports in a Category, click the Reports tab
and select the specific reports to which to give the group access.

@Note: It is not necessary to give a user rights to specific reports in the Reports tab if he
or she has been given rights to the entire category in the Report Categories tab.

Adding Staff Members to a Security Group

1. From the Security screen, select the Security Group to which to add Staff
Members.

2. From the Staff List, select the staff member(s) to be assigned to the security group.
3. Use the > (arrow) button to move the staff members to the Group Membership list.

4. To remove a staff member from the Group Membership list, click on his or her
name and use the < (arrow) button.
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Password Control

Password Control enables the administrator to establish
additional parameters to assist in maintaining secure user
passwords. Itis possible for the administrator to create a
Password Minimum Length longer than 6 characters if
desired. In addition, it is possible for the administrator to
set up a Password Expiration (Days) of up to 365 days.
In order to change any of the information in the Password
Control area, highlight the number currently in the blank
and backspace it out. Type in the new number and click
the Save button.

Paszward Cantral
Dhigkrict-wide
Pazzword

kdirirLim Length

Fassward [1op
Expiration [Dayz]

Save |
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Staff Screen: Security Tab

Setting a Staff Member’s RenWeb Password

1. Select the staff member by clicking his or her name in the list.

2. Click the Security tab.

3. Type the staff password in the Password box and type it again in the Confirm box.

4. Click Save.

5. Click Apply to save the changes you have made to the Security tab or click Cancel to

exit without saving.

@Note: For security purposes, the staff password is not displayed

password is forgotten, just create a new password for the user.

. Therefore, if a

Edit Staff

.Generall Schedulel Education | Substitutes Security ]Gmupsl Picture] EC

View Rights

Modify Rights

Security Group Membership

Remove Group
Add Group

Help

[™ District Wide Filter
[~ Dual Enrolment

Select Security Group

Select all of the groups you want user to

be a member of and the selct OK.

=]

Accounting
Administrator
Admissions
Cafeteria
Cash Register
Childcare
Customization
Faculty

Ken's

Library

Lunch

Nurse

Parent Alert
Re-enrollment
Foom Mom
Substitute

0K

o

OK

Cancel

199



Adding a Staff Member to a Security Group

1. From the Security tab, click the Add Group button.
2. Highlight all groups of which the person should be a member

3. Click Apply to save the changes you have made to the Security tab or click Cancel to

exit without saving.

®N0te: All of a staff member’s rights are based on his/her security group(s) and are

displayed in the two list boxes on the right of the Security screen.

Removing a Staff Member from a Security Group

1. From the Security tab, click on the name of the group to remove in the Security Group

Membership list.
The name of the Security Group is highlighted in blue.

2. Click Remove Group.
The group is removed from the Staff member's security rights.

Assigning a User District Wide Rights

If a user has the security right entitled Security in all schools in the district, he or she will see
the two security rights listed to the right of the Security tab and will be able to assign them to

individuals in the district:

e District Wide Filter: Allows a user to see the District Wide filter option on the
Student, Staff, Communications and RenWeb Setup areas of the program.
e Dual Enrollment: Allows a user the ability to enroll into classes students from

another school in the school-independent district.
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RenWeb Setup: Year and Term

RenWeb Setup houses many of the behind the scenes set up areas, which serve to enable
the program to run smoothly at your school.

This screen defines the dates for the school year by term, semester or year. It is important to
accurately establish the next Year and Term before ending one school year and progressing
to the next.

Creating a School Year
1. From the RenWeb Setup menu, click Year and Term.
2. Click New.

3. Type the year name (i.e. 2010-2011).
If the school year is being used for summer school, select the summer school check
box.

4. Click in the text field below Name and type the term name (i.e. T1 or Q1).
5. Select the Start Date for first term.
6. Select the End Date for first term.

7. Select the appropriate Semester (i.e., Q1 and Q2 may be in Semester 1, while Q3
and Q4 are in Semester 2. If the school does not use semesters but uses one
contiguous year instead, then select YEAR for the semester.).

8. Repeat term entry for all terms in the school year.

9. Click Save.
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@Notes:

~ Term dates may not overlap.
~ Attendance is based on term dates.

~ The term in which a grade book assignment is listed is determined by the term
dates.

~ lItis not possible to delete a year once it is created. This is due to the huge
amount of data that is associated with a specific year. It is possible to modify the
dates and names.

Year and Term Setup @
Year Year Name
133312833 IQUDS-ZMD New [~ Summer School
2000-2001 YearlD = 265
2001-2002 ~ Term Setup-
gggg%ggi Name Start Date End Date Semester
2004-2005 1 |31 | 817/2009 v ||10/27/2008 ~| [SEM.1 <]
2005-2006 :
2006-2007 5 |82 |10/28/2009 v ||12/31/2008 ~| [SEM.1 <]
2007-2008
2008-2009 5 |03 | 17122010 ~|| 3/26/2010 ~| [SEM.2  ~]
2003-2010
0102011 4 |04 | 32722010 >|| 671172010 v| [SEM.2 <]
5, |
E.
l Save I Save and Exit Exit Help
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RenWeb Setup: School Configuration

The school configuration is where the user defines the school's nhame and address. The
right side of the configuration setup determines what information the Family Statements in
Accounting display. It is important that the information in this screen be accurate as it is
what controls the address that displays on ParentsWeb and on printed Family Statements.

1. From Main Menu, click RenWeb Setup.

The RenWeb Setup menu opens.

2. Click School Configuration.

The Configure School screen opens

3. To add or edit school information, select the appropriate edit box and type in the

applicable school information.

4. When all data is entered, click Save and Exit.

[” Share Surveys

User-Defined I Save and Exit I

Configure School
~ School r— District
School Name Distnict Name
]Samp!e Elementary School |HenWeb High School
Address Address
|ss1 3 Eastside Rd |5s1 3 Eastside Rd
City State ZIP City State ZIP
| Fort Worth |T>< |?s1 23 |Fort Warth |T>< ]751 23
Phone ‘web Page Phone Web Page
|81 7-447-5286 |www.samplesch00lc0m |31 7-555-5555 Iwww.sampleschoolcom
Fax Email Fax Email
|939-399-987s lsc@sampleschool. org [999.999.9375 [sc@sampleschool.org
College Board School Code -~ Accounting-
_ " School Independent ' District-Wide
School Code - Library ——
A [ " School Independent " District-Wide
i~ Parents\web-
’ " School Independent * District-wide

Timezone Offset from Eastern Standard Time IU

Cancel I Help
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Accounting Option
There are two methods for district accounting:

~ District-wide: In this method it is assumed that there is one accounting office that
controls all schools. A family would receive one statement that would have charges
from all of the campuses combined.

~ School Independent: With this method each school is treated as a separate
accounting office. Even though the family may be spread out over different schools,
each school will maintain its own accounting system separate from each other.

®Note: You may not change your accounting options and must contact Technical Support if
you wish to change your accounting setup.

Library Option

The school has the option to set up the library to be independent from other schools if in a
multiple school district, or to be viewed as one.

Parent’s Web Option

This option allows multiple schools within a district to have a separate ParentsWeb for each
school or to set up all schools to have a single ParentsWeb configuration and view. If set to
Independent, parents with children in multiple schools will have to exit out of one school to
view child’s information in another school. District-wide choice allows you to see all children
enrolled from any school.
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Time Zone Offset from Eastern Standard Time

Certain program functions (ParentsWeb, Parent Alert, Web Tests) utilize the server time
(Eastern Time), and the variance could be up to 14 hours difference between our server and
the school's location. We have added a database field that allows parents on ParentsWeb
to view "today's" events even though today may be different than the date on our servers.

1. From the School Configuration screen, you may type the offset of hours for your
location from Eastern Standard Time.

a. When typing in an offset for a time that is "later" than Eastern Standard Time,
type the number into the offset field. For example, Guam is 14 hours later
than Eastern Standard Time, so you would type a 14 into the offset field.

b. When typing in an offset time that is "earlier" than Eastern Standard Time,
type a - (minus sign) followed by the number into the offset field. For
example, Hawaii is 6 hours earlier than Eastern Standard Time, so you would
type a -6 into the offset field.

2. Click Save.

®Note: Since the following areas display certain information based on a specific time
and/or date, they will be affected by the Time Zone Offset: Parent’'s Web Surveys,
Parent’'s Web Announcement, Parent’'s Web Homework, Parent’s Web Lesson Plans,
Parent’'s Web Attendance, Parent’s Web Behavior Screen, Parent’s Web Lunch screen,
and Parent’'s Web Calendar. In addition, Staff Passwords that are due to expire, will do so
at 24:00:00 (12 midnight), based on the school's time zone offset.
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RenWeb Setup: Grade Level Setup

All students are identified by their grade levels; this screen is where the defaults are
established to connect students to schedules, report cards, transcript templates and
attendance methods. For grade levels 9 and below, it is best to set them up as 01, 02,
03...09, as this will allow for the grade levels to sort in numerical order.

Creating a Grade Level
1. From the RenWeb Setup menu, click Grade Level button.
2. Click the New button.

3. Enter the appropriate data:

Configure Grade Level @
a. Grade LeVEl dEfIneS the [Pk Grade Level Configuration
K
y o1 Grade Level r— New
student’s current grade level. % - e
04 Nezxt School !NOHhWOUdAcademy Elementary _v_l
b. Next Year’s Grade Level: = Desciption |
. . Sort Order |0 52
assigns students into the next L F
grade Ievel When System |s Graduation Date Save to Students
Capacity |0
progressed at the end of the -
Preschool
ear. " Elementary
y " Middle School
" High School
c. Next School: allows the Hepest Badl oo =
system to progress students Progrss Repar Tempst ]
. N Transcript Template b
fI’OIT] one dIS'[I’ICt CampUS tO Default Curticulum Plan i
H Attendance Method 1>
another. An el.ghth—grader may s B
move tO the h|gh SChOOI Admissions Tracking] L’
Reenrallment Tracking I Ll
CampUS next yeal’ Library
Circulation Limit {10
. Circulation Period |7
d. Graduating? check box:
defines a student who is Save sndExi] sse | Ceanp |
Exit | Delete | Help [

graduating from the district
and not being enrolled next

year. They will progress into the Graduate Filter for future access.

e. Graduation Date: defines the full date for which a student in a particular
grade level will graduate from school. Click Save to Students to set the
graduation date for all students in that particular grade level.

®Note: A graduation date should only be added for the highest grade level in

each school division.
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f. School Division: determines the School Division associated with the Grade
Level.

g. Default Curriculum Plan: defines the correct curriculum plan for each
specific grade level. (The curriculum plans are defined in the Curriculum Plan
Editor)

h. Attendance Method: defines how each grade level takes attendance:

None Attendance is not recorded

Homeroom Attendance is taken once a day in a defined homeroom
class

Period Attendance is taken in each class period during the day

Single Class Attendance is taken once a day but is not in a defined
homeroom class

i. Inquiry Tracking: can be tied to a grade level, so that when a tracking
process is started, for a student associated with a specific grade, the Inquiry
tracking will be automatically selected for the student.

j- Admissions Tracking: can be tied to a grade level, so that when a tracking
process is started, for a student associated with a specific grade, the
Admissions tracking will be automatically selected for the student.

k. Reenrollment Tracking: can be tied to a grade level, so that when a
tracking process is started, for a student associated with a specific grade, the
Reenrollment tracking will be automatically selected for the student.

I. Library - Circulation Limit: allows you to establish unique amounts of
library items that are allowed to be checked out by students in each grade
level.

m. Library - Circulation Period: allows you to establish unique lengths of time,
per grade level, for which library items are allowed to be checked out by
students.

4. Click OK to save and exit back to the RenWeb Setup menu or Apply to save and
stay in the Configure Grade Level screen.
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RenWeb Setup: Database Tasks

Database Tasks is an area in RenWeb where system-wide functions may be performed by
staff members with administrative security group rights. It is an extremely powerful tool and
should be utilized only when mass changes to the databases need to take place.

~ Person/Family Cleanup: This function enables the user to view the database list of
names. It is possible to merge and delete records from this area, but it is imperative
to remember that once something is deleted from this area, it is deleted from the
database.

Using Person/Family Cleanup

1. From the main menu, click RenWeb Setup.
The RenWeb Setup menu opens.

2. Click Database Tasks.
The Database Tasks list opens.

3. Click Person/Family Cleanup.

4. Click Run.
The Person/Family Cleanup screen displays.

Person/Family Cleanup ==

@ Person " Family [ District Wide Help Exit |

Barbara (3553)

P

. Barbara (3553)
Family: McCurley, Michael and Mercedes - 997065

Family: LaFontaine, Kim and Laura - 999599

. Virginia (3555) [
Urbank, Frances (6125) e
Abbasi, Susan M. (3556)

Abbasi, Teresa J. (3557) Person as Student rmation Person as Parent Information
Abbe, Virginia (3560) P Children:
'arents ]
ﬁggg:; é:r?;l; [[3355683;]] Blas, Teresa (2988) Father - Custod C: E
Abboll: Nancy (1831) Blss, Virginia (3989) Mother - Custody - E"
Abel, Teresa (3569) Academic Information inancial Information
Abelson, Virginia (3570) SchoolCode: F.{CV-TRAIN ch : 0

Abelson, Wanda (3571)
Aberathy, Chase (6255)
Abernathy, Kristin (506)

Status: Graduate

This Delete button
Attendance: 0

will delete the record

Gradebook: 0
Abemathy, Paullette (6256) for, Barbara (3553) L3
Abemathy, Wallace (505) M| Pepetterd :

Transcript: 0 -
I Unassociated Family Edit
[Viiginia (3555 Merge | Delete

_Barbara (3553
. . Virginia (3555)

3
Urbank, Fi 6125 = 5 1 5
Al::baa:@, Suisaarfas. [[3556]] Family: Vinson, Lindsey and Troy - 998050

:gl;am\./ Teresa ~13-5[8305]57] ily: LaFontaine, Kim and Laura - 999599

Abbzi!, K%l;::l a[ (3563) Person as Student Inforieation Person as Parent Information

Abbatt, Cynthia [3565) Parents Children: 3
Abbott, Nancy (1831) Iglesis, Helen (5882) Father - Custody -

Abel, Teresa (3563) Iglesia, Mary (5882) Mother - Custody - E.C.

Abelson, Virginia (3570) Iglesia, Nancy {5884) Grandparent - GP

Abelson, Wanda (3571) Parmer, Cynthia (5885) Grandparent - GP

zgemam}'» Ehal'se [[5502515] Parmer, Wanda (5886) Grandparent - GP This Delete button B
emathy, Kristin X ]

Abemathﬁ, Paullette (6256) Academic Information Financ will delete the record

Abemathy, Wallace (505) SchoolCode: RW-TRAIN Chergest  for, Virginia (3555)

Abraham, Barbara (3572) i Status: Graduate

Attendsnce: 0 ¥
Famiy Edit | Delete
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5. Select District Wide to view the list of all people or families for the entire district.
You will not see this option if you do not have district wide security rights.

6. Select the Person or Family option depending on whether you have individual
duplicates or family duplicates.
The list populates with Person or Family names.

7. The screen is divided into two different lists; the user may select one of the duplicate
person/family in the top list and then select the second in the bottom drop-down list.

8. Decide which duplicate person/family to keep based on the individual with the most
accurate information and the individual with the most academic and financial
information tied to him or her.

9. Use the Family Edit button to jump to the Family screen and facilitate easier
cleanup.

a. Remove students from a family.
b. Remove parents from a family.

10. Click Yes to confirm the deletion or click No to cancel the deletion.

@Note: Report Manager>Directory>Duplicate Person Error Check is an excellent report
for determining if duplicates exist in your school’s database.

M. Person/Family Cleanup Exercise

Objectives: Delete all of the fake students, parents, staff and families you have entered
during training today.

Delete the Fake Students, Parents and Staff
1. From the Person/Family Cleanup screen, select the Person option.

2. Find & delete all of the added students, parents and staff

Delete the Fake Students, Parents and Staff
1. From the Person/Family Cleanup screen, select the Person option.

2. Find & delete all of the added students, parents and staff
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